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Preface
PREFACE
General

Since the first report of DNA amplification using the process known as polymerase chain reaction (PCR) in 1985, many
advances and modifications have been made to the basic method. PCR is an-inwitro‘method for the enzymatic synthesis
of specific DNA sequences, using two oligonucleotide primers that hybridize:to opposite strands and flank the region of
interest in the target DNA. A repetitive series of cycles involving template denaturation, primer annealing, and extension
of the annealed primers by DNA polymerase results in the exponential accumulation of a specific fragment whose
termini are defined by the 5” ends of the primers. Because the primer extension products synthesized in one cycle can
serve as a template in the next, the number of target DNA copies approximately doubles at every cycle. Thus, 20 cycles
of PCR yields about a million-fold (2°°)‘amplification: The original PCR method, invented by Kary Mullis, was used to
diagnose prenatal sickle-cell anemia.** With advances iri'the polymerase chain reaction process, analyzing forensic
casework has been made more efficient. The ability to extract and type DNA from forensic evidentiary samples has
revolutionized the field of forensic DNA. Previously, genetic marker typing was limited to the analysis of blood group
markers and soluble polymorphic.protein.markers. Because.the.number.of suitable markers.expressed in particular fluids
and tissues is relatively small, and-because mixtures of fluids cannot be separated for conventional genetic marker
typing, a suspect frequently cannot be included or excluded as a fluid donor:in:a case. However, the development of
methods to extract DNA from virtually all biological specimens has greatly expanded the potential for individual
identification.’

Taq DNA Polymerase

Initially, PCR amplification used the Klenow fragment of E. coli DNA polymerase | to extend the annealed primers. This
enzyme wasrinactivated-by-the-high temperatures required to separate the two,DNAustrands at the outset.of.-each PCR
cycle. Freshrenzyme had to be added constantly during every cycle. To make the process more time efficient molecular
biologists began to'use ‘an enzyme from a thermophilic eubacterial'microorganism, Thermus aquaticus (Taq), capable of
growth at 70°C-75°C.? Although Taq DNA polymerase has a very limited ability to synthesize DNA above 90°C, the
enzyme is relatively stable and is not denatured irreversibly by exposure to high temperatures. Preliminary results
indicate retention of 65% activity after a 50-cycle PCR amplification when the upper limit temperature was 95°C.* Under
normal reaction conditions, the amount of Tag DNA polymerase becomes limiting after 25-30 cycles of amplification.”
Two forms of Tag DNA polymerase that are now available are both a genetically engineered form of the native enzyme
synthesized in E. coli. One of these DNA polymerases, AmpliTaq Gold™ (Perkin-Elmer), is provided in an inactive
state. Heat activates the enzyme. This feature allows flexibility in reaction setup. Both forms of the polymerase carry a
5'— 3’ polymerization-dependent exonuclease activity, but they lack a 3 — 5’ exonuclease activity.**

PCR Primers

In order to amplify a sequence of DNA, oligonucleotide primers flanking the target DNA sequence of interest are used.
These oligonucleotide primers typically have different sequences and are complementary to sequences that lie on
opposite strands of the template DNA with their 3’ ends oriented toward each other. The template DNA is first denatured
by heating in the presence of a large molar excess of each of the two oligonucleotide primers and the four dNTPs. The
reaction is then cooled to a temperature that allows the oligonucleotide primers to anneal to their target sequences, after
which the annealing primers are extended with the enzyme Thermus aquaticus (Tag) DNA polymerase in an automated
series of heating and cooling cycles. With each cycle the DNA will approximately double the number of copies. The
primers are responsible for the sequence specificity of the PCR reaction. Typically the length of the primers used in the
PCR amplification should be at least 16 nucleotides (preferably-20-to 30 nucleotides) in length and single stranded.*
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Introduction
INTRODUCTION

An important development in the field of forensic science was the introduction of DNA typing systems for the analysis
of biological samples. The RFLP-based typing system is highly informative, but requires greater than 50 ng of high
molecular weight DNA and involves the use of multiple radioactive/chemiluminescent probes to obtain a result. An
alternative approach to forensic DNA typing is based on the powerful polymerase chain reaction(PCR) technology,
which does not require the use of radioactivity 2. Specific regions of the genome containing either sequence
polymorphisms or length polymorphisms are amplified from minute amounts of DNA. Alleles which have been
amplified and contain sequence differences may be typed using the "reverse dot blot technology.® Amplified alleles
containing length variations, such as short tandem repeats (STRs) and amplified fragment length polymorphisms (AMP-
FLPs) may be typed by polyacyrlamide gel or capillary electrophoresis.

STR loci consist of short, repetitive sequence elements of 3 to 7 base pairs in length.” These abundant repeats are well
distributed throughout the human genome and are a rich source of highly polymorphic markers which may be detected
using the polymerase chain reaction. The alleles for these loci are differentiated by the number of copies of the repeat
sequence contained within.the amplified.region.and.are distinguished from.one another.using radioactive, silver stain, or
fluorescence detection following electrophoresis. In the capillary system, fluorescence detection of the amplified product
is accomplished during the-electrophoresis. The PowerPlex® 16 System provides a rapid, non-isotopic method which can
be used to evaluate very small amounts of human DNA. STR typing is more tolerant of the use of degraded DNA
templates than other typing methods because the amplification products are less than 500 bp long, much smaller than the
material detected with AMP-FLP*® or VNTR"® analysis.

The PowerPlex® 16 System allows the co-amplification and four-color detection of sixteen loci (fifteen STR loci and
Amelogenin) and the internal lane standard (ILS 600). The PowerPlex® 16 System contains the loci Penta E, D18S51,
D21S11, THO1, D3S1358; FGA; TPOX, D8S1179; VWA; Amelogenin,Penta D, CSF1PO, D16S539, D7S820,
D13S317, and D5S818. In the system, the primer sets specific for Penta E, D18S51,,D21S11, THO01, and"D3S1358,
contain one primer of each pair that is labeled with fluorescein (FL); the primer sets specific for the following loci: FGA,
TPOX, D8S1179, VWA, and Amelogenin contain one primer of each pair that is labeled with carboxy-
tetramethylrhodamine (TMRY); and the primer sets specific for the following loci: Penta D, CSF1PO, D16S539, D75820,
D13S317, and D5S818 contain one primer of each pair that is labeled with 6-carboxy-4’,5’-dichloro 2°,7" —
dimethoxyfluorescein (JOE). All sixteen loci are amplified simultaneously in a single tube or plate well and analyzed in
a single capillary®.

Capillary electrophoresis involves the use of acrylamide polymers packaged into glass capillaries for separating
fragments of DNA of varying length depending on the function for which it is used (i.e., sequencing versus fragment
analysis). The acrylamide polymers used are not cross-linked, however, DNA fragments are retarded in proportion to the
length of the molecule in a manner similar to conventional gel electrophoresis. The internal diameter of the capillaries
used is small, 50 pm.*® The narrow capillary (thus high surface area) enables the application of high electric fields, and
thus faster run times, without overheating problems associated with the high voltages due to the more efficient heat
dissipation.
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1 PCR Amplification

1 PCR AMPLIFICATION

1.1 Technical Notes

111

1.1.2

113

Taq DNA Polymerase, purified from Thermus aquaticus, attaches nucleotides in a 5’--->3 direction to
extend the DNA chain..

The PowerPlex® 16 System contains 16 sets of primers and allows for the co-amplification and three-
color detection of 16 loci (15 STR loci and Amelogenin), which include the FGA, TPOX, D8S1179,
VWA, Amelogenin, Penta E, D18S51, D21S11, THO01, D3S1358, Penta D, CSF1PO, D16S539, D75820,
D13S317, and D5S818 loci.

If a batch of samples will be amplified using the Biomek® Automation Workstation as few as one
amplification negative control and amplification positive control may be amplified per Biomek®
Automation Workstation run. However, in order to report the typing results for the evidence samples
associated.with these controls, the controls.must work.appropriately in accordance with the procedures
outlined in Chapter-8, Interpretation of The PowerPlex® 16 System PCR Amplification Results.

1.2 Equipment

1.2.1  Thermal Cycler — 9700

1.2.2  Pipettes - 2 pL, 10 pL, 20 pL, 100 pL and/or 200 pL

1.2:3+ 8-Channel-Pipette= Range 0:5uL to 10-uL

1.2/4  Biological Safety'Hood

1.2.5  Microcentrifuge tube racks

1.3 Materials

1.3.1  Sterile ART pipette tips - 2 pL, 10 pL, 20 pL, 100 pL and/or 200 pL

1.3.2 1.5 mL microcentfuge tubes

1.3.3  Kimwipes

1.34  Sterile MicroAmp® tubes (0.2 mL tubes)

135 Gloves

1.3.6 96 well amplification plates (TempPlate® 111 P/N 1402-9700 or similar) and strip caps or plate sealing
film (TempPlate® P/N-2921-000 or similar)

1.3.7  Compression pad (ABI P/N 4312639 or similar)

1.4 Reagents

141  Powerplex® 16 System Primer Pairs

1.4.2  Sterile Type | Water

1.43 Gold ST*R 10X Buffer

1.4.4  Amplification Positive Control
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1 PCR Amplification
1.45  AmpliTaqg™ Gold DNA Polymerase
1.5 PowerPlex® 16 System Amplification Procedure for the 9700 Thermal Cycler

NOTE: A dedicated area, such as a biological hood or a separate room, should be used for preparing PCR
amplification reactions. All equipment-and supplies used to prepare amplification reactions should be
kept in this dedicated “clean" area at all times. Do not use these items-to handle amplified DNA or other
potential sources of contaminating DNA. Trace amounts of amplified DNA, if carried over into other
samples before amplification, can lead to results that can be misinterpreted. DO NOT bring amplified
DNA, or equipment and supplies used to handle amplified DNA, into the designated "clean™ area. Wear
clean disposable laboratory gloves while preparing samples for PCR amplification. Change gloves
frequently or whenever there is a chance they have been/contaminated with DNA.

151  Amplification Parameters for the 9700 Thermal Cyclers:

1511 Turn.on.the 9700 thermal cycler..Program as follows using the step cycle file, change the
defaultsetting to:

Set a hold file for 11 minutes at 95°C.

Link this hold file to a separate hold file to denature at 96°C for 1 minute.
Link this preheat program to a separate program as follows:

Ramp 100% to denature at 94°C for 30 seconds

Ramp 29% to anneal at 60°C for 30 seconds

Ramp 23% to extend at 70°C for 45 seconds

Program for 10 cycles

Link this program to a separate program as follows:
Ramp 100% to denature at 90°C for 30 seconds
Ramp 29% to anneal at 60°C for 30 seconds

Ramp 23% to extend at 70°C for 45 seconds

Program for 21 cycles

Link to a 60°C hold file for 30 minutes

Link to a 4°C hold cycle.

This program may be saved as a “User File” for later use.

NOTE: The PowerPlex® 16 Allelic Ladder and Internal Lane Standard 600 supplied in the PowerPlex®
16 System kit do not require amplification and should not be stored in the sample preparation
area.

1.5.2  Transfer the PowerPlex® 16 System amplification reagents to the designated “clean” area and allow the
Gold ST*R 10X Buffer, amplification positive control-and the PowerPlex® 16 10X.Primer Pairs to thaw
completely at room temperature.

1.5.3  Place the required number of labeled sterile MicroAmp® reaction tubes (or 96-well plate, incl. one label
for entire plate indicating the plate name) in a rack.

1.5.4  Calculate the required volume of each PCR amplification component to prepare a master mix by
multiplying the volume by the number of samples. This should include reagent blanks, plate blanks
(associated only with samples extracted on the Biomek® Automation Workstation), and positive and
negative amplification controls and additional reaction volumes (depending on the number of samples
being amplified) to compensate for any pipetting variation. The PCR Master Mix should be prepared in a
clean 1.5 mL microcentrifuge tube.
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1 PCR Amplification
Half Reaction Master Mix:

1.25 pL Gold ST*R 10X Buffer

1.25 uL PowerPlex® 16 10X Primer Pairs
4.60 pL Sterile Type | Water

0.40 uL. AmpliTag™ Gold Enzyme (2 Units)

155  Add 7.5 pL of PCR Master Mix to each labeled sterile MicroAmp® tube or well of the 96 well plate using
sterile ART tips. Cap each tube and ensure that the solution is at the bottom of the tube by gently tapping
each tube on the counter top.

NOTE: Each PowerPlex® 16 Systemamplification is performed in a final volume of 12.5 pL. Exactly 5
pL has been allocated for the sample DNA. However, when a body identification or reference
sample contains a low level of DNA(e.g., 0.05 ng/pL or less DNA) estimated based upon the
DNA qguantitation, 9.6 pL of sample DNA may be used and the water removed from the Master
Mix cocktail.

No more than one tube should be opened at a time when making the following additions. Use a
new sterile ART tip for each addition.

1.5.6  Prepare the sample DNA and controls as follows:

1.5.6.1 Open the MicroAmp® tube containing the DNA extract and carefully add 5 pL of sample
DNA (0.62 to 1.25 ng/5 uL is in general the optimal target concentration, however the full 5
pLofundiluted DNA may beadded when the target,concentration cannot hesreached) to the
appropriate labeled sample tube or well'in 96-well amplification plate.

156.1.1 If samples intended solely to collect “touch” or “wearer” DNA do not have more
than 0.006 ng (6 pg) /ul of autosomal or Y DNA (using the Plexor quantitation
system), these samples will not proceed through the DNA typing step. This is
not intended to apply to samples collected for other body fluids that may also
contain "touch™ DNA (such as a knife handle contaminated with blood).
Exceptions will be considered by the Program Manager on a case-by-case basis.

1.56.2 Positive Amplification Control: Gently mix by hand the Control DNA followed by a light
tapping of the tube on the counter top to remove any liquid from the cap. Open the
MicroAmp® tube and carefully add 5 pL (0.62 to 1.25 ng/5 uL) of the Control DNA to the
appropriate labeled sample tube or well in 96-well amplification plate.

NOTE: When preparing the stock Control DNA, dilute the sample to a concentration of 0.12
to 0.25 ng/uL with sterile Type | Water.

1.5.6.3 Neégative Amplification Control: Open the MicroAmp® tube and carefully add 5 pL of sterile
Type | water to the appropriate labeled sample tube or well in 96-well amplification plate.
Note: if a volume of 9.6 pL of sample DNA will be used for any samples during the
amplification step, 9.6 uL of the Type | water will be used.

15.6.4 Reagent Blank(s) or Plate Blank(s): Open the MicroAmp® tube and carefully add 5 L of the
reagent blank(s)/plate blank(s) to the appropriate labeled sample tube or well in 96-well
amplification plate. Note: if a volume of 9.6 pL of sample DNA will be used for any samples
during the amplification step, 9.6 pL of the reagent blank(s)/plate blank will be used.

1.5.7  Place the MicroAmp® tubes or the 96-well amplification plate into the thermal cycler. Push the tubes or
plate down completely into the block. Add a compression pad (ABI P/N 4312639 or similar) (for
amplification in plates only), place the thermal cycler lid over the samples, and tighten.

1.5.8  When the thermal cycler prompts the user for the sample volume, choose 13 L.
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1 PCR Amplification
1.5.9  Start the amplification file and verify the cycling parameters by monitoring the first cycle.
NOTE: The PCR amplification program will run for approximately 3.5 hours.

1.5.10 After the amplification process is complete remove the tubes or 96-well amplification plate from the
thermal cycler and proceed with all samples to the “Capillary-Electrophoresis” chapter of this manual. A
product gel may be run (in accordance with Chapter 6 “Product Gel for Determining Amplified Product”
of the Commonwealth of Virginia Forensic Biology Section Procedure Manual Section I11, Fluorescent
Detection PCR-Based STR DNA Protocol: PowerPlex® 16 BIO System) prior to capillary
electrophoresis,

1.5.11 If the sample will not be ‘analyzed within approximately three'days, the samples should be stored in the
dark at 2 to 8 °C for a few days or at -20 °C for extended periods.

NOTE: Store amplified DNA samples separate from PCR pre-amplification reagents and extracted

DNA samples.
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2 Capillary Electrophoresis

2 CAPILLARY ELECTROPHORESIS

2.1 Technical Notes

211

2.1.2

2.13

2.14

2.15

2.1.6

The Applied Biosystems 3130xI Genetic Analyzer is a fluorescent capillary electrophoresis (CE)
instrument with a 16 capillary array which can be used for,-DNA sequencing and.-fragment analysis
applications. This/includes STR (Short Tandem Repeat) analysis as well as DNA sequencing and SNP
(Single Nucleotide Polymorphism) analysis.

The capillary length and polymer type will vary based on the individual application. Sample handling and
injection is automated by use of the autosampler, which holds two 96- or 384-well plates.

The polymer delivery pump (PDP) automates the replenishment of polymer between injections so that the
instrument is capable of fully-automated operation.

Fluorescent detection is-accomplished by utilizing.an argen-ion multi-line, single mode laser with
primary excitation-lines at 488 nm and.514.5 nm to excite fluorescent dyes and a CCD camera records the
fluorescence emitted from samples within.each of the 16 capillaries.

Data analysis, including color separation, is performed semi-automatically through the use of
GeneMapper® ID software v3.2.1.

For the purpose of this manual, the following definitions apply:

2:1:6.1 Injection =all samples that were separated via CE at-a single time:Thus; for-one:injection on
the 3130xl, up to 16 samples can be separated at a single‘time.

2.1.6.2 Run - all samples that were defined on a single plate and loaded onto the instrument at a
single time for separation, regardless of the number of injections utilized to separate each
sample contained on the plate. Thus, a run could contain up to 96 samples for separation on a
single plate. At least 1 ladder sample is needed per run.

2.2 Equipment

2.2.1  Applied Biosystems 3130xI Genetic Analyzer
2.2.2  Heat block, capable of 95 °C
2.3 Materials
2.3.1  36-cm capillary array (Applied Biosystems, Inc. P/N 4315931 (16-capillary))
2.3.2  MicroAmp® Optical 96-Well Reaction'Plate (Applied Biosystems, Inc. P/N N801-0560)
2.3.3  96-well plate septum (Applied Biosystems, Inc. P/N 4315933)
2.3.4  96-well plate retainer and base (Applied-Biosystems, In¢. P/N 403081 and N801-0531)
2.3.5 50 mL conical tube
2.3.6  Freezer block
2.3.7  Sterile ART tips for pipettes — 10uL, 20uL, 100puL, 200uL, and 1000 pL

2.4 Reagents

2.4.1  PowerPlex® Matrix Standard 3100/3130 (Promega Corp. P/N DG4650)
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24.2

2.4.3

24.4

2.4.5

2.4.6

2 Capillary Electrophoresis
10X Genetic Analyzer Buffer with EDTA (Applied Biosystems, Inc. P/N 402824)
Hi-Di Formamide (Applied Biosystems, Inc. P/N 4311320)
PowerPlex® 16 Allelic Ladder (Promega Corp. P/N DG600B)
Internal Lane Standard (ILS) 600 Size Standard (Promega Corp. P/N.DG261A)

POP-4 Polymer (Applied Biosystems, Inc. P/N 4363752 (3.5 mL) or P/N 4352755 (7 mL))

2.5 Safety Considerations

25.1

2.5.2

2.5.3

The Applied Biosystems 3130/3130xI Genetic Analyzer uses an Argon-ion laser. Under normal operating
conditions, the instrument laser is categorized as a Class 1 laser. All instrument panels must be in place on
the instrument while the instrument is operating. When all panels are installed, there is no detectable
radiation present..If any panel is.removed when.the laser is.operating, (during service with safety
interlocks disabled):you may be exposed to laser emissions in-excess of the Class 3B rating. Do not
remove safety labels or disable safety interlocks.

Performance Optimized Polymer (POP) is an irritant, always wear gloves when handling or cleaning
liquid or dried polymer. It may causeskin, eye, and respiratory tract irritation.

Exposure to Hi-Di formamide causes eye, skin, and respiratory tract irritation. It is a possible
developmental and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear
appropriate-protective-eyewear; clothing;-and gloves:

2.6 Computer

2.6.1  Turn on the power for the computer.
2.6.2  Turn on the power for the 3130xI instrument. Wait for the solid green light on the front of the instrument.
2.6.3  Select the Data Collection icon from the screen to start the Data Collection software. The service console
opens, as shown in Figure 1. When all of the applications are running, the Data Collection Viewer
window opens and green squares appear, as shown in Figure 1.
ol
Messaging Service
Drata Service |
Instrument Service
Wiewwer
! Restart Al i Stop All
Figure 1. Data Collection service console.
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2 Capillary Electrophoresis

2.7 Sample and Instrument Preparation

2.7.1  Install the Capillary Array
27.11 If a capillary array has already been installed on the instrument, proceed to section 6.7.2 for
continued preparation of the instrument.
2.7.1.2 In the Data Collection software, select the “Wizards” menu and choose “Install Array”.
Follow the on-screen directions for installing a capillary array.
2.7.1.3 If a new capillary array has been installed on the instrument, a spatial calibration must be
completed prior'to funningsamplés on the instrument. Refer to Appendix F of

the Commonwealth of Virginia Forensic Biology Section Procedure Manual Section VIII,

Fluorescent Detection PCR-Based STR DNA Protocol: PowerPlex® 16 System for detailed

instructions on running the calibrations.

2.7.2  Set the oven temperature.to 60 °C.
2721 In the Data Collection software, select Manual Control in the tree pane to bring up the manual

control dialog box, as shown in Figure 2.

Manual Control
Send Defined Command For: Oven i3
Command Name Value Range
o Y
Comments:
rms main oven on and off.
| Send Command |
Figure 2. Manual Control dialog box.
2.7.2.2 Select “Oven” in the drop down menu for “Send Defined Command For:”
2.17.2.3 Select “Set oven temperature” from the drop down menu under “Command Name”.
2.7.24 Type 60 for the value and click “Send Command”.

27241 Note; the instrument-default oven temperature is set at 50 °C. Therefore, the
temperature must always be set to 60 °C for the pre-warming, prior to turning
the oven on.

2.7.3  Turn on the oven. The oven should be warming up as samples are being prepared, or approximately 30-
45 minutes.
2.7.3.1 Select “Turn On/Off oven” under command name and “On” from the drop down list under
Value.
2.7.3.2 Click *Send Command”.
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2 Capillary Electrophoresis

2.7.4  Preparation of the sample plate

NOTE: When loaded onto the same plate, all evidence samples pertaining to a case must be loaded on to
the plate prior to loading reference samples for the same case. Samples may not be added to
empty wells previously subject to sample injection.

2.74.1

2.74.2

2743

2744

2.74.5

2.7.4.6

2.7.4.7

Prepare a ‘master mix’ of formamide and size standard as-follows:

27411 Thaw the Hi-Di formamide to room temperature, vortex to mix, and pipet 9.5
uL of Hi-Di formamide for each sample (as well as extra samples to account for
pipetting variation which will vary depending on the number of samples) to a
clean microcentrifuge tube.

27412 Vortex the ILS 600 Size Standard (stored at -20 °C) and pipet 0.5 uL per sample
(as well as the same number of extra samples as in 2.7.4.1.1) to the
microcentrifuge tube-or trough-containing the formamide.

27413 Vortex this “master'mix”to ensure the contents are thoroughly mixed.
Pipet 10 uL of the “‘master mix’ into each used well of the 96-well plate.

10 uL of Hi-Di formamide, extra “master mix’ or Type | water must be pipetted into unused
wells of the plate that will be injected to ensure that air is not injected into some of the
capillaries. (That is, if one injection (16 samples total) will be completed on the 16-capillary
3130xI, it is.necessary. to ensure that all sample wells in the' two columns contain liquid.)

Pipet PCR product (for samples, positive controls, and negative controls) into the
corresponding well of the 96-well plate. Typically, 1 uL of PCR product will be added.
However, 0.5 uL or 2 uL of the PCR product may be used at the analyst’s discretion. For
over-amplified samples, it may also be necessary to dilute the PCR product prior to removing
an aliquot to place into the injection cocktail.

NOTE: The same volume of PCR product (or more) used for the samples must also be used
for the negative controls and associated blanks.

Pipet 1 pL of allelic ladder into at least one well per run.

After addition of all samples, the plate septum should be placed on top of the sample wells
and the plate heated at 95 °C for >2 minutes.

Following heating, the plate should be placed in a freezer block or on ice for at least two
minutes prior to.loading.

2.7.5  Complete the following maintenance tasks:

2751

Prepare 35 mL of 1X Genetic Analysis Buffer with EDTA by diluting the 10X stock Genetic
Analysis Buffer with EDTA. The 1X Genetic Analyzer Buffer may be used for up to 48 hours
after its preparation. Ensure adequate levels of buffer are in the respective reservoirs
(reservoir 1, as shown in Figure 3, and the anode buffer reservoir, as shown in Figure 5) and
the outside of the reservoirs are dry. Remove any buffer droplets from the inside of the
reservoirs that may be clinging to the walls.
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2 Capillary Electrophoresis

2.75.2 When replacing the 1X running buffer, the water reservoirs (2 and 4) should also be rinsed
and refilled with Type 1 H,O to the fill line. Figure 3 shows a diagram of the reservoirs,
indicating which contain H,O and buffer.

7 Watar reservolr " Vater reservoir
fwaste] (rinse)
Cathode reservalr ) " Water reservoir

(1% running buffen
& _| _________ F

l— Home position

{unused)

Figure 3. Location of buffer and water reservoirs on the 3130xI
Figure reproduced from Applied Biosystems 3130/3130xI Genetic Analyzers (2004)
Maintenance and Troubleshooting Guide.

2.75.3 Ensure the plate assemblies are properly assembled (as shown in Figure 4) and positioned on
the deck properly. Note: if the plate assembly is properly assembled, the gray septa will not be
visible when looking down through the holes of the plate retainer. Instead, the wells will
appear black. If the plate assembly is not properly assembled, damage to the capillary array is
likely to occur.

"

» Plate Retainer

<= Plate Septa /
Sample Plate

=, Flate Base

Figure 4. Proper assembly of the plate for loading onto the instrument
Figure reproduced from Applied Biosystems 3130/3130xI Genetic Analyzers (2004)
Maintenance and Troubleshooting Guide

2754 Check for bubbles in the pump block, lower polymer block, interconnect tube, polymer
supply tube, and channels. If bubbles are present, remove all bubbles with the Bubble Remove
wizard.

2.7.5.5 Check the loading-end header to ensure the capillary tips are not crushed or damaged.

2.7.5.6 Ensure that sufficient volume of polymer is-present.in the-bottle for run. (Note: approximately
0.5 mL of polymer is sufficient to run approximately a plate of samples without introduction
of bubbles into the pump block. Additional polymer may be necessary to clear bubbles, etc.)

2.75.7 Ensure that the pump block and lower polymer block are securely fit on the instrument.

2.75.8 Ensure that the instrument surfaces are clean; always use deionized water to clean.
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2 Capillary Electrophoresis

2.759 Check for leaks around the array knob, interconnecting tube nuts, and check valve, all of
which are shown in Figure 5.

Mounting pin

PDP motor

| | L
tinge fitting I 1 FDP mator cover
L 1

"7 Capillary array tip

‘Water seal ‘i b
Waste fitting :[]:m @)

Water trap - £ Gapilary aray
Maunting pin O L S,
Piston | Capillary array knob
Pump chamber - o,
Pump block b—

Chack valve \ I, Double-tapered ferrule

-Array port

// Interconnect tube

Polymer supply tube // //

= o4
% 0 Buffer valve pin
Pal " Mourting ﬂx Lower polymer block
alymer su|
; ey “‘{:J,_ pin ——@& [e) Maounting pin

bottle cap with |
hole - | |
O-ring o Overflow hole
) L Buffer fill-line
Palyriisr y |
supply bottle | Anode buffer raservoir
| (16 mL anode reservoir)
/
Electrode GRoAze : l

Figure 5. Diagram of the pump block and associated components of the ABI 3130xI Genetic Analyzer.
Figure reproduced from Applied Biosystems 3130/3130xI Genetic Analyzers (2004) Maintenance and Troubleshooting Guide

2.8 Instrument Operation

2.8.1  Ensure that the instrument doors are closed and the green light on the front panel of the instrument is on.
Open the 3130xI data collection software. The data collection software sets up the instrument for
operation and data collection and manages the database for every aspect of the capillary electrophoresis.
The software has two basic components: Data Management (e.g., ga3130xI) and Instrument Control (e.g.,
3130x1), both of which are found in the tree pane shown in Figure 6.

m Foundation Data Collection Yers

File View Service Tools Wizards Help

ol ) i
= b GA nstrumerts Figure 6. Tree pane of the Data Collection
DResuts Group software on the computer associated with the
&) Detahase arger 3130xI Genetic Analyzer.
= Elga3130a
Plate Manager
IE Protocol Manager
'ﬁModule Manager
Gl Run Histary
=
Einstrumert Status
wSpaﬁal Fun Scheduler
EIRun Scheduler
=Capillaries Wigsver
.Cap!.&rray Wieywer
nSpectraI iewwer
Qﬂ'ﬂ'Manual Cortrol

@Service Log
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2 Capillary Electrophoresis

2.8.2  Plate Manager - Sample information is entered into corresponding plate locations along with the
individual protocol, results group, and analysis method for each sample loaded on the plate. Sample
information can be entered manually within the plate manager or imported from an external worksheet.
Each injection group (16 samples corresponding to the 16 capillaries) must have the same instrument
protocol as it represents a single injection. Samples should be organized on the plate in order to maximize
efficiency considering the capillaries labeled 1-16 correspond.to A1-H2; A3-H4, A5-H6, A7-H8, A9-
H10, and A11-H12 on the sample plate for each injection. See Figure 7.
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Figure 7. Schematic of capillary locations (left) and depiction of sample plate (right). Capillaries labeled 1-16
correspond to Al=H2, A3-H4, A5-H6, A7-H8, A9-H10, and"A11-H12 on the sample plate for each

injection, resulting in a maximum of six injections per 96 sample plate.
Figure reproduced from Applied Biosystems 3130/3130xI Genetic Analyzers (2004)
Maintenance and Troubleshooting Guide

28.2.1 Click on the Plate Manager fromthe ga3130xI dropdown list.
2.8.2.2 The sample information may be entered in a manual or automated fashion.
2.8.2.3 Manual-Sample Input

2.8.2.3.1 Click the “New” button at the bottom of the display to open the New Plate
Dialog box.

2.8.2.3.2 Complete the information in the New Plate Dialog: Type a name and description
(optional) for the plate.

2.8.2.3.3 Select your fragment analysis application in the “Application” drop-down list.
Typically, this will be “3130xI_1".

2.8.2.34 Select 96-well or 384-well in the “Plate Type” drop-down list.

2.8.2.35 Type DFS for the owner and a name or initials for the operator.
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2 Capillary Electrophoresis

2.8.2.3.6 Click “OK” to open the Plate Editor, as shown in Figure 8.
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Figure 8. Plate Editor. The sample name, results group, instrument protocol, dye set, etc. are
set for each sample being separated on the 3130xl.

2.8.2.3.7 For each sample, fill in the following:
Sample Name

The Priority column will fill in automatically. Lowering the number (100 is
default) for each set of 16 samples increases the priority.

Comments column, enter any comments or notations for the sample (optional)

Sample Type — choose either allelic ladder, positive control, negative control, or
unknown from the drop down list.

Size Standard - choose ILS600 from the drop down menu

Panel — choose the PowerPlex® 16 panel from the options listed. Typically, this
will be “PowerPlex_16 1D3.2.0”.

Analysis Method — choose the appropriate analysis method. Typically, this will
be “PowerPlex16advanced”, found under a sub-menu.

Results Group - select a group from the drop-down list or create a new one (as
described in Appendix L).

Instrument Protocol — select a protocol from the drop-down list. This will be
“PP16_5sec” for the PowerPlex® 16 kit unless otherwise indicated.

2.8.2.3.8 When finished entering the information in the plate manager, click “OK”.
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2.8.3

2 Capillary Electrophoresis
2.8.24 Automated Sample Input

2.8.24.1 The plate data must be created from an outside program such as Microsoft Excel
and be in a tab-delimited, .txt, format before it can be imported.

2.8.24.2 Click on/the “Import” button on the-bottom<of the display to open the “Import
Plate” dialog box.

2.8.24.3 Select the location and file containing the plate data and click on “OK”. The
plate will be added to the list of plate records.

2.8.24.4 CheckK the plate record by selecting the plate and clicking “Edit” to ensure the
plate samples, results groups, protocols, and analysis methods are correct.

Run Scheduler — Two plates may be loaded onto the autosampler at a time in positions A and B. The run
scheduler.designates which plates are located.in.which-position on the autosampler. When loading the
autosampler, ensure:the plate is properly positioned in either-position A or B. If two plates are loaded into
the autosampler; the first plate linked to its plate map will be'the first plate that is injected, independent of
whether it is loaded into position A or B (unless the priority column of the plate map has been used to re-
prioritize the injections). The plate on the left in the autosampler is defined as position A and the plate on
the right is defined as position B, as described below.

2.8.3.1 Click “Run Scheduler” in the tree pane of the Data Collection software to open the Run
Scheduler window, as shown in Figure 9.
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Figure 9. Run Scheduler.

2.8.3.1.1 Repeat 2.8.3 to indicate the location of a second 96-well plate, if necessary.
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2 Capillary Electrophoresis

2.8.3.2 Once the plates have been linked, the run can be started. Click the green button ¥ inthe
toolbar.

2.8.3.3 The Processing Plates dialog box opens. Click “OK”.

2.8.34 Following completion of the run,.proceed to the“Analysis of Capillary Electrophoretic Data”
chapter of the Commonwealth of Virginia ForensicBiology Section Procedure Manual
Section V111, Fluorescent Detection PCR-Based STR DNA Protocol: PowerPlex® 16 System
for data analysis.
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3 Analysis of Capillary Electrophoretic Data
3 ANALYSIS OF CAPILLARY ELECTROPHORETIC DATA
3.1 Technical Notes

3.1.1  The raw data obtained with the Applied Biosystems 3130xI Genetic Analyzer can be analyzed using
GeneMapper® 1D software v3.2.1

3.1.2  GeneMapper® ID is an automated genotyping software program for forensic data analysis that supports
analysis of electropherogram data obtained from the ABI 310 Genetic Analyzer, ABI 377 DNA
Sequencer, ABI 3100 and 3100-Avant Genetic Analyzers, and the ABI 3130 and 3130xI Genetic
Analyzers.

3.1.3  Tothe extent possible, the evidence samples will be analyzed by the examiner/reviewer prior to
analyzing/reviewing the reference sample results.

3.2 Logging On

3.2.1  Open the GeneMapper® ID software v3.2.1 by double-clicking-on the software icon.

3.2.2  Select the appropriate user name and type the password.
3.23 Click OK.
3.3 Project Window

3.3.1 = Upon opening the' GeneMapper® ID software, the user is taken to the Project Window, as'shown in Figure

7, GornoMappar ID ¥3.2 - Untitled - gmid ks Logged In

HS@ BE BN EEE EE ey H BE -

St |Sampe Fie Sample Name | Sample © Commerds | Sample Typs | Specien Cale| Anatrss Method Farel Size Rarded e Rnieme  ns

Figure 1. Project Window.
3.3.2  To begin the data analysis, samples must be added to the project to be analyzed.
NOTE: All samples to be analyzed from a single run should be added at once. If not done in this
manner, the GeneMapper® |D'software may not associate the correct allelic ladders with the
given samples.

3.3.21 Choose “File” and “Add samples to Project” or, click the % icon.

3.3.2.2 Browse to the data files to analyze. You may select the entire folder or pick the files within
the folder to analyze.

3.3.2.3 Click “Add to List” (bottom left of screen) then “Add” (bottom right of screen).
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3 Analysis of Capillary Electrophoretic Data

3.3.3  Upon addition of the samples to the project, the “Samples” tab will become populated, as shown in Figure
2. The population of the information is based on that entered in the Plate Map in the ABI 3130xI Data
Collection Software. Double check to ensure that the correct panel, sample type, and analysis method are
selected. If changes need to be made to this information, select the necessary cells and choose the
appropriate settings from the drop-down menus. Verify that the information is correct before proceeding.

(#)GeneMapper ID v3.2.1 - *est4 - gmid Is Logged In

Fle Edit Anclysis View Tooks Help
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3 h PasCtrl Posftive Cortrol |PowverPlex Badvanced |PowerPlex_16_0320 |KMH_PP16val
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0 | 042408 HE Sample PowverPlex Badvanced |PowerPlex_16_ID320 |KMH_PP1Gval
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Figure 2. “Samples” tab upon adding samples to the newly created project.
3331 Analysis Method = “PP16”
3.3.3.2 Panel = “PowerPlex_16_1D3.2.0”
3.3.4  Each data file has an |h :on in the Status column indicating that it needs to be analyzed.

3.3.5 Inthe tree pane view on the left side of the screen, choose the file name of a negative control. Choose
View>Raw Data to view the unseparated raw fluorescence data.

3.3.6  The recognizable pattern of the size standard should appear in orange. The raw data may be used to
evaluate baseline problems or noise that could.result in poor sizing. In addition, the start and stop points
for the analysis should be noted. The start and stop points should be such that all size standards are
encompassed by the data points analyzed. Typically, this is approximately 3000 — 10000 data points, but
may need to be modified if, for example, at the 10,000 end point, the 600 bp size standard is missing. In
that example, extending the range beyond 10,000 will include the missing 600 bp fragment. This start and
stop point will be selected in the Analysis Method Editor, as shown below.

3.3.7  Exit from the Negative Control raw data, and select Analysis>Analysis Method Editor
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3 Analysis of Capillary Electrophoretic Data

3.3.7.1 All of the settings should remain the same with the exception of the starting and stopping
points, defined in 3.3.6.

3.3.7.2 Click on the “Peak Detector” tab.

3.3.7.3 The Peak Detector tabis where the values suchas.dye specific detection thresholds are set
(Figure 3).
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Analysis Method Editor - HID
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Figure 3. The Peak Detector Tab window. An example of peak amplitude threshold
settings is shown. A solid arrow indicates the data analysis range start and stop
points. The dashed arrow indicates the peak amplitude threshold for the red dye,
which may be altered if needed. No other threshold values may be altered.
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3 Analysis of Capillary Electrophoretic Data

3.3.7.3.1 The values for the peak amplitude thresholds are based upon empirical data
derived from the limit of detection analysis performed during the validation
work. While the ILS 600 (which uses the red dye) will have its default peak
amplitude threshold set based on the LOD analysis, the threshold may be
adjusted upward high enough to prevent detection of a known artifact present in
the Promega ILS 600 size standard.(Figure4) or reduced when the ILS 600
peaks may fall below the default threshold (this can occasionally occur with the
2 second injection). Only the red dye (for the ILS 600) can have its LOD value
modified. If such adjustment is necessary, refer to Appendix D for directions.

(7 Size Match, Editor
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Figure 4. Size Match Editor window showing the ILS 600 size
standard. The arrow points to the artifact at approximately 172 bp.

3.3.8 Analyze the samples by clicking the green arrow: . (Analyze). Upon prompting, type a name for the
project. Click OK.

3.3.9  Examining Analysis Results

NOTE: When loaded on the same plate, all evidence samples pertaining to a case must be analyzed
prior to opening any reference sample electropherograms pertaining to the same case.

3.3.9.1 Examine the size standard by examining the flags in.the SQ (sizing quality) column. A green
square indicates that a sample has passed the sizing criteria. For any samples that do not pass
the sizing criteria, indicated by a yellow triangle or red octagon, assess the size standard by
highlighting the samples and click on the icon: []] or selecting Analysis>Size Match
Editor. ——

NOTE: If the majority of the size standards fail, look for a global problem with the run, such
as a poorly-chosen data analysis range in the Analysis Method Editor (see 3.3.6).
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3 Analysis of Capillary Electrophoretic Data

3.3.9.2 If the sizing standard is observed in the sample, check to see that all peaks are detected and
the peaks are labeled correctly. If no sizing standard is observed, the injection may have failed
or no ILS and/or sample was added to the well. The peaks should follow the pattern shown in
Figure 5. Spikes or other artifacts may be mislabeled by the software, resulting in poor sizing.

Sizing Quality = 1.0 [ Owerride 50 ]
1000_ 100 200 300 400 500 600
800_
5 140-180| 250 350 450
Iﬁlf E00_ 1201160 |225 1275|325 | 375]425 475 550
400_
200,
] a
Size (bp)
Figure 5. ILS 600 Size standard. The peaks are labeled with their base pair size. The
60 bprand 80 bppeaks.are unlabeled-in this figurerand may or may not:be utilized for
sizing purposes.
3.3.9.21 If the size standard peak assignments are incorrect for one or more of the
samples, adjust the peak assignments within the size match editor.
3.39.2.11 The sizing quality of the sample is shown directly above the
labeled size match electropherogram, as shown in Figure 5.
Typically, a low sizing quality value (e.g., 0.5) is a result of a
peak shift (the software incorrectly identifies one peak resulting
in invalid positions for the other size standard peaks), a missing
peak (the software does not identify a peak), or an extra peak
(the software identifies a peak that is not a size standard peak,
but a spike or pull-up peak).
3.39.212 To edit a particular size standard peak, right-click the peak to be
edited to open the editing pop-up window and select “Add”,
“Delete” or “Change” the selected peak.
3.3.9.2121 Choose Add or Change, move the cursor to the
right to open the Select Size sub-menu.
Choose the desired size from the menu.
Note:=The 225 bp size standard may be deleted without
compromising the sizing accuracy (source: Promega
Corp). This may be occasionally necessary since pull-up
from the yellow (TMR) channel, particularly from the
amplification positive control, can produce a pull-up peak
which overlaps with the 225 bp fragment and results in
inaccurate sizing and allele calls.
3.39.2.2 When the standard peaks are properly designated, check the sizing quality by
selecting Tools>Check Sizing Quality. If the peaks are sized correctly, the
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3 Analysis of Capillary Electrophoretic Data

quality value will improve. If the peaks are sized correctly but the quality score
is still below passing, click the “Override SQ” button, as shown in Figure 5 to
set the sizing quality to 1.0. Note that the sizing quality will now read <1.0> and
% will appear in the Sample tab under the SQO (Sizing Quality Override)
column to indicate the sizing quality has been overridden by the analyst. If the
225 bp standard is deleted due to pull-up as‘described above, the " % will also
appear if the sizing quality is improved, even-if the “Override SQ” button is not
clicked, indicating that the size standard was edited. The same icon will also
appear in the electropherogram printout in the header for each dye.
Alternatively, the sample may be re-injected at the analyst’s discretion.

3.3.9.3 "Review of the Allelic Ladder Data
3.3.9.31 In'the “Samples” tab, select each allelic ladder.
3.3:9:3.2 Display the.plots.by.clicking,the sample plots icon: il

3.3.9.3.3 Verify that the allelic ladder-is called carrectly for each locus. Figure 6
represents an example of an accurately designated PowerPlex® 16

allelic ladder.
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Figure 6. PowerPlex® 16 Allelic Ladder.
3.3.9.4 Review of sample data
3.394.1 All sample data must be reviewed carefully, with special attention paid

to samples that display a yellow triangle or red octagon, indicating low
quality analysis.
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3 Analysis of Capillary Electrophoretic Data

3.3.9.4.1.1 A green square indicates that the data passed the initial

3.3.94.1.2

3.3.94.13

3.3.9.4.2

(automated) analysis by the software in the respective
category (such as sizing quality, off-scale data, etc.).

If a flag is yellow or red, it may be helpful to look at the
raw data to'determine the problem. To/ook at the raw
data from the.samples-tab, highlight the sample and select
View>Raw Data.

If it is determined that the sample should not be
considered for interpretation due to problems within the
raw data, the sample may be re-injected or run again
using a different amplification reaction, more PCR
product, less PCR product, or other necessary procedures.

If the sizing.quality for a.given.sample.is.low, the sample will not be

genotyped by the software:
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3 Analysis of Capillary Electrophoretic Data

3.3.9.4.3 The sample data can be viewed by selecting View>Sample Plot or
choosing the icon: m The data is displayed as shown in Figure 7.
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Figure 7. An example of PowerPlex® 16 sample data. Under each allele, the allele call (repeat number), height (RFUSs),
and size (bp) are listed. If an edit was made to the allele call, this comment would also' be indicated in the box under the

peak.

3.39.44

The negative control(s) should be checked to ensure that no
amplification product (called alleles above LOD threshold) was
observed. A called allele is a peak which fits the criteria to be
designated an allele or OL (off ladder) and is above the allele calling
threshold designated in the software and therefore is labeled. Refer to
the “Interpretation of PowerPlex® 16 System Results” chapter of

the Commonwealth of Virginia Forensic Biology Section Procedure
Manual Section V111, Fluorescent Detection PCR-Based STR DNA

Protocol: PowerPlex® 16 System for interpretation guidelines.
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3 Analysis of Capillary Electrophoretic Data

3.3.9.45 The positive control(s) should be checked to ensure that injection and
electrophoresis performance was satisfactory. Refer to the
“Interpretation of PowerPlex® 16 System Results” chapter of
the Commonwealth of Virginia Forensic Biology Section Procedure
Manual Section V111, Fluorescent Detection PCR-Based STR DNA
Protocol: PowerPlex® 16 System for interpretation guidelines.
3.3.9.4.5.1 If the positive control was injected poorly, it can be re-
injected or if necessary, the positive control sample can be
re-prepared and injected. The original sample injections
can be analyzed if the correct types for the positive
contral'are documented upon the re-injection/re-run.
However, in/order to use the data produced in a run, at
least one positive control on the run must result in the
properly-designated alleles.
3.83.944.5.2 Artifacts such-as pull-up and spikes may occasionally
occur and must:be documented as described in the
“Interpretation of PowerPlex® 16 System Results” chapter
of the Commonwealth of Virginia Forensic Biology
Section Procedure Manual Section VIII, Fluorescent
Detection PCR-Based STR DNA Protocol: PowerPlex®
16 System.
3:3.9.4:5:3  If pull-up-peaks-are due to-poor color separation and not
excessive peak heightof peaks in other channels, then a
new spectral calibration may need to be performed and
the samples analyzed using the new spectral.
3.3.9.4.6 The Genotypes tab of the project window displays a number of
additional “flags” to indicate the quality of the data. These may be
used, at the analyst’s discretion, to aid in interpretation of the data.
Table 1 gives the name and description of the flags and their columns.
3.3.94.7 The flags are check marks, green squares, yellow triangles, or red
octagons.
3.3.9.4.7.1 A check mark or green square indicates the data passes
the analysis for that quality indicator.
3.3.9.4.7.2 Avyellow triangle indicates that the data should be
reviewed.
3.3.9.4.7.3 ' Arred octagon indicates poor data quality or analysis
quality. The sample may not be analyzed by
GeneMapper® ID in some instances.
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3 Analysis of Capillary Electrophoretic Data

Table 1. Peak Quality Value Flags on the Genotypes Tab

Column Description
Allele Edit
AE ¢ The check box is unchecked immediately after analysis.
+ The check box is checked when the marker allele calls have been edited by the analyst.
Allele Display Override
ADO ¢ The checkbox is checked when the number of the marker calls exceeds the number to display
previously set (in Table Settings Editor).
SHP Sharp Peak
¢ This flag is used for SNP analysis only, not fragment analysis.
Allele Number
AN + Aflag is displayed when the number-of alleles exceeds the maximum (or no alleles are found). This
maximum is set in the analysis method.
OBA One Basepair Allele
+ This flagis used for SNP/analysis only, not fragment analysis.
SPA Single Peak Artifact
+ This flag is used for SNP analysis only, not fragment analysis.
Out of Bin Allele
Bin + Aflag is displayed when the called alleles® peak apex is out of the bin boundary. The peak is then
labeled “OL”.
Peak Height Ratio
PHR ¢ Aflag is displayed when there are two alleles present and the ratio between the lower allele height
and-the higher-allele height.is below-a certain-level (default =50%, set in the Peak-Quality tab of the
analysis method). The ratio is based on the peak height of the called allele peaks.
Low Peak Height
LPH ¢ Aflag is displayed when the alleles are lower than the specified values and do not result in the
proper intensity. The default is 200 RFU, set in the Peak Quality tab of the analysis method.
Spectral Pull-Up
SPU + Aflag is displayed when the marker signal contains bleed-through peaks
¢ Pull-up is when the peak height of the called peak is less than 10% of the larger peak within £ 1 data
point.
BD Broad Peak
+ Aflag is displayed when the called alleles’ peak width is wider than 1.5 basepairs.
Split Peak
SP ¢ Aflag is displayed when a split peak is found by the software.
+ A split peak is defined as overlapping peaks that are < 0.25 basepairs apart.
(OF] Offscale
+ Aflag is displayed when there are offscale peaks present within the marker size range.
CcC Control Concordance
¢ Aflagisdisplayed when the designated control sample does not exactly: match the defined alleles
for this marker in the panel.
OVL | Overlap
+ Aflag is displayed when a peak in the overlapped region is called twice, as it is possible to have two
allele size ranges that overlap.
NB Narrow Bin
+ This flag is used for SNP analysis only, not fragment analysis.
DP Double Peak
+ This flag is used for SNP analysis only, not fragment analysis.
GQ Genotype Quality
+ Ared octagon is shown when the analysis for a sample is of low quality.
+ A green square indicates the analysis is of good quality.
+ Avyellow triangle indicates the analysis should be checked.
+ The weighting of the various factors that are used for calculating the genotype quality are set by the
analysis method.
Forensic Biology Section Procedures Manual, Section VIII DFS Document 210-D1100
Issued by Biology Program Manager Revision 4

Issue Date: 25-April-2016 Page 30 of 128




3 Analysis of Capillary Electrophoretic Data
3.3.10  Printing the results

3.3.10.1 If the project file must be transferred to another, non-networked computer, the
GeneMapper® ID project must be exported.

3.3.10.1.1 Under the Tools drop-down window, select GeneMapper Manager and
the following window will.open up-(Figure 8).

(7] GeneMapper Manager,

Projects | Analysis Methods | Table Settings | Plot Settings || Matrices | Size Standards
Project Last Saved Orivrier # of Samples
0B0508sagSenstivity 2008-06-05 16:39:3 | amic) 16 B
(0B0508zagrun_2Senstivity {2008-08-06 09:23:4 | gmid 16
0E1208RAPrelim 2008-06-20 08:13:5] amic! 30
(0E2008PCRacd 2008-06-23 03:30:5 | gmic! 46
(0E2308Reinject 2008-06-23 15:31:2 | gmic! 15
0701 0bmh 2008-07-04 13:17:0/ gmicd 149
0701 Dibrh-2 2000-07-01 17:03:2| rmict 14
070205 _bones_KMH 2008-11-06 14:00:0 gmic! il
070208PCRAMSR 2008-07-03 09:31:5 | gmic! 70
070208PCRAMHSRDegrade) 2008-07-03.05:37:4  amid 40
070208PCRAMHSRPostAmpl | 2008-07-03 10:04:0 gmic! 30
070312_MiniFiler_Cit 2008-07-29 11:26:4 | gmic! 10

[ Rerame.. l [ Save As... ] [ Irmport ] Export. J

Figure 8. GeneMapper Manager.

3.3.10.1.2  Highlight the project file that is to be exported and select export. The
project will be saved to the location and file folder designated. Transfer
the project file to a CD or approved flash drive for transfer to another
computer workstation.

3.3.10.1.3  To open the project file at another computer workstation, transfer the
project file from the CD or flash drive to the desktop or a designated
folder. Open GeneMapper® ID and then open GeneMapper Manager as
shown in Figure 8. Select import and your project file will imported
into the GeneMapper® ID project file list. Select Open file in
GeneMapper® ID and find your project in the file list.

3.3.10.2 The electropherogram of each evidence and reference:sample pertaining to a case
will'be printed for the case file and initialed by the analyst. The electropherogram
will display the allele calls, any editing comments, the peak height, and basepair
size. Any remaining electropherograms (including blanks, controls, and allelic
ladders) will'be contained in electronic form or paper form in the case file.

3.3.10.3 After reviewing each allele call in the samples plot, the x- and y-axes should be set
accordingly for printing (as shown below). If the axis needs to be changed, right-
click on the axis to display the scale settings.
3.3.10.3.1  X-axis = 95bp — 500bp

3.3.10.3.2  Negative Control, Reagent Blank, or samples with no typing results: Y-
axis =0-100 RFU
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3 Analysis of Capillary Electrophoretic Data

3.3.10.4 Print the electropherogram by File>Print.

3.3.10.5 Should additional documentation be necessary to support an allele designation, other
views of the data (such as a zoomed-in view of an electropherogram) may be printed
and retained in the case file, at the analyst’s discretion.

COPYRIGHT © 2016

VIRGINIA
DEPARTMENT
OF
FORENSIC SCIENCE

UNCONTROLLED
COPY

Forensic Biology Section Procedures Manual, Section V111 DFS Document 210-D1100
Issued by Biology Program Manager Revision 4
Issue Date: 25-April-2016 Page 32 of 128



4 Interpretation of Powerplex® 16 System PCR Amplification Results
4 INTERPRETATION OF POWERPLEX® 16 SYSTEM PCR AMPLIFICATION RESULTS
4.1  Technical Notes

4.1.1  STR alleles are small in size, generally less than 500 bp and contain repeat units ranging from 3 to 7
bases.

4.1.2  If an allele contains an incomplete repeat, the allele is considered a microvariant and is designated by the
number of complete repeats present followed by a decimal point, followed by the number of bases of the
incomplete repeat. For example, the FGA 22.2 allele contains 22 tetrameric repeats plus 2 bases. Because
of a deletion of two bases the FGA 22.2 allele is two bases shorter than the FGA 23 allele.

4.1.3  The characteristics of the PowerPlex® 16 System and the allelic ladders are given in the table below':

Table 1. PowerPlex 16° System loci and allelic ladder alleles

Locus * Repeat Chromosome Size Range Alleles present in Allelic Fluorescent
Sequence Location of Allelic Ladder Label
53 Ladder (bp)
FGA TTTC 4931.3, afibrinogen, 322-444 16-30, 31.2, 43.2, 44.2, TMR
Complex 3 intron 45.2,46.2
TPOX AATG 2p25.3 thyroid peroxidase, 262-290 6-13 TMR
10" intron
D8S1179 TCTA 8924.13 203-247 7-18 TMR
Complex
VWA TCTA 12p13.31 von Willebrand 123-171 10-22 TMR
Complex Factor, 40" intron
Amelogenin NA Xp22.1-22.3 and Y 106 - X X, Y TMR
112-Y
Penta E AAAGA 15026.2 379-474 5-24 FL
D18S51 AGAA 18921.33 290-366 8-10, 10.2, 11-13, 13.2, 14- FL
27
D21S11 TCTA 21921.1 203-259 24,24.2,25,25.2, 26-28, FL
Complex 28.2,29, 29.2, 30, 30.2, 31,

31.2,32,32.2, 33, 33.2, 34,
34.2, 35, 35.2, 36-38

THO1 AATG 11p15.5 tyrosine 156-195 4-9,9.3,10-11, 13.3 FL
hydroxylase 1% intron
D3S1358 TCTA 3p21.31 115-147 12-20 FL
Complex
Penta D AAAGA 21922:3 376-449 2.:2;3.2;:5, 7-17 JOE
CSF1PO AGAT 5033.1 c-fms proto- 321-357 6-15 JOE
oncogene, 6™ intron
D16S539 AGAT 16g24.1 264 — 304 5,8-15 JOE
D7S820 AGAT 7921.11 215 -247 6-14 JOE
D13S317 AGAT 13g31.1 169 -201 7-15 JOE
D5S818 AGAT 5023.2 119 -155 7-16 JOE

*All repeat sequences are defined using the recommendation of the DNA Commission of the International Society of

Forensic Haemogenetics (ISFH): 1) for STR loci within coding genes, the coding strand shall be used and the repeat

sequence motif defined using the first possible 5' nucleotide of the repeat motif; and 2) for STR loci not associated with a

coding gene, the first database entry or original literature description shall be used.**

KEY: TMR = carboxy-tetramethylrhodamine, FL = fluorescein, JOE = 6-carboxy-4’,5’-dichloro-2’,7’-
dimethoxyfluorescein.
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4 Interpretation of Powerplex® 16 System PCR Amplification Results

Applied Biosystem 3130xI| Genetic Analyze

r==

Fluorescein is detected at a wavelength of ~530-540 nm.

TMR is detected at a wavelength of ~580-590 nm.

JOE is detected at a wavelength of ~555-565 nm.

4.1.4  The Fluorescent Internal Lane Standard 600 (CXR — carboxy-X-rhodamine) consists of 22 DNA
fragments (60, 80,100, 120, 140, 160, 180, 200, 225, 250, 275, 300, 325, 350, 375, 400, 425, 450, 475,

500, 550, and 600 bp) and can be detected at a wavelength of ~615-625 nm**.

415 The “Known” Genotypes for the amplification positive control DNA using the PowerPlex® 16 System are

given in the table below®

Table 2. 2800M PowerPlex®.16 profile

Locus Genotype
Penta E 7,14
D18S51 16,18
D21S11 29,31.2

THO1 6,9.3

D3S1358 17,18
FGA 20,23

TPOX 11,11
D8S1179 14,15

VWA 16,19

Amelogenin X, Y

Penta D 12,13
CSF1PO 12,12
D16S539 9,13
D7S820 8,11
D13S317 9,11
D5S818 12,12
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4 Interpretation of Powerplex® 16 System PCR Amplification Results

4.2  Procedure

4.2.1  Verification of the allelic ladder

Figure 1 shows electopherograms of the PowerPlex® 16 allelic ladder. Ensure that alleles in the allelic
ladder are properly designated.
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Figure 1. PowerPlex® 16 allelic ladder

4.2.2  The electropherogram data will be evaluated in order to determine if samples need to be re-injected,

injected for a longer or shorter period of time, more/less amplified DNA added to the injection cocktail
or if a new spectral must be created due to excessive pull-up.

4.2.3  The source of a DNA sample may be from a single person or more than one person. This may be
determined by examination of the number of alleles (peaks) at each locus as well as additional
information such as peak height ratios at loci with more than one allele.
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4 Interpretation of Powerplex® 16 System PCR Amplification Results

4.2.4 A DNA profile may be considered as having originated from a single individual if no more than two

alleles (peaks) are observed at each locus. Figure 2 displays an example of a single source profile.
However, there are examples of three allele patterns due to gene duplication or translocation events.® All

loci should be taken into account when making this determination as well as the peak height ratios when
two peaks are present.
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Figure 2. Electopherogram of a single source PowerPlex® 16 profile

NOTE: Although average peak height ratios for a single source sample at a heterozygous locus may be
above 0.6 when' DNA (quantity is above stochastic levels (250 pg-andigreater), minimum
heterozygote balances have been observed below 0.6 for single source samples even at
sufficient quantities of input DNAA (250 pg and greater,).® Table 3 displays the heterozygote

peak ratio data reported in the VDFS “Validation of the PowerPlex® 16 Amplification System:
Heterozygous Peak Balance” study.
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4 Interpretation of Powerplex® 16 System PCR Amplification Results

Table 3. Lower limit heterozygote peak height percentage for each locus in the PowerPlex® 16 System.
Data generated from amplifications of 1 ng and 0.5 ng template DNA (eleven purified DNA samples each)
during validation testing.

Lower Limit -
Difference _ Lower Limit
Between Difference Between
Heterozygous
Locus Heterozygous Locus
Alleles All_eles
(minimum (minimum
observed) observed)
Penta E 33% VWA 60%
D18S51 61% Amelogenin 64%
D21S11 72% Penta D 53%
THO1 53% CSF1PO 61%
D3S1358 69% D16S539 51%
FGA 50% D7S820 59%
TPOX 59% D13S317 55%
D8S1179 78% D5S818 75%

425 The GeneMapper® ID software provides information on peak quality (height, base pair size, shape,
number) as well as designating alleles. The GeneMapper® ID data along with the electropherogram data
should be used in combination to determine the potential number of contributors to a DNA sample.

4.2.6  Ifitis determined that an unknown sample is a mixture, then a determination of whether or not a major
profile can be ascertained will be made.following the guidelines described in 4.2.7.7.. If a major profile
can be determined, then a match probability can be applied, where feasible, as described in the
“Statistical Calculations” chapter of this manual.

4.2.7  When an excess of DNA is added to the amplification cocktail, artifacts may occur. Excess DNA added
to the PCR can produce an increased amount of PCR product and this can result in the following:

4.2.7.1  Fluorescence intensity that exceeds the linear dynamic range for detection by the instrument
("off-scale" data). Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter peak to appear
higher in relative intensity, thus increasing the calculated percent stutter. These samples
should be diluted and/or reinjected for a shorter time period.
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4 Interpretation of Powerplex® 16 System PCR Amplification Results

4.2.7.2 Multicomponent analysis of off-scale data can result in poor spectral separation (“pull-up™).
Refer to Figure 3 for an example of pull-up at the CSF1PO locus.
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Figure 3. Pull-up. from'the yellow/black channel (TMR) into the green|channel (JOE), indicated by the red
circle and shown as an edited off-ladder (OL) peak that has been changed to indicate pull-up (PU). Editing
allele calls is'described in 4.2.7.6.

4.2.7.3  Incomplete +A nucleotide addition

The PCR process using AmpliTag Gold® is optimized such that an additional Adenosine
nucleotide is added onto the extended fragment. Excessive input DNA makes the Adenosine
addition less efficient and thus PCR fragments are shorter by one nucleotide than the true
amplicon size (-A).

4.2.74  Stutter peaks

Stutter peaks frequently appear during PowerPlex® 16 System profiling. These are most
commonly 4 nucleotides smaller than the amplicon size (true peak) for the tetranucleotide
repeats and 5 nucleotides smaller for the pentanucleotide repeats. Careful consideration, such
as the evaluation of whether or not the sample appears to be degraded and if the peak height
ratios fall below 0.6, must be made when differentiating stutter peaks and a possible mixture.
Stutter is typically more pronounced when excessive quantities of DNA are placed into the
amplification cocktail. Stutter may also appear as multiples of the repeat unit (e.g., 8
nucleotides) or may be larger than the amplicon size (+4 stutter or “up-stutter”).

NOTE: Stutter peaks are believed to be a result of slippage of the Taq polymerase during
amplification. The GeneMapper® ID software is programmed to detect (i.e., not call as
an allele) stutter peaks that are less than or equal to a given stutter ratio (defined in the
panel manager based upon VDFS validation data shown in Table 4) for each locus. This
will only be applied to the n-1 repeat stutter. Examples_of stutter peaks are shown in
Figure/4.
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Figure 4. Stutter peaks at the D3S1358 locus, indicated by red circles.

42741 If the ratio of the peak height for the smaller peak to the larger peak is less than
the established stutter value (listed in the Tables 4 and 5 below), the allele will
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4 Interpretation of Powerplex® 16 System PCR Amplification Results

be considered to be stutter by the GeneMapper® ID software and no allele will
be designated even if it is suspected that the peak is a true allele..

Table 4. Stutter percentages (n-1 repeat) generated at VDFS for the PowerPlex® 16 System loci. The stutter
values are averages (plus three standard deviations) of the observed stutter values.

Locus % Stutter GI‘;EE;\)/'IF ::;:);?TD Locus % Stutter (_;Iemng&r;;%gt?D
D3S135 12.6 13 D16S539 11.4 11

THO1 5.4 5.0 CSF1PO 10.8 11
D21S11 13.8 14 Penta D 4.1 4
D18S51 135 14 VWA 17.8 18
Penta E 8.2 8 D8S1179 10.8 11
D5S818 10.9 1 TPOX 5.9 6
D13S31 10.5 11 FGA 12.6 13
D75820 9.8 10 Amel. NA NA

NA = not applicable.

Table 5. Stutter percentage n+(1 repeat) stutter observed at VVDFS for the PowerPlex® 16

System loci.
Locus N Ave. n+1 Std Dev Average+ 3 Maimum observed
Stutter % (SD) % SD stutter
D3S1358 17 1.6 0.9 4.3
THO1 0 NA
D21S11 25 2.6 14 6.8
D18s51 6 2.8 2.3 9.7
Penta E 1 1.0 * 1.0
D5S818 8 1.5 0.8 3.9
D13S317 10 1.7 0.7 3.8
D7S820 12 1.7 11 5.0
D16S539 4 1.7 05 * 2.4
CSF1PO 8 24 14 6.6
Penta D 1 1.0 * 1.0
VWA 11 2.5 1.9 8.2
D8S1179 6 1.2 0.3 2.1
TPOX 0 NA
FGA 3 1.9 0.4 * 2.4
Amel. NA NA NA NA NA

NA = not applicable.

4.2.74.2 If the ratio of the peak height for the smaller peak to the larger peak is above the
established stutter value (this event is generally observed in samples containing
a high concentration of DNA or the DNA is partially degraded), the allele may
still be called stutter once all loci have been taken into account and both the
examiner/analyst and the technical reviewer are in agreement (based upon
knowledge of the system and experience) that the smaller peak is stutter.
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4 Interpretation of Powerplex® 16 System PCR Amplification Results

Alternatively, the examiner must also evaluate the entire profile for evidence of
more than a single contributor (such as more than three peaks at a locus, peak
height ratios below 60%) to conclude that the peak is not stutter and the profile
is a mixture.

42.75 | For analysis of sampledata, all electropherograms must be visually evaluated by the analyst
to ensure that artifacts are not mislabeled. If a peak is mislabeled (e.g., spike, pull-up, etc.),
the allele call can be edited by the analyst, either electronically or manually (by hand).

4276 Indication that a peak may be an artifact can result if a given PowerPlex® 16 System STR
profile is known to be single-source or appears to be single source based upon the providence
of the sample, but an extrapeak(s) is observed. In‘such cases, the extra peak(s) must be
assessed to determine if it'is a true allele or an artifact. Similarly, artifacts may be observed in
amplification products arising from more than one individual. In all cases, the determination
of artifact vs. true allele is made by using one or more of the following as needed: re-
injection, re-amplification.and review,of the.data.

4.2.76.1 To electronically edit the allele call-of a mislabeled peak, select the peak of
interest by right-clicking on it.

4.2.7.6.2 If the peak is already labeled, the allele call can be deleted. The user will be
prompted to add a comment.

4.276.2.1 If the deleted label is on a stutter peak, the comment will
indicate “‘stutter’”-or “ST’%

4276.2.2 If the deleted label is 'on a pull-up peak, the comment will
indicate “pull-up” or “PU".

NOTE: Pull-up, an example of which is shown in Figure 3,
refers to peaks that are not true alleles but result from
poor color separation of the raw data or off-scale data in
one or more channels. Recurrent pull-up due to poor
color separation in samples indicates the need to
complete a new spectral calibration.

4.2.7.6.2.3 If the deleted label is on a spike, the comment will indicate
“spike”.

NOTE: Signal spikes can frequently resemble peaks. Spikes
usually occur at the same/similar location in more than
one color (dye). Spikes are also characterized by their
very narrow width. GeneMapper® 1D has an algorithm
that discriminates between true peaks and spikes,
although, occasionally, the analyst may encounter a
spike called as an allele. While the signal spike does not
result-from an actual DNA fragment, the software
cannot always make this distinction and therefore
calculates a size in base pairs for the spike.

Forensic Biology Section Procedures Manual, Section VIII DFS Document 210-D1100
Issued by Biology Program Manager Revision 4
Issue Date: 25-April-2016 Page 40 of 128



4 Interpretation of Powerplex® 16 System PCR Amplification Results

4.2.7.6.2.4 If the deleted label is on a peak that appears to be raised baseline,
as opposed to a true peak, the comment should indicate “raised
baseline” or “RB”. See Figure 5 for an example.
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Figure 5. An example of raised baseline at the D8S1179 locus, indicated by the red circle.

4.2.76.25 If the deleted label is on —A peak, the comment will indicate “-
A”.

NOTE The comment “ART” may also be used to indicate any
type of artifact in place of the specific comments listed
above, however to the extent possible, more descriptive
designations will be used. Alternatively, a “?”” may be
used to indicate that a clear interpretation of the signal
(peak) cannot be made.

NOTE: If a sample is believed to be inhibited (due to gPCR
and/or STR results), a Microcone 100 may be utilized in
accordance with Chapter 2, DNA Purification, to
improve typing.

4.2:7.6:3 Allele edits-are displayed.in.the.Genotypes Table-(an X:is placed in the AE
[Allele Edit] column) and on the electropherogram:.:On the electropherogram,
the initial allele call is displayed (with a strike-through)and the comment added
to the label, as shown in Figure 6.
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Figure 6. An example of a peak label that has been deleted to indicate it is a result of stutter.
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4 Interpretation of Powerplex® 16 System PCR Amplification Results

Evidence samples should be evaluated to see if a DNA statistic can be calculated. The
traditional statistics evaluated should be the single source statistic, the combined probability
of inclusion (CP1), the unrestricted random match probability (URMP) and the likelihood ratio
method that is calculated in POPSTATS.

4.2.7.7.1 If the case is a current non-person’s-case and one of the above calculations
cannat be calculated, no comparisons will be-conducted on that particular item.

4.2.7.7.2 If the case is a current person’s case, additional statistical calculations may be
applicable such as a restricted RMP using Armed Xpert (AX) or likelihood ratio
using True Allele (TA) and comparisons will be made and conclusions will be
reported.

4.2.7.7.3 If the case is a historical case where conclusions have already been provided, the
statistical calculations listed in 4.2.7.7 and/or 4.2.7.7.2 will be used.

4.2.8 A comparison is performed between known samples and questioned samples.

4281

4.2.8.2

4283

4284

4.2.85

4.2.8.6

4287

If the DNA profiles are distinctly different, it is concluded that the sample originated from a
different source than the individual of interest and the individual is excluded.

If the DNA profiles appear consistent, indicating the possibility they may have originated
from the same source, that individual in question cannot be eliminated as a possible source.
Refer to section 4.3 for further guidance.

A sample may be considered to be a mixture of DNA from'two or more individuals if the
sample contains 3 or more peaks at one‘or more loci and/or there is a distinct difference in
peak heights at heterozygous loci. However, as described earlier, validation studies conducted
at the Virginia Department of Forensic Science have demonstrated that the heterozygote peak
balance may fall below 0.6 even for single source samples with 1 ng of DNA in the
amplification reaction. All loci should be taken into account when making this determination.

In a two contributor mixture, a major profile will be called when the peak height of the minor
source of DNA is 33.0% or less than the peak height of the major source of DNA. If one or
both the minor and the major contributors is heterozygous, then the 33.0% value applies to the
largest of the minor contributor peaks and the smallest of the major contributor peaks. At least
one allele from the major contributor shall be above the stochastic threshold. Four or more
loci meeting the above requirement of 33.0% or less of the minor to the major peak heights
and at least one allele above the stochastic threshold are required to calculate major RMP
statistics. Additionally, heterozygous DNA types shall be in peak height ratio for 2 person
mixtures. All remaining loci are taken into account to support the conclusion of the major
contributor. The major profile can be treated statistically as a single source profile as
described in the Statistical Calculations chapter of this manual. In 2 person mixtures the minor
contributor may be defined and treated as a single source profile for statistical purposes.

A major profile may still be called when there are multiple minor contributors to the mixture
if a clear major profile.is observed. The clear major profile must still conform to the rules
described in 4.2.7.8.4 with the exception that the heterozygous DNA types should generally
be within peak height ratio.

DNA typing results are required at 7 loci or more before DNA comparisons can be made.
Otherwise, the partial profile shall be reported as inconclusive.

When a probative result is obtained for an evidence sample and an inconclusive result is
obtained at more than one locus for a known reference sample, the known reference sample
will be re-typed or re-amplified in order to produce a complete DNA profile. To the extent
possible, complete DNA typing results will be obtained for reference samples.
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4 Interpretation of Powerplex® 16 System PCR Amplification Results

Generally, statistical frequencies will be generated for DNA profiles (mixture and non-
mixture profiles) obtained from evidence where the reference profile cannot be eliminated.

Statistical frequencies will not be generated at a locus if the known standard from a reference
sample exhibits a 3 or 4 peak pattern.

In criminal paternity/maternity and missing person cases, an individual must be eliminated at
three or more loci to account for the possibility of mutations before the individual is
eliminated as a parent/offspring.

4.2.8.10.1 Incriminal paternity and missing person cases, inconsistencies may be observed
without declaring the individual as eliminated as the source of genetic material.
However, statistical analysis must be performed to incorporate the possibility
that a mutation occurred. Mutations typically result in a full repeat difference,
larger or smaller, for the allele.

4.2.8.10:2 | ‘When a couple is evaluated as possible biological parents of a missing person,
each possible parent’s DNA profilewill be evaluated separately to determine if
the individual is included or eliminated as a biological parent. Subsequently the
profiles from both individuals will be evaluated together to determine if as a
couple they could have conceived the missing person.

Allele designations for evidence and reference samples will be determined by the
examiner/analyst using the GeneMapper® ID software (see the “Analysis of Capillary
Electrophoretic Data” chapter-of this manual-for instructions;on utilizing the GeneMapper®
ID software).

All evidentiary sample electropherogram data must be analyzed prior to the known, reference
samples except when references are used as assumed known contributors such as intimate
samples.

A technical review of the data analysis will be conducted by a second qualified
examiner/analyst using the GeneMapper® 1D software. The reviewer will review the
evidentiary samples prior to the reference samples.

If both the examiner/analyst and the technical reviewer are in agreement, the alleles can be
called.

The technical reviewer must agree with the major/minor designation.

The examiner's/analyst's reviewed allele calls are the "official" values entered into CODIS.

4.2.9 Each electropherogram will include the peaks from each locus labeled with the designated allelic number,
height, and base ‘pair:size.

4.2.10 Ifan allele is seen in a region “off ladder” or OL alleles, i.e., larger than the largest allelic ladder peak of
the largest MW locus on the electropherogram;-smaller-than the smallest allelic ladder peak of the
smallest MW locus on the electropherogram, or between loci, an allele designation based upon the
nomenclature referenced in 4.2.9.1 or 4:2.9.2 will be used. Once the allele designations have been
independently generated for both the sample and the standard, the allele assignment and base pair values
for the evidence sample and the standard will be compared.

EXCEPTION: The Penta D “6 allele”, which is not in the allelic ladder, will be assigned its allele

designation as a “6” allele based upon the base pair size in relation to the base pair size
of the Penta D 5 and 7 alleles.
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4 Interpretation of Powerplex® 16 System PCR Amplification Results

4.2.10.1 If the allele is seen to the right (higher MW) of the largest allelic ladder peak of the largest
MW locus, it will be assigned the type of the largest allele of the allelic ladder with a greater
than sign (>). If the allele is seen to the left of the smallest allelic ladder peak of the smallest
MW locus, the allele will be assigned the type of the smallest allele of the allelic ladder with a
less than sign (<). The "OL" value on the electropherogram will be manually changed to
reflect the allele designation.

If an allele is seen between two loci and either the locus to the right OR left of the peak
contains two peaks, the allele will be considered to belong with the locus not containing two
peaks. The assignment of the allele designation will be based upon the nomenclature
described in 4.2.9.2.

4.2.10.2 If the allele is to the right of the largest allelic ladder peak of the locus not containing two
alleles, it will be assigned the type of the largest allele of the allelic ladder with a greater than
sign (>). If the allele is smaller than the smallest allelic ladder peak of the locus not containing
two peaks, the allele will be assigned the type of the smallest allele of the allelic ladder with a
less thanssign(<)./ The "OL" value will be manually changed to reflect the allele designation

4.2.10.3 If anallele is seen between two loci and neither the higher nor lower molecular weight locus
contains two alleles, follow the guidelines outlined in steps 4.2.9.4 through 4.2.9.5. The
assignment of the allele designation will be based upon the nomenclature described in 4.2.9.2.

4.2.10.4 The base pair size for the allele in question will be compared to the base pair values for the
largest allelic ladder peak of the lower molecular weight locus and to the smallest allelic
ladder-peak of the-higher-molecular weight locus. An evaluation of the-physical-location of
the allele in question with respect to the higher and lower'molecular weight loci'will be
conducted.

4.2.10.5 The allele in question will be considered to belong to the locus which falls within an
appropriate size distance from the locus (i.e., full repeat units from the largest/smallest allelic
ladder peak). This OL variant may not always be assigned to the locus which is closest in
proximity.

4.2.11 Ifan allele is between two allelic ladder peaks of the same locus, the GeneMapper® ID program generates
a value “off ladder”. The allele will be considered to be a microvariant. The allele will be assigned an
allele designation of the lower repeat value followed by the number of bases in the incomplete repeat.
Example: an allele that migrates one base pair below the CSF1PO 14 allele will be designated as a
CSF1PO 13.3. The "off ladder" value on the electropherogram will be manually changed to reflect the
allele designation.

NOTE: To determine a microvariant or OL allele call in the GeneMapper™ ID software, highlight the
sample in question and an allelic ladder under the “Samples” tab. Click on “Display plots” and
magnify the peak in question heavily. The ladder will also magnify automatically. Show bins, if
needed, by clicking on “Bins” under the “View” header. The bin will appear as gray shading
behind each peak. Compare the base pair size of the peak in question to the surrounding known
ladder allele(s) to determine the size of the peak.

4.2.12 If an allele falls between the FGA 31.2 and the 43.2 allelic ladder bands, the allele will be assigned an
allele designation of >31.2.

4.2.13 For a typing result to be reported, all controls must give the expected result and have been treated
appropriately (i.e., same or longer injection times and/or same or larger volumes loaded into the injection
cocktail).

Reagent Blanks

If a signal (peak) is detected above the LOD in a reagent blank at a single locus and the signal is
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4.2.15

4 Interpretation of Powerplex® 16 System PCR Amplification Results

demonstrated to be part of the control, the test results associated with the reagent blank will be
considered inconclusive at that locus or the samples may be re-extracted or re-amplified. If it is
imperative that the locus be used, the samples will be re-extracted and/or re-amplified.

If a signal (peak) is detected above the LOD in a reagent blank at multiple loci and the signal is
demonstrated to be part of the control, the test results for samples associated with the reagent
blank will be considered inconclusive for all loci and all samples associated with the reagent
blank, if possible, will be re-extracted and/or re-amplified.

Positive Amplification Control

The positive control DNA must elicit the "khown" genotype for each locus as specified in 4.1.5
and Table 2. If an allele is detected in the positive control DNA at a specific locus that is not
consistent with the known genotype or if no result is obtained at a single locus, the test will be
considered inconclusive at that locus. If it is imperative that the locus be used, the samples will
be re-amplified.

Negative Amplification/Control

If a signal (peak) is detected above the LOD in the negative amplification control at a single
locus and the signal is demonstrated to be part of the control, the test results associated with the
negative amplification control may be considered inconclusive at that locus. If it is imperative
that the locus be used, the samples will be re-amplified.

If a signal(peak)-is detected above the LLOD in.the negative-amplification.control-at multiple
loci and'the signal is demonstrated to be part of the control; the test results for samples
associated with the control will'be considered inconclusive for all loci and all'samples, if
possible, will be re-amplified.

If it is determined that a sample contains stutter peaks at a majority of the loci and other artifactual peaks
are visible throughout the electropherogram due to overloading of the sample and/or amplifying too
much sample DNA, the sample may be re-injected using a reduced injection time or using less amplified
DNA in the injection cocktail following the guidelines described in the “Capillary Electrophoresis”
chapter of this manual. Samples may also be re-amplified with less template DNA and then re-typed. If
however, the accurate profile can be determined from the original sample profile by both the examiner
and the technical reviewer, then the data may be used.

To indicate the gender of the contributor of a particular biological sample the Amelogenin locus may be
used. A biological sample exhibiting a single peak at approximately 106 bp (X allele) will generally be
considered to have originated from a female individual. A biological sample exhibiting a peak at
approximately 106 bp (X allele) and a peak at approximately 112 bp (Y allele) will generally be
considered to have originated from a male individual. If only a Y allele is obtained or only an X allele is
obtained from a known male sample, the results at the Amelogenin locus will be reported as
inconclusive.

4.3  General Interpretation of Single Source Samples

e 1 or2alleles are detected per locus.

e DNA types should be detected at 7 or more loci before comparisons are conducted.

e Restricted genotypes types should be deconvoluted at 4 or more loci.

e For low level or partial profiles, heterozygote alleles do not need to be in peak height ratio to be used in
statistical calculations.

e Possible allelic drop-out can occur for genetic data that is detected below the stochastic threshold.

(0]

A maximum of 3 instances of allelic dropout at 3 loci can occur for data below the stochastic threshold
when compared to a reference sample for a conclusion of cannot be eliminated to be reached.

e Allelic drop-out is not counted at loci where no DNA typing results are obtained.
o Allelic drop-out for genetic data above the stochastic threshold is less likely to occur.
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4 Interpretation of Powerplex® 16 System PCR Amplification Results

0 For genetic data above the stochastic threshold, the DNA types from the evidence should match the DNA
types from the reference sample for a conclusion of cannot be eliminated to be reached.
Statistics are calculated at all loci where DNA typing results are obtained.

4.4  General Interpretations of 2 Person Mixtures
1-4alleles are detected per locus.
DNA types should be detected at 7 or more loci before conclusions can be reached.
Major/minor can be determined for some 2 person mixtures.
o0 Deconvoluted major alleles shall be within peak height ratio.
o0 Deconvoluted minor alleles are generally within peak height ratio.
o0 Minor alleles are deconvoluted at loci'where major alleles are deconvoluted.
o0 Minor alleles may be masked by major alleles and are not deconvoluted at these loci.
o0 Allelic drop-out is not counted at loci where the major alleles mask the minor alleles and no minor types
are deconvoluted.
o0 4 loci orimare arerequired forsstatistics torbe calculated for major oryminor-contributors
For intimate samples, DNA types from a known contributor can be subtracted or dosage considered to
determine which types are foreign at a locus.
o Foreign alleles are generally within peak height ratio.
0 4 loci or more are required for statistics.to be calculated.
o Allelic drop-out is not counted at loci where the.owner alleles mask the foreign alleles and no foreign
types are deconvoluted.
Unresolved 2 person mixture (no major/minor determinations)
0 Determine if a CPI or uRMP statistic can be conducted.
= CPI will be calculated only with mixture profiles in which all the data is above the stochastic
threshold and assumptions can be' made about the humber of contributors; exceptions will be
considered on a case by case basis.
= URMP will be calculated only where breakout has occurred (3 allele or 4 alleles per locus) and the
number of DNA contributors can be reported.
o URMP is calculated at minimum of 1 locus.
o Ifa CPI or uRMP cannot be calculated for non-person cases, no comparisons will be conducted for that
sample.
0 Person cases are forwarded to the True Allele (TA) examiners if the TA analysis is required on a
probative piece of evidence.
Allelic drop-out considerations are the same as listed in the single source section.
4.5 General Interpretations of 3 Person Mixtures
1-6 alleles are detected per locus and/or PHR imbalance is evident.
DNA types should be detected at 7 or more loci before conclusions can be reached.
Major contributor can be determined for some 3 person mixtures.
0 Major-allelesare generally-within peak-height ratio.
o 4 loci or mare are required for statistics to be/calculated for a major contributor.
Unresolved 3'person mixture
0 Determine if a CPI or uRMP statistic can be conducted.
= CPI with all data above the stochastic threshold and assumptions can be made for the number of
contributors, exceptions considered on a case by case basis.
=  URMP where breakout has occurred (5 alleles or 6 alleles per locus) if the number of DNA
contributors can be reported.
o URMP is calculated at minimum of 1 locus.
o IfaCPI or uRMP cannot be calculated for non-person cases, no comparisons will be conducted for that
sample.
0 Person cases are forwarded to the True Allele (TA) examiners if TA analysis is required on a probative
piece of evidence.
Allelic drop-out considerations are the same as listed in the single source section.
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4 Interpretation of Powerplex® 16 System PCR Amplification Results
4.6  General Interpretations of 4 Person Mixtures
e  These mixtures are typically not interpreted
Exceptions to 4.3 - 4.6 will be considered by the Program Manager or designee on a case-by-case basis.

4.7  Interpretation of a Foreign Profile from a Mixture Searched in CODIS (Combined DNA Index System):
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Figure 7. Example of a female:male mixture. Female contributor alleles are circle in red.

In the above example, the victim (V) has the following profile: D3S1358 16, THO1 8.9.3, D21S11 29,30,
D18S51 13,15, Penta E 10,12, D5S818 9,11, D13S317 11,12, D7S820 8,12, D16S539 12,13, CSF1PO 10,12,
Penta D 10,13, vWA 15,19, D8S1179 9,14, TPOX 8,11 and FGA 19,20. Therefore, the minimum known
foreign DNA profile that would be searched in CODIS would be:

D3S1358 17
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4 Interpretation of Powerplex® 16 System PCR Amplification Results
THO1 6,9.3  The 9.3 peak is 3X the height of the 8 peak which is provided by the victim. Therefore, a
conclusion can be reached that the contribution of the 9.3 peak may not be solely from the
victim. The 6 peak is foreign to the victim.

D18S51 14,17
PentaE 7,17
D5S818 12,13
D13S317 13
D7S820 10,11

D16S539 11,12  The 12 peak'is >4X the height of the 13 peak which is provided by the victim. Therefore, a
conclusion can be reached that the contribution of the 12 peak may not be not solely from the
victim. The 11 peak is foreign to the victim.

CSF1PO 11,12 The 12 peak is >2X the height of the 10 peak which is provided by the victim. Therefore, a
conclusion can be reached that the contribution of the 12 peak may not be solely from the
victim. The 11 peak is foreign to the victim.

PentaD ' 10,14  The 10 peak is >3X the height.of the 13 peak which is provided by the victim. Therefore, a
conclusion can be reached that the contribution of the 10 peak may not be solely from the
victim. The 14 peak is foreign to the victim.

VWA 17,18

D8S1179 13,14 The 14 peak is 4X the height of the 9 peak which is provided by the victim. Therefore, a
conclusion can be reached that the contribution of the 14 peak may not be solely from the
victim. The 13 peak is foreign to the victim.

FGA 25
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5 Statistical Calculations
5 STATISTICAL CALCULATIONS

Before a statistical calculation is performed, the DNA profile will be evaluated to determine both suitability of loci for
interpretation, statistical calculations, and to determine if the individual of interest is included or eliminated as a possible
source of the genetic material. Refer to the “Interpretation of Powerplex® 16 System Results” chapter of this manual, for
guidelineson interpreting DNA profiles. Only if the individual of interest.cannot beeliminated as a possible source of
the genetic material will a statistical calculation be performed. The statistical-approach that is applied will depend on the
circumstances of the case and the criterion addressed in the remainder of this chapter.

The stochastic threshold (STH) can be used as a predictor for allelic drop-out. The average RFU of the detected
allele of a heterozygous pair demonstrating allelic drop-out was used to generate a STH for each injection time (2
sec, 5 sec, 10 sec). Two standard deviations of this average is listed/below.

The stochastic thresholds are as follows:

2 sec injection =210 RFU
5 sec injection - 320 RFU
10 sec injection =460 RFU

Alleles detected below these thresholds may be missing their sister allele. If the alleles are above this threshold,
generally both sister alleles can be presumed to be present; however, if the majority of other loci have alleles below
this threshold, it can be an indication that DNA from the low-level donor has dropped out completely.

The STH range will be evaluated for any profile determined to be a single source profile (or a deduced major
profile)-for which arrandom:match probability,will-be calculated and for any profile- determined.to-be-a mixture
suitablefor combined probability of inclusion calculations.

Conclusions for positive associations (not eliminated) and the supporting statistics for the item will be addressed
in the same Certificate of Analysis.

5.1 The frequency of occurrence of allele fragments reported as being consistent is determined for each polymorphic
locus within a racial/ethnic population group. Using the allele designations specified in the “Interpretation of
Powerplex® 16 System Results” chapter of this manual, determine the frequency for each allele from the
appropriate population database.

5.2 The genotype frequency associated with a particular pattern of alleles from a sample is based upon principles of
Hardy-Weinberg equilibrium.

5.2.1 Ifasingle source sample under analysis demonstrates two different alleles, the genotypic frequency at a
particullar locus is determined by the equation 2pg, where p and q represent the frequencies of allele #1
and #2".

5.2.2  Ifasingle source sample under analysis consists of the same allele, the genotypic frequency at a
particular locus is determined by the equation p?+ p(1-p)0, where 6 = 0.01 and p represents the frequency
of the allele ™.

5.2.3  If aknown sample consists of more than.two-alleles-at a-particular locus, no frequency data will be
generated for that locus.

5.3 A random match probability will be determined for single source samples using the product rule. The product rule
may also be applied for a mixture sample when the complete major contributor profile can be determined or a
foreign contributor profile can be determined by subtracting the contribution of the known donor from an intimate
mixture.

5.3.1  For asingle source sample (or a deduced major profile in a mixture), all homozygous loci will be
evaluated using the STH values. If a single homozygous allele detected at a locus falls below the STH for
the respective injection time, the formula 2p-p? may be applied.
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Traditional likelihood ratios will be used to calculate the match probability for the DNA profile from a sample
when a mixture of DNA profiles from TWO individuals is observed and the entire foreign DNA profile cannot be
determined by subtracting the contribution of the known donor from the mixture profile which would otherwise be
a RMP calculation. This situation is further defined as a 2 person mixture where one of the contributors is a
“known” for both the prosecution proposition and the defense proposition listed below. The "Likelihood Ratio"
frequency (L) is determined by the equation ™% *°:

54.1

5.4.2

5.4.3

LR = P(E[Cx)
P(EICy)

The LR compares two hypotheses or scenarios — informally they are 1) what is the probability of the
DNA evidence if the prosecution proposition is true? and 2) what is the probability of the DNA
evidence if the defense proposition'is true? The LR provides a measure, based upon the DNA
evidence, of how many times more likely hypothesis (1) is versus hypothesis (2).

Where:..Cy is.the first.explanation.(the alleles of the.mixed.DNA profile attributed to unknown
contributors under explanation Cx), where X is the:number of unknown contributors under
explanation Cy.

Cy is the second explanation (the alleles of the mixed DNA profile attributed to unknown
contributors under explanation Cy), where Y is the number of unknown contributors under
explanation C,.

P(E|Cx) is the probability of the DNA profile (E) using explanation Cyx

P(E|CY) is the probability of the DNA profile (E) using explanation Cy

Refer to Appendix | of the Commonwealth of Virginia Forensic Biology Section Procedure

Manual Section 11, Fluorescent Detection PCR-Based STR DNA Protocol: PowerPlex® 16
BIO System for specific formulas used for calculating likelihood ratio frequencies.

NOTE: Because the likelihood ratio calculation takes into account all possible contributors involved
in the mixture and therefore provides a conservative probability, 0 is not used in the
calculation.

When the victim and suspect share the same two alleles (i.e., 12,13), they may be accounted for as both
unknown or knowns in the likelihood ratio calculation. An example when both of the alleles would be
counted as unknowns is if the victim’s contribution to the mixture is the minor component throughout the
mixture profile and the type that is shared by the victim and suspect is consistent with the major
contributor (based upon the peak heights of the alleles in relationship to the rest of the DNA profile) the
alleles will be considered to have originated from the foreign contributor and will be used in the
calculation.

Example: Victim - 12,13 (minor contributor)
Suspect - 12,13 (major contributor)
Evidence - 12,13 [both alleles will be considered as unknowns]

If four alleles are observed inja mixture, the alleles that are foreign to the victim will be used in the
calculation.

Example: Victim - 5,8
Suspect - 7,9
Evidence - 5,8,7,9 [the 7 and 9 alleles should be considered as unknowns]

Once the profile has been evaluated and it has been determined that the individual of interest cannot be
eliminated, if any of the alleles for the individual of interest is missing at a particular locus, the locus will
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not be used in the calculation. However, the results at that locus may be used in the overall decision of an
inclusion or exclusion.

Example: Victim - 10,11
Suspect - 6,8
Evidence - 10,11,6 [this locus will not be used in the‘overall calculation of the likelihood
ratio frequency]

5.5 Combined probability of inclusion (CPI) may be used to calculate the match probability when a mixture of DNA

profiles from MORE THAN TWO individuals is obtained and no major contributor can be determined or a
mixture of two individuals is obtained and a likelihood ratio cannot be calculated as outlined above.

NOTE: The CPI calculation assumes that all alleles from all individual(s) of interest to the mixture are present at
the loci for which the statistic is being calculated. Therefore, a locus at which drop-out is presumed (with
stochastic thresholds) or known to have occurred (based on comparisons to known samples) cannot be
used in the.calculation.of this statistic.

The following combined probability of inclusion calculation will be used to establish the frequency of individuals
who would be included as possible contributors to the mixture.

Probability of exclusion (PE) = Probability representing all genotypes not contributing to the mixture.

PE = Q° +2Q(1-Q)  Where, Q = (1-P), frequency of alleles associated with genotypes at each locus not
contributing to the mixture and P represents the sum of allele frequencies in the
mixture:

CPE =1- [(1-PE)(1-PE))....(1-PE})]
The combined probability of inclusion (CPI) can then be calculated by the equation:
CPI=1-CPE

5.5.1  When an evidence profile is determined to be a mixture that requires a CPI calculation, all loci will be
evaluated using the STH values (for the injection time of that sample) prior to any comparisons to known
samples.

55.11 Known samples from donors of intimate samples or owners of items are the exception. Their
profiles may be used to determine the number of contributors to a mixture profile and whether
it is of value.

5.5.2  If one or more alleles at a locus falls below the STH for the injection time of the sample, the CPI
calculation will not be used unless an exception is granted.

5.5.3  Once the profile has been evaluated using the STH values and determined to be suitable for a CPI
calculation, the stutter peaks at all loci determined to be suitable for CPI will be compared to the ‘true’
allele peaks. If, at any locus, the largest stutter peak is larger or equal to the smallest ‘true’ allele peak,
then all of the stutter alleles at that locus-will-be.used in-the CPI calculation.

5531 The profile may be re-analyzed in GeneMapper with the stutter cutoff filter turned off to assist
with this evaluation.

5.6  Anunrestricted modified random match probability (URMP) can be calculated for mixtures following the
procedures in mMRMP manual. Report writing for this application is also addressed in the mMRMP manual section
15.

5.7 Ifitis suspected that a relative of the suspect may have left the genetic material at the crime scene, the DNA
profile from the relative should be obtained whenever feasible. However if a suspected relative cannot be profiled,
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the following formulas may be used to determine the conditional probability that the relative has a particular
genotype consistent with that of the suspect™:

Genotype of the suspect Probability of the same genotype in a relative
Homozygote: AjA, pi? +4pi(LpF
Heterozygote: AjA; 2pip; + 2(pi +p; - 4pipj)F

F represents the kinship coefficient and p; and p; represent the frequency of the alleles for the race of the
relative in question.

For parents and offspring, F = 1/4; for half-siblings F= 1/8; for tncle or nephew F = 1/8; for first cousins
F=1/16.

For full siblings the following formulas will be used:

Homozygote: AiA; (1 +2p; + pi)i4
Heterozygote: A A; (L4 pi + pj +2pip;)/4

5.8 The following are the formulas which may be used when calculating Paternity/Relationship type calculations:
5.8.1 Random Man Not Excluded (RMNE): the frequency with which men selected at random from the same

racial background as the Alleged Father would not be excluded as the Biological Father in a given test
which includes the Mother-Child Combination.

Maother P R
Child P Q
Alleged Father Q N

i. RMNE = 2q - g? (Where q equals the obligatory allele frequency)

Mother P Q
Child P Q
Alleged Father Q N

ii. RMNE =2(p+q)-(p+0q)*(Where p and q equal the obligate allele frequency)

5.8.2  Paternity Index (PI): This is the ratio of the chance that the mother (M) and a man of the Alleged Father’s
(AF) phenotype produced the child (passed the obligate allele) compared to the chance that the mother
and a random man produced the child (passed the obligate allele).

Ho.= Alleged father is the biological father
H, = Alleged father is not the biological father

P(R|H,) = Probability of the child (with R genetic information of M and AF) given Hy.
P(R|H1) = Probability of the child (with R genetic information of M and AF) given H;.

When the numerator and.denominator are divided by P(R|H,)
P(Ho|R) = P(RIHo) / P(RIHo) + P(R|H1)

Let P(RIHo) = X
P(RHy) =Y

P(HolR) = 1/1 + Y/X

Pl = X/Y or 1/ Y/X, also known as a likelihood ratio (L)**
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Pl compares two hypotheses or scenarios — informally they are 1.) paternity, and 2) non-
paternity. Pl provides a measure of how many times more characteristic of (1) the genetic
evidence is than of (2).

Example: Mother (M) =10, 11
Child (C) =10,11
Alleged Father (AF) =10, 12

Paternity Index = (M10)(AF11) + (M11)(AF10)
(M10)(RM1;) + (M11)(RMy0)

= (0) + (AF10)
(RMy3) + (RMyp)

= (AF)/(RMy;) + (RMy)

Child Mother Alleged Father Paternity Index
AA AA AA 1P,
AA AB AA 1P,
AB AA AA 1P,
AB BB AA 1P,
AB BC AA 1P,
AA AB AB 1/2P 5
AA AA AB 1/2P 5
AB BB AB 1/2P 5
AB BB AC 1/2Px
AB BC AD 1/2P,
AB BC AB 1/2P 5
AA AB AC 1/2P 5
AB AA BB 1/Pg
AB AC BB 1/Pg
AB AA AB 1/2Pg
AB AA BC 1/2Pg
AB AC BD 1/2Pg
AB AA BC 1/2Pg
AB AC AB 1/2Pg
AB AB AA 1P+ Pg
AB AB AB 1/PA + Pg
AB AB BB 1/PA + Pg
AB AB BC Yo(Pa +Pg)
AB AB AC Yo(Pa +Pg)

5.8.3  Combined Paternity Index (CPI): The combined paternity index.is calculated.by multiplying together
each individual paternity index.

CPl= PlixPlaxPI3un. avi......... Pl,

5.8.4  Probability of Paternity: The probability of paternity'is expressed as a frequency (or percentage),
incorporating the combined paternity index and a prior probability (which is most typically set at 0.5)
which compares the likelihood that the tested man may pass the required genes to the likelihood that an
untested, unrelated random man of the same race may pass these genes.

Probability of Paternity = (CPI)(Pr) / (CPI)(Pr) + (1-Pr)

Pr = Prior Probability and CPI = Combined Paternity Index
With a Pr = 0.5, the formula reduces to:

Probability of Paternity>®* = CP1 / CPI + 1
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Refer to Appendix L of the Commonwealth of Virginia Forensic Biology Section Procedure Manual
Section 111, Fluorescent Detection PCR-Based STR DNA Protocol: PowerPlex® 16 BIO System for

acceptable values of Probability of Paternity.

5.9 The following are the formulas used when calculating Paternity/Maternity/Relationship Type calculations from a

single parent >:

Where:

p = frequency in the population
q = frequency in the population
AF, = chance of passing p
AF = chance of passing ¢

59.1  PI=(p)(AFq) + (a)(AFy) / 2pq = (p)(0.5) + (a)(0) / 2pg = 1/4q
Person
Child P Q
Alleged Father Q R
592 PI=(p)(AFq) + (a)(AFy) / 2pg = (p)(1) + (a)(0) / 2pq = 1/2q
Person
Child P Q
Alleged Father Q Q
5.93  PI=(p)(AFq) +(a)(AF,) /2pg = (p)(0.5) + (1)(0-5) / 2pq = (p'+ q) /4pq
Person
Child P Q
Alleged Father P Q
5.9.4  Pl=(q)(AF,)/q*=(q)(0.5)/q°=1/2q
Person
Child Q Q
Alleged Father Q R
59.5 Pl =(q)(AF,)/q*=(aq)(1)/q°=1/q
Person
Child Q Q
Alleged Father Q Q

5.10 The following are the formulas used when calculating Paternity/Maternity/Relationship Type Calculations from a
single grandparent >®:

Child Grandmother Grandfather Paternity Index
AA AA Unknown (1+a)/2a
AA AB Unknown (1+2a)/4a
AA BC Unknown 1/2

AA BB Unknown 1/2

AB AA Unknown (1+2a)/4a
AB AB Unknown (a+ b+ 4ab)/(8ab)
AB BC Unknown (1 + 4b) / (8b)
AB BB Unknown (1 + 2b) / (4b)
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AB
AB

CC
CD

1/2
1/2

Unknown
Unknown

The following are the formulas used when calculating Missing Person Calculations (where mother’s and father’s
genotypes are known) °:

Prob(EIM, F, Q) is the probability that the evidence would-be observed given that the mother and the
father were the parents of the evidence sample (Q).

Prob(EIM, F, U) is the probability that the evidence would be observed given that a random member of
the population was the questioned sample (U).

LR is the ratio of the two probabilities = Prob(EIM, F, Q)// Prob(EIM, F, U)
P etc. is the estimated frequency of the “A” allele in the population

Mother| Question:|. Father Prob(EIM; F; Q) Prob(EIM, F, U) LR
AA AA AA PA” XPA® PA”XPA"XPA° 1/P,°
AA AA AB PA"X 2PAPg X % Pa’ X 2PaPg X PA” 1/2P,°
AA AB BB Pa” X Pg’ Pa”X Pg” X 2PAPg 1/2PPg
AA AB AB Pa’X2PaPg X % Pa”X 2PAPg X 2PaPg | 1/4PAPg
AA AB BC Pa”X2PgPc x % Pa”X 2PgPc X 2PaPg | 1/4PAPg
AA AB BB 2P AP X P’ x % 2PAPg X Pg° X 2PaPg | 1/4PPg
AB AB AB 2PAPBX2PAPBX(1/4+ ZPAPBXZPAPBX 1/4PAPB
Ya) 2PAPs

AB AB AC | 2PAPs x 2PpPc x %o x 2P APg X 2PAPC X 1/8PaPg
Y 2PAPs

AB AA AA 2PAPg X PA° X %2 2PAPg X PA” X PA® 1/2PA°

AB AA AB 2PAPg X2PAPg X Y2 X | 2PAPg X 2PaPg X PA° 1/4PA°
Y%

AB AA AC 2PAPg X2PAPc X Y2 X | 2PAPg X 2PaPc X PA° 1/4PA°
Y

AB AC cc 2PAPg X Pc? x % 2PAPg X PC° X 2PAPc | 1/4PAPc

AB AC BC | 2PaPg x2PgPc x %X 2PAPg X 2PgP¢ X 1/8PaPc
Y 2P AP

AB AC AC | 2PAPg x2PsPc x %X 2P APg X 2P AP X 1/8PaPc
Y% 2P AP

AB AC CD | 2PAPg X 2PcPp x % X 2P APg X 2PcPp X 1/8PaPc
Y 2P AP

5.12 When performing a Missing Person or Paternity Index calculation on a partial DNA profile it is possible that an

5.13

individual or an evidence sample may be identified that cannot be eliminated as a possible offspring/parent or have
originated from the offspring/parent. However the individual’s DNA profile or the evidence sample is missing an
allele at a particular locus that.is observed in the mother/father/child’s DNA profile. The allele may be missing as
a result of allelic dropout or a mutation. Therefore to account for both of these situations two probabilities will be
provided in the Certificate of Analysis and will be calculated in the following manner:

5.12.1 To account for the possibility of allele dropout; the locus will not be used in the overall calculation.

5.12.2 To account for the possibility of a mutation, the formula addressed below will be used for the locus and
factored into the overall calculation.

When applying the formulas for Missing Person or Paternity Index calculations, if a partial profile is obtained and
the individual cannot be eliminated, however an allele is missing at a particular locus the probability for the locus
will be calculated and reported two ways:

5.13.1 To account for the possibility of allele dropout, the locus will not be used in the overall calculation.
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5.13.2 To account for the possibility of a mutation, the formula addressed below will be used.

5.14 The following formula is used when calculating Paternity/Maternity type calculations invelving'a potential

mutation.” &

Pl =Mgr / 2P Mg refers to the specific mutation rate for changing allele S to R

Mgr = L represents the average mutation rate reported by the American Association of Blood Banks
(AABB)
PI=u/2Px P a, etc. is the estimated frequency of the “A” allele in the population
Average Mutation Rates Established by the AABB™

Locus Paternal Maternal
FGA 0.0029 0.0005
TPOX 0.0002 <0.0001
D8S1179 0.002 0.0003
VWA 0.0032 0.0003
Penta E 0.0012 0.0002
D18S51 0.002 0.0006
D21S11 0.0015 0.0011
THO1 0.0001 0.0001
D3S1358 0.0015 0.0003
Penta D 0.00066 0.00064
CSF1PO 0.0014 0.0002
D16S539 0.0011 0.0002
D75820 0.0013 0.0002
D13S317 0.0015 0.0005
D5S818 0.0014 0.0002

5.15 The following formulas are for use when it is suspected that two individuals are siblings

6,12,13.

Sibling Genotype

Probability of S2 genotype if two persons are:

S1 S2 Truly Related Are Unrelated Sibling Index
AA AA (1+a)“/4 a (1+a)“/4 a°
AA AB (b+ab)/2 2ab (1+a)/4a
AA BB b’/4 b Y,

AA BC bc/2 2hc Ya

AB AB (1+a+b+2ab)/4 2ab (1+a+b+2ab)/8ab
AB AA (a+a’)/4 a’ (1+a)/4a

AB AC (c+2ac)/4 2ac (1+2a)/8a
AB CD cd/2 2cd Ya

5.16 A sibling index threshold of 33 is designated based upon the literature, at and above which, it will be concluded
that the statistical data support a sibling relationship and below which the evidence in support of a biological
relationship is deemed inconclusive >,

5.17 The following formulas are for use when it is suspected that two individuals are half-siblings (also grandparent-
child or uncle-niece/nephew)®:

| Half-Sibling Genotype | Probability of S2 genotype if two persons are: |
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S1 S2 Truly Related Are Unrelated Half-Sibling Index
AA AA (a+a)’/2 a (1+a)/2a

AA AB (b+2ab)/2 2ab (1+2a)/4a

AA BB b’/2 b Y

AA BC bc 2bc Yo

AB AB (a+b+4ab)/4 2ab (at+b+4ab)/8ab
AB AA (at2a)l4 a’ (1+2a)/4a

AB AC (c+4ac)/4 2ac (1+4a)/8a

AB CD cd 2cd Yo

5.18 Procedure for rounding frequencies;

5.18.1 Allele and genotype frequencies will be carried out to 3 digits. If the fourth digit is 4 or less the third digit
will remain the same. If the fourth digit is 5 or greater then the third digit will be rounded up.

Example: 0.3464 would be truncated to 0.346
0.3467 would be rounded to 0.347

5.18.2 Mutation rate frequencies will be carried out to the number of digits in the actual mutation rate.

Example: 0.0002 will be carried out to 4 digits
0.0020 will be carried out to 3 digits

5.18.3 The frequency for the overall DNA pattern, termed a DNA profile, can be determined by multiplying
together the genotype frequency obtained from each locus. The overall match probability/Likelihood
Ratio/CPI1 (combined probability of inclusion/combined paternity index) will be truncated to two
significant figures.

Example: 8.169738341 x 10™ = 1 in 12,240,294,100
Reported match probability: 1 in 12 billion

Refer to Chapter 10, Report Writing, for the specific wording used when reporting match
probabilities/likelihood ratios/combined probability of inclusion/probability of paternity.

5.19 Procedure for calculating allele and genotype frequencies:

The following represents an example of data collected for a STR database and the procedures used to
determine the allele and genotype frequencies. Refer to Appendix H of the Commonwealth of Virginia
Forensic Biology Section Procedure Manual Section 111, Fluorescent Detection PCR-Based STR DNA
Protocol: PowerPlex® 16 BIO System for the Virginia Department of Forensic Science population
databases;

Example: THO1 locus in‘Caucasian population (n'= 209)
Allele Frequency:

Frequency of allele = Number.of times the allele was observed out of all possible alleles for a
particular locus/2n.

NOTE: Alleles that contain fewer than 5 events are defaulted to 5 events in order to provide a more
conservative frequency.

Examples:

Allele 5 was observed 3 times out of 418 alleles. Therefore, the allele 5 will default to a total of
5 events (5/418) = 0.012
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Allele 6 was observed 100 times out of 418 alleles (100/418) = 0.239
Allele 7 was observed 59 times out of 418 alleles (59/418) = 0.141
Allele 8 was observed 50 times out of 418 alleles(50/418) = 0.120
Allele 9 was observed 64 times out of 418 alleles (64/418) = 0.153
Allele 9.3 was observed 68 times out of 418 alleles (68/418) = 0.163
Allele 10 was observed 74 times out of 418 alleles (74/418) = 0.177

Allele 11 was observed 0 times out of 418 alleles. Therefore, the allele 5 will default to a total of
5 events (5/418) = 0.012

The sum of the-individual allele frequencies should equal-approximately 1.000. However, because
eventsless than'5 are defaulted to 5, the total frequencies'may not total to exactly 1.000:

(0.012) + (0.239) + (0.141) + (0.120) + (0.153) + (0.163) + (0.177) + (0.012) = 1.017
Expected Genotype Frequency:
Based on the assumption that the THO1 genetic locus is in Hardy-Weinberg equilibrium, the
expected genotype frequencies-are calculated-from. the allele frequencies; as-in:the following
examples:
THO1 Genotype 7, 7:
(Frequency of the 7 allele)® + Frequency of the 7 allele(1-Frequency of the 7 allele)d
(_0.141)2 +0.141(1-0.141)0.01 = 0.021
OR
THO1 Genotype 7, 9.3:

2(Frequency of the 7 allele)(Frequency of the 9.3 allele)

2(0.141)(0.340) = 0.096

1. The Evaluation of Forensic DNA Evidence, National Academy Press, Washington D.C., 1996.

2. Evett, lan W. and Weir, Bruce S., 1998. Interpreting DNA Evidence, Chapter 6.

3. Gdrtler, H. 1956. Priniciples of blood group statistical evaluation of paternity cases at the University Institute of
Forensic Medicine, Copenhagen, Acta. Med. Leg. Soc., Liege 9:83-93.

4. Paternity Testing, American Association of Blood Banks, New Orleans, Louisiana, 1979

5. Fung, W., Wong, D.M., and Tsui, P. 1996. Determination of both parents using DNA profiling, Jurimetrics Journal,

36:337-342
6. Wenk, R.E., Traver, M., and Chiafari, F.A., 1996. Determination of sibship in any two person, Transfusion, 36:259-
262
Forensic Biology Section Procedures Manual, Section VIII DFS Document 210-D1100
Issued by Biology Program Manager Revision 4

Issue Date: 25-April-2016 Page 59 of 128



5 Statistical Calculations

7. Gjertson, D.W., Appendix 13. The effect of an isolated single-locus inconsistency in the statistical evaluation of
paternity, adapted from presentations given by Debra Endean and David Gjertson at the Promega Sponsored
Statistical Workshop (September 1996) and to the English Speaking Working Group of the International Society of
Forensic Haemogenetics (October 1996).

8. Endean, D..and Gjertson, D., Suspected DNA mutations: statistical approach.

9. Gill, P. etal. (2000) An investigation of the rigor of interpretation rules for STRs derived from less than 100 pg of
DNA, Forensic Science International 112, 17-40.

10. Curran, J.M., et al. (2005) Interpretation of repeat measurement DNA evidence allowing for multiple contributors
and population substructure, Farensic Science International 148/47-53.

11. Guidance for Standards for Relationship Testing Laboratories, 8" Edition.

12. Chang EP and Linacre.A. Systematic evaluation.of sensitivity.and.specificity. of sibship.determination by using 15
STR loci. J Forensic Legal Med 2008;15:329-34.

13. Reid TM, Wolf CA, Kraemer CM, Lee SC, Baird ML and Lee RF. Specificity of sibship determination using the
ABI Identifiler multiplex system. J Forensic Sci 2004;49:262-4.

14. Pu CE and Linacre A. Systematic evaluation of 'sensitivity and specificity of sibship determination by using 15 STR
loci. J Forensic and Legal Med (2008);15:329-34.

Forensic Biology Section Procedures Manual, Section VIII DFS Document 210-D1100

Issued by Biology Program Manager Revision 4

Issue Date: 25-April-2016 Page 60 of 128



6 Report Writing

6 REPORT WRITING

6.1 Report Requirements

In accordance with the FBI’s

13

Quality Assurance Standards for Forensic DNA Testing Laboratories”, all Forensic

Biology Certificates of Analysis in which DNA analysis was conducted will contain at.a minimum the following

information:

6.1.1  Case identifier

6.1.2  Description of evidence examined

6.1.3 A description of the methodology

6.1.4  Polymorphic loci examined or amplification system

6.1.5 A quantitative or qualitative interpretative statement

6.1.6  Statistical frequencies of inclusion

6.1.7  Date issued

6.1.8  Disposition of evidence

6.1:9. Assignature andtitle,-or equivalentidentification of the person-accepting responsibility-for-the content of

the report

6.2  Categories of Results

The results will fall within one of the following categories:

6.2.1  Usable DNA Profiles
6.2.1.1  No DNA profiles foreign/different to individual “A” were developed.
6.2.1.2  The DNA profiles developed for samples under comparison are consistent (match).
6.2.1.3  The DNA profiles developed for samples under comparison are consistent with a mixture.
6.2.1.4  The DNA profiles developed for samples under comparison are different (do not match) or
are from non-subject cases.
6.2.1.4.1 The DNA profiles for “unknown” samples (samples from non-subject cases or
samples not attributable to any corresponding known samples) were searched in
the Virginia DNA Data Bank.
6.2.1.4.1:1 The DNA Data Bank search resulted in a match.
6.2.1.4.1.2 The DNA Data Bank search resulted in no matches.
6.2.1.4.1.2.1 The DNA profile for an unknown sample will be
submitted to the National DNA Data Bank (if
suitable).
6.2.1.4.2 The DNA profile for an “unknown” sample was not suitable for searching in the
Virginia DNA Data Bank or submission to the National DNA Data Bank;
however, it may be suitable for direct comparison purposes.
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6.2.2 Potentially Usable DNA Profiles (preferential amplification, drop-out, insufficient quantity, and/or
sample degradation)

6.2.2.1  Based on a review of the data, considering the type of sample and DNA yield, a partial DNA
profile may be considered a “usable” profile.

6.2.2.2 ' No conclusive DNA profiles were developed (after cautious and conservative review, no
comparison or interpretation can be offered).

6.2.2.3 A partial DNA profile may not be suitable for searching in the DNA Data Bank; however, it
may be suitable for direct comparison purposes.

6.2.24 A complex mixture profile of'4 or more contributors (see 4.3 for definition) will be
determined to be either of no value or limited value for elimination purposes only.

6.2.2.4.1, Mixture profiles.that.fall.below.the defined.criteria.can still be determined to be
complex and treated in the same manner.

6.2.3  No DNA Profiles (insufficient quantity and/or sample degradation).
6.3 General Reporting Format

The Certificate of Analysis will contain a METHODS section (as appropriate) and RESULTS section, and may
contain a CONCLUSIONS section. Depending on the case scenario and what questions the analyses are trying to
answer-as-part of the-investigation;a report may-need to bewritten-using several of the guidelines:listed below.

6.3.1 The METHODS SECTION (as outlined below) will be placed prior to the RESULTS section in the
Certificate of Analysis and will include the description of methodology, the PCR kit used, and
polymorphic loci tested.

DNA ANALYSIS METHODS:

e The method of deoxyribonucleic acid (DNA) analysis used was the Polymerase Chain Reaction
(PCR).

e The PCR amplification kit used was the PowerPlex® 16 system.

e The PowerPlex® 16 system contains 16 genetic loci (FGA, TPOX, D8S1179, VWA, Penta E,
D18S51, D21S11, THO1, D3S1358, Penta D, CSF1PO, D16S539, D7S820, D13S317, D5S818 and
Amelogenin, a gender determining locus which is not used for statistical purposes).

NOTE: The METHODS section is not included in Supplemental Reports (i.e., subsequent hit reports)
when no additional DNA analysis has been performed.

6.3.2  For cases which were terminated after extraction due to low DNA yields, the following METHODS
SECTION will be used:

DNA ANALYSIS METHODS:

e The method of deoxyribonucleic acid (DNA) analysis used is the Polymerase Chain Reaction (PCR).

e The PCR amplification kit, PowerPlex® 16, contains 16 genetic loci (D351358, TH01, D21S11,
D18S51, Penta E, D5S818, D13S317, D7S820, D16S539, CSF1PO, Penta D, VWA, D8S1179,
TPOX, FGA and Amelogenin, a gender determining locus which is not used for statistical purposes).

6.3.3 The RESULTS SECTION will contain the results of all analyses including comparisons, Data Bank
searches, conclusions and statistics and will follow the METHODS section in the Certificate of Analysis.
The results section may list results in a bulleted format or a narrative format.
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6.3.3.1 Known Reference Samples: For known reference samples, the results of the DNA analysis

will be reported in the following manner:

“A DNA profile was developed from the blood sample (or buccal swabs) from
VICTIM/SUSPECT/ELIMINATION SAMPLE.”

6.3.3.1.1

Referencing Previously Analyzed Known Sample/Evidence: When performing
a comparison between a known sample and a previously analyzed evidence sample
or vice versa the previously analyzed sample will be reported in the following
manner:

Examples; Evidence:and known samples from the same case

A DNA profile was developed from the buccal swabs from SUSPECT (ltem 3).
SUSPECT cannot be eliminated as a contributor of the foreign DNA profile
previously developed.from.the vaginal.sample.(Item.2) and reported in the
Certificate of Analysis dated December:12, 2004.

or

A DNA profile foreign to VICTIM was developed from the vaginal sample from
VICTIM (Item 2). SUSPECT (Item 3, previously reported in the Certificate of
Analysis dated December 12, 2004) cannot be eliminated/is eliminated as a
contributor of the foreign DNA profile developed from the vaginal sample.

Example: - Evidence and known samples fromdifferent cases usedfor comparison.
The report is generated by the examiner who analyzed the unknown
(evidence) samples, referencing the report with the known samples.

A DNA profile foreign to VICTIM was developed from the vaginal sample (Item
2). SUSPECT (Item 3, submitted under FS Lab # C04-XXXX and the subject of
the Certificate of Analysis dated and addressed to NAME OF
INVESTIGATOR, NAME OF AGENCY, and Agency Case # 2004-XXXX)
cannot be eliminated/is eliminated as a contributor of this foreign DNA profile.

NOTE: If the evidence in the above example was previously analyzed and
reported, then that Certificate of Analysis needs to be referenced in the
statement above.

or

DNA profiles were previously developed from the buccal swabs from Suspects 1,
2;and 3 (Items 100, 101, and 202 submitted under FS Lab # ---- and the subject of
the Certificate of Analysis dated ---- addressed to ---, Agency, and Agency Case #

).

A DNA profile foreignto. VICTIM was developed from the vaginal sample (Item
2). Suspect 1 cannot be eliminated as a contributor of the foreign DNA profile
developed from the vaginal sample. Suspects 2 and 3 are eliminated as
contributors.

If the intercomparison of samples involves an analysis conducted by an outside
laboratory, it will be clear in the report that those profiles were based on a report
dated ---- issued by OUTSIDE LABORATORY, their case #----)
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6.3.3.2  Alternate Knowns: When an alternate known sample (cigarette butt, can, bottle, shoes, etc.)
is submitted in place of the traditional known sample (blood or buccal swabs) the results for
this sample will be reported in the following manner:

“A DNA profile was developed from the ALTERNATE KNOWN from VICTIM/SUSPECT.”

When drawing a conclusion using an alternate known, this'will be reported in the following
manner:

“If the DNA profile developed from the ALTERNATE KNOWN is from
VICTIM/SUSPECT, then VICTIM/SUSPECT cannot be eliminated (or is eliminated) as a
contributor of the DNA profile developed from the EVIDENCE.”

NOTE: Ifacomplete, single source profile is developed from the alternate known, no request
will be made in the Certificate of Analysis for another, traditional known sample. If a
partial, single source profile is.developed.from the alternate known, it may be
necessary to request a traditional known:sample from the victim/suspect. If a mixture
profile is developed from the alternate known and no additional information supports
the decision to use the major/minor portion of the mixture, the alternate known will
not be considered as a known sample, but rather as an additional evidentiary item,
and a traditional known sample (or known samples from parents/offspring) will be
requested in the Certificate of Analysis.

6.3.3.3  Request for Known Samples: When a suspect, other person of interest, victim or elimination
known:sample-has:not been submitted-and/or-no suspect-has been-identified;-and a profile has
been obtained in the case for which the source is unknown; a request will be made in the
Certificate of Analysis for a known sample to be submitted using the following statement:

“DNA comparisons can be conducted following the submission of two buccal (cheek) swabs
from a suspect (or SUSPECT/VICTIM/ELIMINATION SAMPLE/ other person of interest)
or other person of interest to the Laboratory.”

For deceased individuals or body ID cases:

“DNA comparisons can be conducted following the submission of an alternate known sample
(such as a toothbrush or cigarette butts) from VICTIM or two buccal (cheek) swabs from the
biological parents/offspring of VICTIM to the laboratory.”

NOTES: In certain case scenarios, a profile with an unknown source may be developed;
however, this profile is not probative to the case. It is not necessary to request a
known sample for comparison in this situation.

If a known sample is not available, an alternate known may be used in place of the
known sample for comparison.

6.3.3.4  Reporting of Clippings and Swabbings: Clippings and swabbings of a sample (techniques
used during the examination.of an-item:to collect a DNA sample) are considered part of the
examination process and will not be reported in the Certificate of Analysis.

EXAMPLE: A swab is used to swab the mouth area of a bottle and DNA analysis is
conducted on the swab. The report will be worded in the following manner: “A
DNA profile was developed from the mouth area of the bottle.”
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6.3.3.5  Sampling: Certificates of Analysis should reflect the sampling method
Examples
e A sample collected from several different areas

“No DNA amplification results were obtained from.a combined sample collected
from the grips, trigger, slide release and magazine release of the pistol.”

or

“A DNA profile was developed from combined stains from the center of the
mattress.”

e Asingle stain tested

“A DNAprofile was developed from a stain (selected stain) found on the cuff of the
right sleeve of the shirt.”

6.3.3.6 Reporting of Differentially Extracted Samples: Routinely, sperm and non-sperm fraction
results will not be reported separately in the results section for samples that are differentially
extracted. Instead, the probative results will be reported for the sample (i.e., vaginal/cervical
sample rather than sperm fraction of the vaginal/cervical swabs). However, the statistical
statement associated with the results statement will make reference to the probative fraction
(i.e., spermand/or non-sperm fraction) for samples that are differentially extracted. The table
included as an appendix tothe Certificate of Analysis will list the sperm.and non-sperm
fractions for the evidence sample whenthe sample‘as a whole is considered probative.

6.3.3.7 Inconclusive Locus or No Result: Inconclusive results and/or no results developed at a
particular locus or loci (e.g., a partial profile) will not be addressed in the report.

Inconclusive DNA Profile: An entire profile is deemed inconclusive when the associated
quality control measures fail. Profiles that are deemed inconclusive will be reported as
follows:

“No reportable DNA results were obtained because the quality control standard was not
achieved.”

6.3.3.8 Data Bank Searches: When a DNA Data Bank search is conducted the loci used for
searching will not be reported.

6.3.3.9  Samples added to the DNA Data Bank: When samples are added to the DNA Data Bank
they will be addressed in the certificate of analysis.

6.3.3.9.1 For DNA profiles from solved or unsolved cases entered into the forensic index

State only
“This DNA profile will be submitted to the Virginia DNA Data Bank.”

State and National
“This profile will be submitted to the Virginia and National DNA Data Banks.”

6.3.3.10 No Typing Results: If no STR typing results are obtained for a sample, either due to no peaks
observed or no peaks observed above threshold, this will be reported in the following manner:

“No DNA typing results were obtained from the EVIDENCE.”
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6.3.3.10.1 There may be rare extenuating circumstances in which the detection of human
DNA, in the absence of amplification results, is critical to the case and may supply
investigative information. This will be reported in the following manner:

“Human DNA was isolated from the EVIDENCE; however, no DNA typing
results were obtained.”

6.3.3.11 “Touch” and “Wearer” DNA samples: If samples collected solely for “touch” or “wearer”
DNA do not have more than 0.006 ng/ul of autosomal or Y DNA (using the Plexor
quantitation system), these samples will not proceed through the DNA typing step and will be
reported in the following manner:

“Due to the limited quantity of nuclear DNA obtained from the EVIDENCE, it is not suitable
for PCR analysis using the PowerPlex® 16 system and no further testing was conducted on
this sample.”

6.3.3.12  Profilewvs. Types: The term ‘profile’ will routinely be used when referring to the typing
results-asia whole developed from an item. Typically, ‘profile’ describes typing results for
which conclusions can be drawn and/or entered into the Data Bank for a meaningful search.
However, it may also be used to describe typing results which have limited value, no value,
and/or not suitable for a meaningful Data Bank search. The term ‘type’ or ‘types’ is described
as components of a profile (i.e., results at one or a few loci). These terms may be used instead
of ‘profile” when referring to typing results of limited value, no value and/or not suitable for a
meaningful Data Bank search in a report. Examiner discretion will be used in deciding
whether:to-use-‘profile’ jor ‘type/types’in.the report:

6.3.3.13° Complex Mixture Profiles: Complex mixture profiles indicative of 4 or more contributors
(as defined in 4.3) will be determined to be of no value or limited value and reported as such:

“Due to the unknown number of potential contributors and complex nature of this mixture
profile, it is not suitable for comparison, searching against the Virginia DNA Data Bank, or
submission to the National DNA Data Bank.” (The Data Bank statement is used as
appropriate).

Or the profile may be determined to be of limited value and used for elimination purposes
only and reported as:

“Due to the unknown number of potential contributors and complex nature of this mixture
profile, it is only suitable for elimination purposes. It is not suitable to searching against the
Virginia DNA Data Bank, or submission to the National DNA Data Bank.” (The Data Bank
statement is used as appropriate).

6.3.3.14  Use of the.term “Foreign™: The term “foreign’ will routinely be used when the profile
developed from an intimate item of evidence contains a DNA profile which is different than
the owner/source of the evidence (i.e., vaginal/cervical swabs containing a profile that could
not have come from the victim herself). DNA profile attribution statement(s) regarding the
owner/source are used.as necessary:

6.3.3.15 Use of the term “Different”: The term “‘different” may be used in situations where the
probative finding would be a profile different than the source (i.e., cigarette butts recovered
from the victim’s house, steering wheel of victim’s car, victim’s wallet recovered from his
house, etc.). This situation is typically encountered in cases when investigators are looking for
investigative leads (ie, profiles different than the victim). It is necessary to note that analysis
of these items is useless without the proper known samples. DNA profile attribution
statement(s) regarding the source are used as necessary.
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6.3.3.16  All positive associations must be clearly and properly qualified in the Certificate of Analysis.
This can be done by either:

1 - A statistical statement

2 — A gualitative statement. A qualitative statement(not based on a statistical calculation) will
be limited to situations in which the presence of an individual’s DNA on an item is reasonably
expected limited to the following:

1 — Intimate samples (e.g., samples and items collected or removed from an
individual’s body). A qualitative statement may also be used for profiles developed
from consénsual sexual partners on intimate samples.

2 — ltems owned or worn by an individual where that individual’s DNA is expected
to be found (e.g., swabs from cars, homes, clothing, etc).

3 — Crime scene evidence where profiles.different from the victim are being sought
(e.g., blood samples from the scene of a-homicide where DNA profiles are consistent
with the victim).

The qualitative statementwill indicate the number of loci at which all the owner’s alleles are
present. See below for reporting wording examples:

Intimate sample examples (no minimum number of loci requirement)
Vaginal / cervical sample (carryover of NSP into SP)

o A DNA profile foreign to VICTIM was developed. SUSPECT cannot be eliminated
as a contributor.
o0 Statistical statement for sperm fraction foreign
o A DNA profile/DNA types attributable to the VICTIM was also present in this
sample (‘at 15 loci in the non-sperm fraction and 4 loci in the sperm fraction)

Vaginal/cervical sample (profile consistent with elimination and victim)

e No DNA profile foreign to VICTIM and ELIM was developed. SUSPECT is
eliminated as a contributor. A DNA profile attributable to the VICTIM is present in
this sample (at 15 loci in the non-sperm fraction).

o A DNA profile attributable to ELIM is also present in this sample (at 15 loci in the
sperm fraction)

OR

o DNA profiles attributable to VICTIM and ELIM were.present in this sample at 15
loci in.the non-sperm fraction and 15 loci-in;the-sperm.fraction, respectively.

Ownership sample examples (must be 4 or more loci)
Steering wheel swabs, door handle swabs, clothing, etc. (ownership-type items)

o A DNA profile foreign to OWNER was developed.
0 SUSPECT cannot be eliminated as a contributor of this foreign profile.
= Statistical statement for different profile.
0 A DNA profile attributable to OWNER is also present in this sample at 8
loci.
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Crime scene sample examples (must be 4 or more loci)

Five stained swabs tested from homicide of the victim, she is found in her home:

Item 1 — Stained swab
Item 2 — Stained swab
Item 3/— Stained swab
Item 4 — Stained swab

o No DNA profile foreign to VICTIM was developed. DNA profile(s) attributable to
her were developed at 15 loci (or list # of loci separately, respectively).
e Suspect is eliminated as a contributor.

Item 5 — Stained swab

o -ADNA profile was developed:

o VICTIM:is eliminated as a contributor.
o /SUSPECT cannot be eliminated as a contributor.
= Statistical statement

6.3.3.17 Probative Evidence: Evidence through testing that demonstrates the proposition that a
biological fluid may or may.not have been deposited by a specific “individual of interest” that
is believed to be associated with the evidence in question.

6.3.3:18 " Table/Appendices: A table of the typing results will be included in the Certificate of
Analysis as an appendix based on the followingcriteria.

6.3.3.18.1

6.3.3.18.2

6.3.3.18.3

6.3.3.18.4

6.3.3.18.5

6.3.3.18.6

Tables will only be included in cases where there is a positive association (i.e.,
inclusion) to a probative item of evidence.

In cases where a table is included, all DNA evidence profiles suitable for
comparison will be included in the table, regardless of what conclusion is
reached for the profile (inclusion, elimination, insufficient information,
elimination only).

In cases where a table is included, DNA reference profiles for individuals for
which a conclusion of cannot be eliminated or insufficient information was
reached will be included in the table. DNA reference profiles will NOT be
included in the table if the individual is eliminated from all charted evidence.

Any DNA profile determined to be of no value for comparison (for any reason)
will not be included in the chart. This includes DNA mixture and single source
profiles of no value, intimate DNA profiles with no_foreign/different types (note
exception below), and intimate DNA profiles.containing foreign/different types
of no value.

If a sperm or-non-sperm fraction is suitable for comparison and is included in
the table, the other fraction MUST be included in the table as well, even if that
profile'is of no value, no types foreign or no typing results are obtained. This
may affect which reference samples are charted. In the example of no foreign
types to the victim are detected in the non-sperm fraction of a sample from her,
the victim reference sample should also be charted.

For cases (paternity/maternity, body 1D, TrueAllele) where conclusions and
statistics are to be the subject of a supplemental report and/or the profiles are not
suitable for traditional statistics, tables will be included with the original
Certificate of Analysis.
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6.3.3.18.7  In cases where the original analysis did not result in a table being included in the
Certificate of Analysis and where the subsequent submission of new evidence or
known standards results in positive associations to probative item(s) of
evidence, a table will be included in a new Certificate of Analysis including all
profiles developed in the case following the guidelines above.

6.3.3.18.8 = In cases where the original analysis.did resultin a table being included in the
Certificate of Analysis and where the subsequent submission of new evidence or
known standards results in additional inclusions to probative item(s) of
evidence, only the newly developed profiles need to be included in the table.
Previously charted profiles are not required to be included in any subsequent
tables.

6.3.3.19 Termination During Examinations: If DNA analysis has begun in the case, and a request
for terminating the case has been received, this will be reported as follows: “The DNA
analysis.on.the EVIDENCE was.discontinued at.the request.of INVESTIGATOR/
COMMONWEALTH’S ATTORNEY on DATE:”

6.3.4 A CONCLUSIONS SECTION may be included in the Certificate of Analysis and will follow the
RESULTS section. This section is reserved for reports containing multiple items tested and hence more
results to be reported. It may be incorporated into the report to assist in streamlining results, thus creating
a more reader friendly report. When incorporated, it will contain results of comparisons, Data Bank
searches, conclusions and statistics, if applicable. Refer to the below examples for when a
CONCLUSIONS section might be incorporated into the report.

EXAMPLE: A reconstruction case involving 2 victims and 2 suspects and 21 items was submitted for
analysis. DNA profiles were developed from 17 of the 21 items; the results of comparison
to the known samples may be summarized in a CONCLUSIONS section in the Certificate
of Analysis. The RESULTS section would address whether DNA profiles were developed
or not.

EXAMPLE: A homicide case involving 1 victim, 5 suspects, and multiple submissions with numerous
items for examination was submitted for analysis. Grouping of evidence results for
reporting purposes is minimal due to the varying results obtained (full profiles, no foreign
profiles, mixtures suitable for searching, limited foreign profiles, etc.). A CONCLUSIONS
section may be used to report the results of the comparisons and Data Bank searches. The
RESULTS section of this report would address whether DNA profiles were developed or
not.

6.4 Reporting Format for Subject Cases

The results of the analysis for a subject case will be reported in the Certificate of Analysis in the following
manner.

6.4.1 Intimate Evidence Samples (i.e., Victim or Suspect PERK samples)

NOTES: The following section-is written as-if the.evidence is from the victim. If the evidence is from
the suspect, substitute “SUSPECT” for “VICTIM” and “VICTIM” for “SUSPECT”, as
appropriate.

The VICTIM/SUSPECT EVIDENCE SAMPLE(S) listed below refers to the sample as a
whole (i.e., vaginal swabs, pubic area swabs, etc.). The sperm and non-sperm fractions will not
routinely be reported separately in the “Results” section.
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6.4.1.1 Single Source Foreign Donor

6.4.11.1

6.4.1.1.2

6.4.1.1.3

INCLUSION - Victim’s Type NOT Present

“A DNA profile foreign to VICTIM was developed from the VICTIM
EVIDENCE SAMPLE(S). SUSPECT cannot:be eliminated as a contributor of this
foreign DNA profile.”

INCLUSION - Victim’s Type Present

“A DNA profile foreign to VICTIM was developed from the VICTIM
EVIDENCE SAMPLE(S). SUSPECT cannot be eliminated as a contributor of this
foreign DNA profile. A DNA profile attributable to VICTIM is also present in this
sample.”

EXCLUSION

“A DNA profile foreign to VICTIM was developed from the VICTIM
EVIDENCE SAMPLE(S). SUSPECT is eliminated as a contributor of this foreign
DNA profile.”

NOTE: If the victim’s DNA profile is present add the statement, “A DNA profile
attributable to the VICTIM is also present in the sample.” (Refer to the
appropriate non-subject case subsection for reporting results of Data Bank
searches,if appropriate.)

6.4.1.2 Multiple Foreign Donors

6.4.12.1

6.4.12.2

6.4.1.2.3

INCLUSION - Victim’s Type NOT Present

“A DNA mixture profile foreign to VICTIM was developed from the VICTIM
EVIDENCE SAMPLE(S). SUSPECT 1 and SUSPECT 2 cannot be eliminated as
contributors to this foreign DNA mixture profile.

If any portion of mixture profile remains unaccounted for, it needs to be addressed
in the Certificate of Analysis.

INCLUSION - Victim’s Type Present

“A DNA mixture profile foreign to VICTIM was developed from the VICTIM
EVIDENCE SAMPLE(S). SUSPECT 1 and SUSPECT 2 cannot be eliminated as
contributors to this foreign DNA mixture profile. A DNA profile attributable to
VICTIM is also present in this sample.”

If any portion of mixture profile remains unaccounted for, it needs to be addressed
in the Certificate of Analysis.

EXCLUSION

“A DNA mixture profile foreign to VICTIM was developed from the VICTIM
EVIDENCE SAMPLE(S). SUSPECT is eliminated as a contributor of this foreign
DNA mixture profile.”

NOTE: If the victim’s DNA profile is present add the statement, “A DNA profile
attributable to VICTIM is also present in the sample.” (Refer to the
appropriate non-subject case subsection for reporting results of Data
Bank searches, if appropriate.)
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NOTE: If one of the donors to the foreign mixture profile is an elimination
sample (i.e., boyfriend or husband), the results can alternatively be
reported as follows:

“A DNA profile foreign to VICTIM and different from ELIMINATION
was developed from the VICTIM EVIDENCE SAMPLE(S). SUSPECT
cannot be eliminated (or is eliminated)as a contributor of this foreign
DNA profile.”

NOTE: If the victim or elimination DNA profile is present add the statement,
“DNA profile(s) attributable to VICTIM and/or ELIMINATION are also
present in this sample.”

6.4.1.3  No Foreign Profiles

“No,DNA profile foreign.to.VICTIM (and/or different. from ELIMINATION) was developed
from the:VICTIM/EVIDENCE SAMPLE(S).

6.4.1.4  Foreign Profiles of Limited Value (Single Source or Mixture Profiles)
6.4.1.4.1 NO CONCLUSIONS REGARDING KNOWN SAMPLE

If a DNA profile foreign to the victim is developed, and no conclusions relative to
the suspect can be made due to the limited information obtained, this will be
reported-in the following manner:

“A'DNA (mixture) profile foreign to VICTIM was developed fromthe VICTIM
EVIDENCE SAMPLE(S). Insufficient information exists to draw a conclusion
regarding SUSPECT as a contributor of (to) this foreign DNA (mixture) profile.”

NOTE: If the victim’s DNA profile is present add the statement, “A DNA profile
attributable to VICTIM is also present in the sample.”

6.4.1.4.2 EXCLUSION (COMPARISON ONLY/ELIMINATION ONLY)

6.4.14.2.1 Comparison Only: If a DNA profile foreign to the victim is
deemed suitable for comparison purposes, but not suitable for
searching against the Data Bank, this will be reported in the
following manner:

“A DNA (mixture) profile of limited value and foreign to VICTIM
was developed from the VICTIM EVIDENCE SAMPLE(S).
SUSPECT is eliminated as a contributor of (to) this foreign DNA
(mixture) profile. This profile may be suitable for comparison. Due
to the limited information obtained, it is not suitable for searching
against the Virginia DNA Data Bank or submission to the National
DNA Data Bank.”

NOTE: If the victim’s DNA profile is present add the statement,
“A DNA profile attributable to VICTIM is also present in
the sample.”

or
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Complex mixture

A DNA mixture profile of limited value and foreign to VICTIM
was developed from the VICTIM EVIDENCE SAMPLE(S).
SUSPECT is eliminated as a contributor to this foreign DNA
(mixture) profile. This.profile‘may be suitable for comparison. Due
to the unknown number of potential contributors and the complex
nature of this profile. it is not suitable for searching against the
Virginia DNA Data Bank or submission to the National DNA Data
Bank.

NOTE: |Ifthe victim’s DNA profile is present add the statement,
“A DNA profile attributable to VICTIM is also present in
the sample.”

“DNA comparisons.can.be.conducted.following the submission of
two buccall (cheek) swabs from a suspect (or other person of
interest) to'the Laboratory.”

NOTE: If the evidence is from the suspect or the case is not a
CODIS case, omit the latter part of the statement above
regarding searching of the Data Bank and submission to
the National DNA Data Bank.

6.4:1.4:2.2 Elimination:Only-:If asDNAuprofile foreign:to the:victim is
deemed of limited value for comparison purposes and will only be
used for elimination purposes, and the profile is 'not suitable for
searching against the Data Bank, this will be reported in the
following manner:

“A DNA (mixture) profile of limited value and foreign to VICTIM
was developed from the VICTIM EVIDENCE SAMPLE(S).
SUSPECT is eliminated as a contributor of (to) this foreign DNA
(mixture) profile. This profile is not suitable for searching against
the Virginia DNA Data Bank or submission to the National DNA
Data Bank. Due to the limited information obtained, it may only be
used for elimination purposes. ”

NOTE: If the victim’s DNA profile is present add the statement,
“A DNA profile attributable to VICTIM is also present in
the sample.”

“DNA comparisons can be conducted following the submission of
two buccal (cheek) swabs from a suspect (or other person of
interest) to the Laboratory.”

NOTE:If the evidence is from the suspect or the case is not a
CODIS case, omit the latter part of the statement above
regarding searching of the Data Bank and submission to
the National DNA Data Bank.
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6.4.1.5  Foreign Profiles of No Value (Single source or mixture profiles)

When a DNA profile foreign to the victim is developed from the victim evidence, and this
profile is determined to be of no value for comparison or Data Bank searching, report this in
the following manner:

“A DNA (mixture) profile of no value and foreign'to VICTIM was developed from the
VICTIM EVIDENCE SAMPLE(S). Due to the limited information obtained, this profile is
not suitable for comparison, searching against the Virginia DNA Data Bank or submission to
the National DNA Data Bank.”

NOTE: "If the victim’s DNA profile is present add the statement, “A DNA profile attributable
to VICTIM is also present in the sample.”

OR

Complex mixture

“A DNA mixture profile of no value and foreign to VICTIM was developed from the
VICTIM EVIDENCE SAMPLE(S). Due to the unknown number of potential contributors and
the complex nature of this mixture profile, it is not suitable for comparison, searching against
the Virginia DNA Data Bank or submission to the National DNA Data Bank.”

NOTES: If the victim’s DNA profile is present add the statement, “A DNA profile
attributable to-VICTIM is also-present.in.the.sample.”

If the evidence is from the suspect or the case is not a CODIS case, omit the latter
part of the statement above regarding searching of the Data Bank and submission to
the National DNA Data Bank.

6.4.2 Non-Intimate Evidence Samples (i.e., typically items from the scene such as a knife, T-shirt, cigarette
butts, etc.)

6.4.2.1  Single Source Profiles
6.4.2.1.1 INCLUSION

“A DNA profile was developed from the EVIDENCE. SUSPECT (or VICTIM)
cannot be eliminated as a contributor of this DNA profile.”

6.4.2.1.2 EXCLUSION
“A DNA profile was developed from the EVIDENCE. SUSPECT (or VICTIM) is
eliminated as a contributor of this DNA profile.”” (Refer to the appropriate non-
subject case subsection for reporting results of Data Bank searches, if
appropriate.)
6.4.2.2 Mixture Profiles with Discernible'Major/Minor Contributors

NOTE: Both portions of the mixture profile (major and minor) must be addressed in the
“Results” section of the Certificate of Analysis.

6.4.2.2.1 INCLUSION
Two Contributor Mixtures

“A DNA mixture profile was developed from the EVIDENCE. Assuming this
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DNA profile is a mixture of one major contributor and one minor contributor,
SUSPECT (and/or VICTIM) cannot be eliminated as a major (or minor)
contributor to this DNA mixture profile.” (Refer to the appropriate non-subject
case subsection for reporting results of a Data Bank search, if appropriate, on the
remaining portion of the mixture).

NOTE: Conclusions to both major and:minor profiles should be reported
Three Contributor Mixtures

“A DNA mixture profile was developed from the EVIDENCE. Assuming this
DNA profileis a mixture of one major/contributor and minor contributor(s),
SUSPECT (and/or VICTIM) cannot be eliminated as a major (or minor)
contributor to this DNA mixture profile.” (Refer to the appropriate non-subject
case subsection for reporting results of a Data Bank search, if appropriate, on the
remaining portion of the mixture).

6.4.2.2:2° EXCLUSION

“A DNA mixture profile was developed from the EVIDENCE. SUSPECT (and/or
VICTIM) is eliminated as a contributor to this DNA mixture profile.” (Refer to the
appropriate non-subject case subsection for reporting results of a Data Bank
search, if appropriate).

NOTE:~Depending-on thecase scenario-and-the results, itmay be-necessary to
report the exclusion relative to a major or minor contributor. However, if
the lindividual is eliminated from the DNA mixture profile entirely, use
the format listed above.

6.4.2.3  Mixture Profiles with NO Discernible Major/Minor Contributors

NOTE: All portions of the mixture profile must be addressed in the “Results” section of the
Certificate of Analysis.

6.4.2.3.1 INCLUSION

“A DNA mixture profile was developed from the EVIDENCE. SUSPECT (and/or
VICTIM) cannot be eliminated as a contributor to this DNA mixture profile.”
(Refer to the appropriate non-subject case subsection for reporting the results of a
Data Bank search, if appropriate, on the remaining portion of the mixture).

6.4.2.3.2 EXCLUSION

“A DNA mixture profile was developed from the EVIDENCE. SUSPECT (and/or
VICTIM) is eliminated as a contributor to this DNA mixture profile.” (Refer to the
appropriate non-subject case subsection for reporting results of Data Bank
searches; if appropriate:)
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6.4.24  Profiles of Limited Value (Single Source or Mixture Profiles)
6.4.24.1 NO CONCLUSIONS REGARDING KNOWN SAMPLE

If a DNA profile is developed, and no conclusions relative to the victim or suspect
can be made due to the limited information obtained, this will be reported in the
following manner:

“A DNA (mixture) profile was developed from the EVIDENCE. Insufficient
information exists to draw a conclusion regarding SUSPECT (or VICTIM) as a
contributor of (to) this DNA (mixture) profile.”

6.4.2.4.2  EXCLUSION (COMPARISON/ONLY/ELIMINATION ONLY)

6.4.24.2.1 COMPARISON ONLY: If a DNA profile is deemed suitable for
comparison-purposes; but not suitable for searching against the
Data Bank, this will bexreported in the following manner:

“A DNA (mixture) profile of limited value was developed from
the EVIDENCE. SUSPECT (and/or VICTIM) is eliminated as a
contributor of (to) this DNA (mixture) profile. This profile may be
suitable for comparison. Due to the limited information obtained, it
is not suitable for searching against the Virginia DNA Data Bank
or submission to the National DNA Data Bank.”

OR
COMPLEX MIXTURES

“A DNA mixture profile of limited value was developed from the
EVIDENCE. SUSPECT (and/or VICTIM) is eliminated as a
contributor to this DNA (mixture) profile. This profile may be
suitable for comparison. Due to the unknown number of potential
contributors and the complex nature of this mixture profile, it is not
suitable for searching against the Virginia DNA Data Bank or
submission to the National DNA Data Bank.”

“DNA comparisons can be conducted following the submission of
two buccal (cheek) swabs from a suspect (or other person of
interest) to the Laboratory.”

NOTE: If the case is not a CODIS case, omit the latter part of the
statement above regarding searching of the Data Bank and
submission to the National DNA Data Bank.

6.4.2.4.2.2 ELIMINATION ONLY: If a DNA profile is deemed of limited
value for.comparison purposes and will only be used for
elimination purposes, and the profile is not suitable for searching
against the Data Bank, this will be reported in the following
manner:

“A DNA (mixture) profile of limited value was developed from the
EVIDENCE. SUSPECT (and/or VICTIM) is eliminated as a
contributor of (to) this DNA (mixture) profile. This profile is not
suitable for searching against the Virginia DNA Data Bank or
submission to the National DNA Data Bank. Due to the limited
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information obtained, it may only be used for elimination
purposes. ”

“DNA comparisons can be conducted following the submission of
two buccal (cheek) swabs from a suspect (or other person of
interest) to the Laboratory.”

NOTE: If the case is not a CODIS case, omit the latter part of the
statement above regarding searching of the Data Bank and
submission to the National DNA Data Bank.

6.4.25  Profiles'of No Value (Single Source or Mixture Profiles)

When a DNA profile is determined to be of no value for comparison purposes or Data Bank
searching, this will be reported in the following manner:

“A DNA (mixture).profile.of no.value was.developed.from the.EVIDENCE. Due to the
limited-information obtained, this profile is not suitable for comparison, searching against the
Virginias DNA Data Bank or submission to the National DNA Data Bank.”

OR
Complex Mixture

A DNA mixture profile of no value was developed from the EVIDENCE. Due to the
unknown number-of potential-contributors and the complex nature of this mixture profile it is
not suitable for comparison, searching against the Virginia'lDNA Data Bank or'submission to
the'National DNA Data'Bank.

NOTE: If the case is not a CODIS case, omit the latter part of the statement above regarding
searching of the Data Bank and submission to the National DNA Data Bank.

6.4.3 Formatting Conclusions

Depending on the number of samples tested and the complexity of the results, samples with similar
conclusions can be listed in bullet/list format. Alternatively, the conclusions may be reported in a chart
format which includes the item number, item description and names of individuals tested in the header
row, and the results (i.e., eliminated, not eliminated) within the appropriate chart cells. Refer to the
examples below.

6.4.3.1 Bullet/List Format

VICTIM cannot be eliminated, and SUSPECT is eliminated, as a contributor of the DNA
profile developed from the following samples:

Stained swabs (Items 1, 2 and 4)
Stains A and C on T-shirt (Item 3)
Stains A, B and C on-pants (Item.5)
Knife blade (Item.7)

SUSPECT cannot be eliminated, and VICTIM is eliminated, as a contributor of the DNA
profile developed from the following samples:

e  Stained swabs (Item 6)
e  Stain B on T-shirt (Item 3)
e Knife handle (Item 7)
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6.4.3.2 Chart Format

ITEM ITEM DESCRIPTION VICTIM SUSPECT
1 Stained swabs Not Eliminated Eliminated
2 Stained swabs Not Eliminated Eliminated
3 T-shirt — Stains Aand C Not Eliminated Eliminated
3 T-shirt — Stain B Eliminated Not Eliminated
4 Stained swabs Not Eliminated Eliminated
5 Pants — Stains A, Band C Not Eliminated Eliminated
6 Stained swabs Eliminated Not Eliminated
7 Knife — Blade Not Eliminated Eliminated
7 Knife — Handle Eliminated Not Eliminated

6.5 Report Format for Non-Subject Cases

The results of the analysis of a non-subject case will be reported in the following manner:

6.5.1 Intimate Evidence Samples (i.e., Victim PERK:samples)

NOTES: The following section is written as if the evidence is from the victim. If the evidence is from
the suspect, substitute the “SUSPECT” for “VICTIM” and “VICTIM” for “SUSPECT", as
appropriate.

The VICTIM/SUSPECT EVIDENCE SAMPLE(S) listed below refers to the sample as a
whole (i.e., vaginal swabs, pubic area swabs, etc.). The sperm and non-sperm fractions will not
routinely be reported separately in the “Results” section.

6.5.1.1

6.5.1.2

6.5.1.1.1

Single Source Foreign Donor

Victim’s Type NOT Present

“A DNA profile foreign to VICTIM was developed from the VICTIM
EVIDENCE SAMPLE(S).” (Refer to the appropriate subsection under non-
intimate evidence samples for reporting results of Data Bank searches.)

6.5.1.1.2

Victim’s Type Present

“A DNA profile foreign to VICTIM was developed from the VICTIM
EVIDENCE SAMPLE(S)..A DNA profile attributable to VICTIM is also present
in this sample.” (Refer to.the appropriate subsection-under non-intimate evidence
samples for reporting results of Data Bank searches:)

Multiple Foreign Donors

6.5.1.2.1

Victim’s Type NOT Present

“A DNA mixture profile foreign to VICTIM was developed from the VICTIM
EVIDENCE SAMPLE(S). (Refer to the appropriate subsection under non-
intimate evidence samples for reporting results of Data Bank searches.)
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NOTE: If one of the donors to the foreign mixture profile is an elimination
sample, the results can alternatively be reported as follows:

“A DNA profile foreign to VICTIM and different from ELIMINATION
was developed from the VICTIM EVIDENCE SAMPLE(S).

NOTE: |Ifthe victim or elimination DNA profile is present add the statement,
“DNA profile(s) attributable to VICTIM and/or ELIMINATION are also
present in this sample.”

6.5.1.3 NO Foreign Profiles

“No DNA profile foreign to VICTIM (and/or different from ELIMINATION) was developed
from the VICTIM EVIDENCE SAMPLE(S).”

6.5.1.4 . Foreign.Profiles of Limited Value (Single.Source or. Mixture Profiles)

6.5.14.1

6.5.14.2

COMPARISON ONLY: If a DNA profile foreign to the victim is deemed
suitable for comparison purposes, but not suitable for searching against the Data
Bank, this will be reported in the following manner:

“A DNA (mixture) profile of limited value and foreign to VICTIM was developed
from the VICTIM EVIDENCE SAMPLE(S). This profile may be suitable for
comparison. Due to the limited information obtained, it is not suitable for
searching-against the Virginia. DNA:Data Bank-or-submission.to-the-National
DNA Data Bank.”

NOTE: If the victim’s DNA profile is present add the statement, “A DNA profile
attributable to VICTIM is also present in the sample.”

OR
COMPLEX MIXTURE:

“A DNA mixture profile of limited value and foreign to VICTIM was developed
from the VICTIM EVIDENCE SAMPLE(S). This profile may be suitable for
comparison. Due to the unknown number of potential contributors and the
complex nature of this mixture profile, it is not suitable for searching against the
Virginia DNA Data Bank or submission to the National DNA Data Bank.

NOTE: If the victim’s DNA profile is present add the statement, “A DNA profile
attributable to VICTIM is also present in the sample.”

“DNA comparisons can be conducted following the submission of two buccal
(cheek) swabs from a suspect (or other person of interest) to the Laboratory.”

NOTE: -If the case is-not a-.CODIS case, omit the latter part of the statement above
regarding searching of the Data Bank and submission to the National
DNA Data Bank.

ELIMINATION ONLY: If a DNA profile foreign to the victim is deemed of
limited value for comparison and will only be used for elimination purposes, and
this profile is not suitable for searching against the Data Bank, this will be reported
in the following manner:

“A DNA (mixture) profile of limited value and foreign to VICTIM was developed
from the VICTIM EVIDENCE SAMPLE(S). This profile is not suitable for
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searching against the Virginia DNA Data Bank or submission to the National
DNA Data Bank. Due to the limited information obtained, it may only be used for
elimination purposes.”

NOTE: If the victim’s DNA profile is present add the statement, “A DNA profile
attributable to VICTIM is also present in the sample.”

“DNA comparisons can be conducted following the submission of two buccal
(cheek) swabs from a suspect to the Laboratory.”

NOTE: If the case is not a CODIS case, omit the latter part of the statement above
regarding searching of the Data Bank and submission to the National
DNA Data Bank.

Foreign Profiles of NO Value (Single Source or Mixture Profiles)

When a-DNAprofile foreign to the victim is developed from the victim evidence, and this
profileris:determined to be of no value for comparison or Data Bank searching, report this in
the following manner:

“A DNA (mixture) profile of no value and foreign to VICTIM was developed from the
VICTIM EVIDENCE SAMPLE(S). Due to the limited information obtained, this profile is
not suitable for comparison, searching against the Virginia DNA Data Bank or submission to
the National DNA Data Bank.”

NOTE:" If the victim’s DNA profile is present add the statement, “A DNA profile attributable
to VICTIM'is also present inthe sample.”

OR

COMPLEX MIXTURE:

“A DNA mixture profile of no value and foreign to VICTIM was developed from the
VICTIM EVIDENCE SAMPLE(S). Due to the unknown number of potential contributors and
the complex nature of this mixture profile, it is not suitable for comparison, searching against

the Virginia DNA Data Bank or submission to the National DNA Data Bank.”

NOTES: If the victim’s DNA profile is present add the statement, “A DNA profile
attributable to VICTIM is also present in the sample.”

If the case is not a CODIS case, omit the latter part of the statement above regarding
searching of the Data Bank and submission to the National DNA Data Bank.

6.5.2 Non-Intimate Evidence Samples (i.e., typically items from the scene such as a knife, T-shirt, cigarette

butts, etc.)

6.5.2.1

Single Source Profiles
6.5.2.1.1 No Match in Data Bank

“A DNA profile was developed from the EVIDENCE. This profile was searched
against the Virginia DNA Data Bank and no DNA profile consistent with this
profile was found. Future searches will be conducted on a periodic basis. This
profile is indicative of a male (or female) contributor and will be submitted (or is
not suitable for submission) to the National DNA Data Bank.
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DNA comparisons can be conducted following the submission of two buccal
(cheek) swabs from a suspect to the Laboratory”

NOTE: If the Amelogenin results are inconclusive or no Amelogenin results are
obtained, report this finding in the Certificate of Analysis as “No
conclusions can be made regarding the gender of the contributor of this
sample.”

6.5.2.1.2 Match Obtained in Data Bank to an INDIVIDUAL

“A DNA profile was developed from the EVIDENCE. This profile was searched
against the' Virginia DNA Data Bank and found to be consistent with the following
individual (in the “LISTED STATE” DNA Data Bank; use when a NDIS hit
occurs):

Name:

SSN:

DOC #

DCN #

SID #

Date of Birth:
Race:
Gender:

This information-is-provided-only-as aninvestigative lead;and any-possible
connection or involvement of this individual to'the case must be determined
through further investigation.

In order to complete the direct DNA comparison, two buccal (cheek) swabs from
INDIVIDUAL must be submitted to the Laboratory.”

NOTES: When a NDIS hit occurs and the information provided by another state
is more comprehensive than the categories listed above, the additional
identifying information (i.e., FBI number) will be provided in the
Certificate of Analysis. No information regarding height, weight, hair
color, eye color, etc. will be included in the Certificate of Analysis if this
information is provided by the other state.

If the match is made to the listed victim, the two paragraphs following
the hit information will be omitted from the Certificate of Analysis since
this type of hit is not probative.

If the 'match is made to the listed suspect, the paragraph referencing an
investigative lead will be omitted from the Certificate of Analysis.

If the match made is from a sample in a solved case and the match is not
probative, the-two-paragraphs following the hit information will be
omitted and the following statement will be included if the match is a
subsequent'search, “The DNA profile from EVIDENCE has been
removed from the Virginia DNA Data Bank.”

If the match was the result of a subsequent search and a new report will
be written, substitute the following sentence for the beginning
statements above: “A subsequent search of the DNA profile previously
developed from EVIDENCE and addressed in the Certificate of Analysis
dated against the Virginia DNA Data Bank found it to be
consistent with the following individual:”
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If the match was obtained at NDIS, substitute “National DNA Data
Bank” for “Virginia DNA Data Bank” listed above. Refer to

the Commonwealth of Virginia Department of Forensic Science CODIS
Operating Policies and Procedures Manual for further instructions.

If @ match is made to specimens in the convicted offender/arrestee and
the forensic indices, etc., the information associated with only the
convicted offender/arrestee index will be reported in the Certificate of
Analysis.

If a match to an individual occurs after previous matches have been
made to other unsolved cases, a separate report will be issued for each
linked case and contain the /information of the individual.

6.5.2.1.3 Match Obtained in Data Bank to Another CASE (Solved or Unsolved)

“A DNA profile was developed from:the EVIDENCE. This profile was searched
against the Virginia DNA Data Bankand found to be consistent with the DNA
profile developed from the EVIDENCE submitted under FS LAB # and the subject
of the Certificate of Analysis dated and addressed to NAME OF
INVESTIGATOR, NAME OF AGENCY, AGENCY CASE NUMBER. These
results indicate that the DNA profile developed from both of these samples could
have been deposited by the same individual.

Future-searches will-be conducted-on.a periodic:basis: The- DNA profile developed
from the EVIDENCE FROM THE CASE WHICH IS BEING REPORTED is
indicative of'a male (or female) contributor and will be submitted (or is not
suitable for submission) to the National DNA Data Bank.

This information is provided only as an investigative lead, and any possible
connection between these cases must be determined through further investigation.

DNA comparisons can be conducted following the submission of two buccal
(cheek) swabs from a suspect or other person of interest to the Laboratory.”

NOTES: The “Future searches...” paragraph will not be used if the candidate case
is a solved case. If the target mixture profile hits on a candidate
mixture profile, the above statement will be modified to reflect the
appropriate situation (i.e., “This mixture profile was searched against the
Virginia DNA Data Bank. As a result of this search, a contributor (or the
major contributor/the minor contributor) to the DNA mixture profile
developed from the EVIDENCE submitted under FS LAB # and the
subject of the Certificate of Analysis dated addressed to NAME
OF INVESTIGATOR, NAME OF AGENCY, AGENCY CASE
NUMBER cannot be eliminated as a contributor to this mixture profile.”

In the-absence of-a simultaneous offender/arrestee hit, the examiner
assigned to the target profile case will issue a Certificate of Analysis and
send a'copy of that report to the investigator of the candidate profile case
regardless of whether that case is solved or unsolved. No report is issued
by the examiner of the candidate profile case.

If the match was obtained at NDIS, substitute “National DNA Data
Bank” for “Virginia DNA Data Bank” listed above. Generally, reports
will be issued for all case to case matches made at NDIS. If cases have
been previously linked as a result of matches made in the Virginia DNA
Data Bank and a subsequent case to case match is made to these linked
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cases at NDIS, a report can be issued on one of the linked Virginia cases
with a copy sent to the investigator of the other linked cases. Refer to
the Commonwealth of Virginia Department of Forensic Science CODIS
Operating Policies and Procedures Manual for further instructions.

If @ match is made to specimens in the convicted offender/arrestee and
the forensic indices, etc., the'information associated with only the
convicted offender/arrestee index will be reported in the Certificate of
Analysis.

6.5.2.2 Mixture Profiles with Discernible Major/Minor Contributors

NOTE: Both portions of the mixture profile (major and minor) must be addressed in the
“Results” section of the Certificate of Analysis.

6.5.2.2.1- NO.Match in-Data Bank

“A DNA mixture profile was developed:from the EVIDENCE. The major (or
minor) profile from this mixture was searched against the Virginia DNA Data
Bank and no DNA profile(s) consistent with this profile was found. Future
searches will be conducted on a periodic basis. This profile will be submitted (or is
not suitable for submission) to the National DNA Data Bank.

DNA comparisons can be conducted following the submission of two buccal
(cheek)-swabs from-a suspectto the Laboratory.”

NOTE: "Depending on the mixture profile obtained and the'case scenario, the
gender of the major/minor contributor may be able to be determined. If
so, gender will be reported similar to the statement under SINGLE
SOURCE PROFILES, NO MATCH IN DATA BANK.

6.5.2.2.2 Match Obtained in Data Bank to an INDIVIDUAL

“A DNA mixture profile was developed from the EVIDENCE. The major (or
minor ) profile developed from this mixture was searched against the Virginia
DNA Data Bank and found to be consistent with the following individual (in the
“LISTED STATE” DNA Data Bank; use when a NDIS hit occurs):

Name:

SSN:

DOC #

DCN #

SID #:

Date of Birth:
Race:
Gender:

This information is provided only as an investigative lead, and any possible
connection or involvement of this individual to the case must be determined
through further investigation.

In order to complete the direct DNA comparison, two buccal (cheek) swabs
from INDIVIDUAL must be submitted to the Laboratory.”

NOTES: When a NDIS hit occurs and the information provided by another
state is more comprehensive than the categories listed above, the
additional identifying information (i.e., FBI number) will be provided
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in the Certificate of Analysis. No information regarding height,
weight, hair color, eye color, etc. will be included in the Certificate of
Analysis if this information is provided by the other state.

If the match is made to the listed victim, the two paragraphs
following the hit information will'be omitted from the Certificate of
Analysis since this type of hit is not probative.

If the match is made to the listed suspect, the paragraph referencing
an investigative lead will be omitted from the Certificate of Analysis.

If the match made/is from/a sample in a solved case and the match is
not probative, the two paragraphs following the hit information will be
omitted and the following statement will be included if the match is a
subsequent search, “The DNA profile from EVIDENCE has been
removed.from.the Virginia DNA Data.Bank.”

If the match was the result-of a subsequent search and a new report
will be written, substitute the following sentence for the beginning
statements above: “A subsequent search of the DNA profile
previously developed from EVIDENCE and addressed in the
Certificate of Analysis dated against the Virginia DNA
Data Bank, found it to be consistent with the following individual:”

If the-match was obtained at:-NDISy substitute-“National:DNA Data
Bank” for “Virginia DNA Data Bank™ listed above. Refer to

the Commonwealth of Virginia of Department Forensic Science
CODIS Operating Policies and Procedures Manual for further
instructions.

If a match is made to specimens in the convicted offender/arrestee
and the forensic indices, etc., the information associated with only
the convicted offender/ arrestee index will be reported in the
Certificate of Analysis.

If a match to an individual occurs after previous matches have been
made to other unsolved cases, a separate report will be issued for each
linked case and contain the information of the individual.

Match Obtained in Data Bank to Another CASE (Solved or Unsolved)

“A DNA mixture profile was developed from the EVIDENCE. The major (or
minor) profile developed from this mixture was searched against the Virginia
DNA Data Bank. As a result of this search, the contributor of the DNA profile
developed from the EVIDENCE submitted under FS LAB # and the subject of the
Certificate of Analysisdated  addressed to NAME OF INVESTIGATOR,
NAME OF AGENCY, AGENCY CASE NUMBER, cannot be eliminated as a
contributor-to this:mixture profile:

Future searches will be conducted on a periodic basis. The DNA profile developed
from the EVIDENCE FROM THE CASE WHICH IS BEING REPORTED will be
submitted (or is not suitable for submission) to the National DNA Data Bank.

This information is provided only as an investigative lead, and any possible
connection between these cases must be determined through further investigation.

DNA comparisons can be conducted following the submission of two buccal
(cheek) swabs from a suspect to the Laboratory.”
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NOTES: The “Future searches...” paragraph will not be used if the candidate case
is a solved case.

Depending on the results and case scenario, the gender of the
major/minor contributor may be able to be determined. 1'so, the gender
will’be reported similar to the statement under SINGLE SOURCE
PROFILES, NO MATCH IN DATA BANK.

In the absence of a simultaneous offender or arrestee hit, the
examiner assigned to the target profile case will issue a Certificate of
Analysis report and send a copy of that report to the investigator of the
candidate profile case regardless of whether that case is solved or
unsolved. No report is issued by the examiner of the candidate profile
case.

If the.match was obtained at:-NDIS; substitute “National DNA Data
Bank™ for “Virginia DNA Data Bank” listed above. Generally, reports
will be issued for all case to case matches made at NDIS. If cases have
been previously linked as a result of matches made in the Virginia DNA
Data Bank and a subsequent case to case match is made to these linked
cases at NDIS, a report can be issued on one of the linked Virginia cases
with a copy sent to the investigator of the other linked cases. Refer to
the Commonwealth of Virginia Department of Forensic Science CODIS
Operating-Policies-and Procedures-Manual for furtherqinstructions.

If a match is made'to specimens inthe convicted offender/arrestee and
the forensic indices, etc., the information associated with only the
convicted offender/arrestee index will be reported in the Certificate of
Analysis.

6.5.2.3  Mixture Profiles with No Discernible Major/Minor Contributor

6.5.2.3.1

6.5.2.3.2

NO Match in Data Bank

“A DNA mixture profile was developed from the EVIDENCE. This mixture
profile was searched against the Virginia DNA Data Bank and no DNA profiles
consistent with this profile were found. Future searches will be conducted on a
periodic basis. This mixture profile will be submitted (or is not suitable for
submission) to the National DNA Data Bank.

DNA comparisons can be conducted following the submission of two buccal
(cheek) swabs from a suspect to the Laboratary.

NOTE: No information regarding gender will be reported for mixture profiles
when no discernible major/minor contributor is obtained.

Match Obtained in Data Bank to an INDIVIDUAL

“A DNA mixture profile was developed from the EVIDENCE. This mixture
profile was searched against the Virginia DNA Data Bank. As a result of this
search, the following individual (in the “LISTED STATE” DNA Data Bank; use
when a NDIS hit occurs) has a DNA profile consistent with a possible contributor
to this mixture:

Name:
SSN:
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DOC #:

DCN #:

SID #:

Date of Birth:
Race:
Gender:

This information is provided only as an investigative lead, and any possible
connection or involvement of this individual to the case must be determined through
further investigation.

In order to complete the direct DNA comparison, two buccal (cheek) swabs from
INDIVIDUAL must 'be submitted to the Laboratory.

This profile will submitted to the Virginia (and National) DNA Data Bank(s).”

NOTES: /When a:NDIS hit occurs and the information provided by another state is
more comprehensive than the categories listed above, the additional
identifying information (i.e., FBI number) will be provided in the
Certificate of Analysis. No information regarding height, weight, hair
color, eye color, etc. will be included in the C of A if this information is
provided by the other state.

When a NDIS hit occurs and the information provided by another state is
more-comprehensive than the categories listed-above; the-additional
identifying information (i.e., FBI number) will be provided-in the
Certificate 'of Analysis. No‘information regarding height, weight, hair
color, eye color, etc. will be included in the C of A if this information is
provided by the other state.

If the match is made to the listed victim, the two paragraphs following the
hit information will be omitted from the Certificate of Analysis since this
type of hit is not probative.

If the match is made to the listed suspect, the paragraph referencing an
investigative lead will be omitted from the Certificate of Analysis.

If the match made is from a sample in a solved case and the match is not
probative, the two paragraphs following the hit information will be omitted
and the following statement will be included if the match is a subsequent
search, “The DNA profile from EVIDENCE has been removed from the
Virginia DNA Data Bank.”

If the match was the result of a subsequent search and a new report will
be written, substitute the following sentences for the beginning statements
above: “A subsequent search of the DNA mixture profile previously
developed.from EVIDENCE and addressed in Certificate of Analysis
dated against the Virginia DNA Data Bank was conducted. As a
result of this search, the following individual (in the “LISTED STATE”
DNA Data Bank; use when a NDIS hit occurs) cannot be eliminated as a
contributor to this mixture profile:”

If the match was obtained at NDIS, substitute “National DNA Data Bank”
for “Virginia DNA Data Bank” listed above and refer to

the Commonwealth of Virginia Department of Forensic Science CODIS
Operating Policies and Procedures Manual for further instructions.

Forensic Biology Section Procedures Manual, Section VIII DFS Document 210-D1100
Issued by Biology Program Manager Revision 4
Issue Date: 25-April-2016 Page 85 of 128



6 Report Writing

If a match is made to specimens in the convicted offender/arrestee and
the forensic indices, etc., the information associated with only the
convicted offender/arrestee index will be reported in the Certificate of
Analysis.

If a'match to an individual occurs after previous matches have been made
to other unsolved cases, a separate report will be issued for each linked
case and contain the information of the individual.

6.5.2.3.3 Match Obtained in Data Bank to Another CASE (Solved or Unsolved)

“A DNA mixture profile was developed from the EVIDENCE. This mixture
profile was searched against the Virginia DNA Data Bank. As a result of this
search, the contributor of the DNA profile developed from the EVIDENCE
submitted under FS LAB # and the subject of the Certificate of Analysis dated

addressed-to NAME OF INVESTIGATOR, NAME OF AGENCY,
AGENCY CASE NUMBER cannot be-eliminated as a contributor to this mixture
profile.

Future searches will be conducted on a periodic basis. The DNA mixture profile
developed from the EVIDENCE FROM THE CASE WHICH IS BEING
REPORTED will be submitted (or is not suitable for submission) to the National
DNA Data Bank.

This information-is-provided-only-as-ansinvestigative lead;-and any-possible
connection between these cases must be determined through furthersinvestigation.

DNA comparisons can be conducted following the submission of two buccal
(cheek) swabs from a suspect to the Laboratory.”

NOTES: The “Future searches...” paragraph will not be used if the candidate case
is a solved case.

No information regarding gender will be reported for mixture profiles
when no discernible major/minor profile is obtained.

If the target mixture profile hits on a candidate mixture profile, the
above statement will be modified to reflect the appropriate situation (i.e.,
“This mixture profile was searched against the Virginia DNA Data
Bank. As a result of this search, a contributor (or the major
contributor/the minor contributor) to the DNA mixture profile developed
from the EVIDENCE submitted under FS LAB # and the subject of the
Certificate of Analysis dated addressed to NAME OF
INVESTIGATOR, NAME OF AGENCY, AGENCY CASE NUMBER
cannot be eliminated as a contributor to this mixture profile.)”

In the absence of a simultaneous arrestee or offender hit, the examiner
assigned to the target profile case will issue a Certificate of Analysis and
send a copy of that report to the investigator of the candidate profile case
regardless of whether that case is solved or unsolved. No report is issued
by the examiner of the candidate profile case.

If the match was obtained at NDIS, substitute “National DNA Data
Bank” for “Virginia DNA Data Bank” listed above. Generally, reports
will be issued for all case to case matches made at NDIS. If cases have
been previously linked as a result of matches made in the Virginia DNA
Data Bank and a subsequent case to case match is made to these linked
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cases at NDIS, a report can be issued on one of the linked Virginia cases
with a copy sent to the investigator of the other linked cases. Refer to
the Commonwealth of Virginia Department of Forensic Science CODIS
Operating Policies and Procedures Manual for further instructions.

If @ match is made to specimens in the convicted offender/arrestee and
the forensic indices, etc., the information associated 'with only the
convicted offender/ arrestee index will be reported in the Certificate of
Analysis.

6.5.2.4  Profiles of Limited Value (Single Source or Mixture Profiles)

6.5.24.1

6.5.2.4.2

COMPARISON ONLY: If a profile/is.deemed suitable for comparison purposes,
but not suitable for searching against the Data Bank, this will be reported in the
following manner:

“A DNA (mixture) profile of limited value was developed from the EVIDENCE.
This mixture profile may be suitable for.comparison. Due to the limited
information obtained, it is not suitable for searching against the Virginia DNA
Data Bank or submission to the National DNA Data Bank.”

OR

“Due to the limited information obtained, the minor profile (or remaining portion /
DNA types different than..:).developed-from:this:mixture-may be:suitable for
comparison, but is not suitable for searching against the Virginia DNA Data Bank
or submission to the National DNA Data Bank.”

OR
COMPLEX MIXTURE

“A DNA mixture profile of limited value was developed from the EVIDENCE.
This profile may be suitable for comparison. Due to the unknown number of
potential contributors and the complex nature of this mixture profile, it is not
suitable for searching against the Virginia DNA Data Bank or submission to the
National DNA Data Bank.”

“DNA comparisons can be conducted following the submission of two buccal
(cheek) swabs from a suspect (or other person of interest) to the Laboratory.”

NOTE: If the case is not a CODIS case, omit the latter part of the statement above
regarding searching of the Data Bank and submission to the National
DNA Data Bank.

ELIMINATION ONLY: If a DNA profile is deemed of limited value for
comparison. purposes:and-will only be used for elimination purposes and this
profile is not suitable for searching against the Data Bank, this will be reported in
the following manner:

“A DNA (mixture) profile of limited value was developed from the EVIDENCE.
This profile is not suitable for searching against the Virginia DNA Data Bank or
submission to the National DNA Data Bank. Due to the limited information
obtained it may only be used for elimination purposes.”

DNA comparisons can be conducted following the submission of two buccal
(cheek) swabs from a suspect (or other person of interest) to the Laboratory.”
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NOTE: If the case is not a CODIS case, omit the latter part of the statement above
regarding searching of the Data Bank and submission to the National
DNA Data Bank.

6.5.2.5 Profiles of NO Value (Single Source or Mixture Profiles)

When a profile is deemed to be of no value for. comparison‘purposes or Data Bank searching,
this will be reported in the following manner:

“A DNA (mixture) profile of no value was developed from the EVIDENCE. Due to the
limited information obtained, this profile is not suitable for comparison, searching against the
Virginia’ DNA Data Bank or submission to the National DNA Data Bank.”

OR

“Due to.the limited.information.obtained, the minor profile (or-remaining portion / DNA types
different:than...) developed from this mixture DNA profile is not suitable for comparison,
searching against the Virginia. DNA Data Bank, or:submission to the National DNA Data
Bank.”

OR
COMPLEX MIXTURE

“ADNA mixture profile-of novalue was developed-from:the EVIDENCE :Due to the
unknown number of potential contributors and the complex nature of this mixture profile, it is
not suitable for comparison, searching against the Virginia DNA Data Bank or submission to
the National DNA Data Bank.”

NOTE: If the case is not a CODIS case, omit the latter part of the statement above regarding
searching of the Data Bank and submission to the National DNA Data Bank.

6.5.3  Multiples Samples Tested within a Case (Single Source or Mixture Profiles)

When multiple samples from a non-subject case are analyzed (i.e., 4 cigarette butts, 2 bottles and 1 can),
the report should address as follows how many different profiles were obtained from these items and
what the Data Bank searching results were.

“DNA profiles were developed from the EVIDENCE SAMPLES. Of these TOTAL NUMBER DNA
profiles, NUMBER OF DIFFERENT PROFILES different profiles, indicative of NUMBER OF
CONTRIBUTORS were developed.” (Refer to the appropriate subsection under non-intimate evidence
samples for reporting results of Data Bank searches.)

EXAMPLE: All items submitted were recovered from a trash can outside of a convenience store which
was burglarized.

“DNA profiles were developed-from:the four cigarette butts, and the mouth openings of the
two bottles and one can. Of these 'seven DNA profiles, four different profiles, indicative of
four different contributors, were developed. Three of these profiles were searched against
the Virginia DNA Data Bank and no profile consistent with these profiles was found. These
profiles are each indicative of a male contributor and will be submitted to the National

DNA Data Bank.
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The fourth DNA profile (Item 7) was searched against the Virginia DNA Data Bank and
found to be consistent with the following individual (in the “LISTED STATE” DNA Data
Bank; use when a NDIS hit occurs):

Name:
SSN:
Etc.”

When multiple samples from a non-subject case are analyzed and the profiles, although indicative of
originating from the same contributor, are not identical, they will be reported in the following manner:

“Similar DNA profiles were déveloped from the EVIDENCE SAMPLES. The DNA profile from the
SPECIFIC EVIDENCE SAMPLE was selected for searching against the Virginia DNA Data Bank and
no profile consistent with this profile was found. This profile is indicative of a male contributor and will
be submitted to the National DNA Data Bank.”

or

“DNA profiles were developed from the EVIDENCE SAMPLES. These DNA profiles are consistent
with originating from a common contributor. The DNA profile from the SPECIFIC EVIDENCE
SAMPLE was selected for searchingagainst the Virginia DNA Data Bank and no profile consistent with
this profile was found. This profile is indicative of a male contributor and will be submitted to the
National DNA Data Bank.”

When multiple-samples from-a-non=subject.case are-analyzed resulting in-mixture-profiles:from which a
common contributor can be identified, they can be reparted in the following manner:

“DNA mixture profiles were developed from the EVIDENCE. A common contributor to these profiles
was identified/observed and was searched (or DNA types common to both mixtures were searched)
against the Virginia DNA Data Bank and no profile consistent with this profile was found. This profile is
indicative of a male contributor and will be submitted to the National DNA Data Bank.”

NOTES: Intercomparisons of multiple samples within a non-subject case or intercomparisons of samples
from two or more non-subject cases should be conducted with only single source profiles or
discernible major contributors to mixture profiles. “No intercomparisons will be conducted
with the remaining DNA profiles” may be used as appropriate.

Judgment should be used when grouping items from multiple locations within the report. It
may be important to note that all profiles in one location are the same versus different profiles
obtained from other locations.

A statement will be included in the Certificate of Analysis to indicate that the results from the
intercomparison of the samples indicate that the contributor of the DNA profile developed
from EVIDENCE 1 cannot be eliminated as the contributor of the profile from EVIDENCE 2.

6.6 Reporting Format for Paternity, Missing Person and Body Identification Cases
When a comparison is made to a biological relative of an individual, rather than directly to the individual, the
results will be reported in the following manner:
6.6.1 Paternity Cases
DNA profiles were developed from the CHILD’S KNOWN SAMPLE/EVIDENCE SAMPLE and the
blood (or buccal) sample from the MOTHER and ALLEGED FATHER.
NOTE: A table listing the probative typing results will be included as an appendix to the Certificate of
Analysis. The statement, “Refer to Appendix 1 for the PowerPlex® 16 typing results and
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Appendix 2 for the Abbreviations”, will be listed just prior to the disposition statement in the
Certificate of Analysis.

If conclusions and statistics will be issued in a separate report by another examiner, include the following
statement or if included in the same report use the bottom statement:

“DNA conclusions and statistical calculations regarding the above analysis will be the subject of a
separate report.”

Or

“The ALLEGED FATHER cannot be eliminated (or fis eliminated) as the biological parent (or father) of
the CHILD/EVIDENCE SAMPLE.”

NOTES: If the mother is the alleged parent, the wording will be changed to reflect the appropriate
conclusion.

If the/mother and father are both alleged, the wording will be changed to reflect the appropriate
conclusions.

6.6.2  Missing Person Cases

“DNA profiles were developed from the EVIDENCE and from the blood (or buccal) samples from
RELATIVE.

NOTE: A'table listing the probative typing results will be includedas an appendix to the'Certificate of
Analysis. The statement, “Referto Appendix 1 for the PowerPlex® 16 typing results and
Appendix 2 for the Abbreviations”, will be listed just prior to the disposition statement in the
Certificate of Analysis.

If conclusions and statistics will be issued in a separate report by another examiner, include the following
statement or if included in the same report use the bottom statement:

“DNA conclusions and statistical calculations regarding the above analysis will be the subject of a
separate report.”

Or

“RELATIVE cannot be eliminated (or is eliminated) as a biological parent/offspring of the contributor of
the DNA profile developed from EVIDENCE.”

6.6.3 Body ldentification Cases
6.6.3.1 = Comparison to Personal Effects

“DNA profiles were developed from the SAMPLE FROM DECEDENT and from the
PERSONAL EFFECTS SAMPLE (i.e:;toothbrush, razor,). If the DNA profile developed
from the PERSONAL EFFECTS SAMPLE is from DECEDENT, then DECEDENT cannot
be eliminated (or is eliminated) as'a contributor of the DNA profile developed from the
SAMPLE FROM DECEDENT.

Investigators are advised to evaluate all associated case information in addition to the
provided genetic results before declaring the identity of the remains.”

NOTE: If a mixture profile is developed from a personal effects sample, this can be used for
comparison purposes as long as the major contributor to this mixture profile can be
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discerned. No reference will be made in the C of A regarding the remaining portion
of the mixture in the personal effects sample.

6.6.3.2  Comparison to Biological Relatives

“A DNA profile was developed from the SAMPLE'FROM DECEDENT and from the blood
(or buccal) samples from'RELATIVE.”

If conclusions and statistics will be issued in a separate report by another examiner, include
the following statement or if included in the same report use the bottom statement:

“DNA conclusions land statistical calculations regarding the above analysis will be the subject
of a separate report.”

Or

RELATIVE cannot be eliminated (or is eliminated) as a biological parent/offspring of the
contributor of the DNA profile developed from EVIDENCE.”

6.7 Reporting Format for Statistical Calculations

Statistical calculations will be conducted and reported for the most probative profile(s). The types of statistical
calculations reported by DFS include random match probability, modified random match probability, likelihood
ratio, combined probability of exclusion/inclusion, paternity index and probability of paternity, and missing
person:Routinely; statistical calculations will;be reported for the Caucasian; Black and Hispanic-populations in
accordance with The Evaluation of Forensic DNA Evidence, National Academy Press, Washington'D.C., 1996
(i.e., National Research Council I1).

If statistics are appropriate and will be issued in a separate report by another examiner, include the following
statement:

“DNA conclusions and statistical calculations regarding the above analysis will be the subject of a separate
report.”

6.7.1 Random Match Probability

The loci that are used for calculating the random match probability will be listed in the report. This can
be done by listing the loci individually, stating “the PowerPlex® 16 loci” or stating “the PowerPlex® 16

loci with the exception of LOCUS/LOCI”. A random match probability will be reported in the following
manner:

6.7.1.1  When all population groups exceed 7.2 billion (approximate world population):

“The probability of randomly selecting an unrelated individual with a DNA profile matching
that developed from the EVIDENCE, SPERM OR NON-SPERM FRACTION OF
EVIDENCE, MAJOR PROFILE OF THE EVIDENCE, ETC. at the LOCI USED FOR
CALCULATION locivis Lin-greaterthan 7:2 billion (which is approximately the world
population) in the Caucasian, Black'and Hispanic populations.”

6.7.1.2  When only one or two population groups exceed 7.2 billion (approximate world population):

“The probability of randomly selecting an unrelated individual with a DNA profile matching
that developed from the EVIDENCE, SPERM OR NON-SPERM FRACTION OF
EVIDENCE, MAJOR PROFILE OF THE EVIDENCE, ETC. at the LOCI USED FOR
CALCULATION loci is approximately 1 in in the Black population, 1 in in the
Hispanic population, and 1 in greater than 7.2 billion (which is approximately the world
population) in the Caucasian population.”

Forensic Biology Section Procedures Manual, Section VIII DFS Document 210-D1100
Issued by Biology Program Manager Revision 4
Issue Date: 25-April-2016 Page 91 of 128



6 Report Writing
6.7.1.3  When none of the population groups exceed 7.2 billion (approximate world population):

“The probability of randomly selecting an unrelated individual with a DNA profile matching
that developed from the EVIDENCE, SPERM OR NON-SPERM FRACTION OF
EVIDENCE, MAJOR PROFILE OF THE EVIDENCE, ETC. at the LOCI USED FOR
CALCULATION locicis approximately 1'in in the’Caucasian population, 1 in in
the Black population, and 1 in in the Hispanic population.”

6.7.1.4 If it is suspected that a relative of the suspect may have left the DNA profile at the crime
scene, the following wording will be used:

“The probability of/the RELATIVE having a’ DNA profile consistent with that of SUSPECT
is approximately 1 in in'the Caucasian population, 1 in in the Black population,
and 1in in the Hispanic population.”

NOTE:..Based. upon.the question.that.is.being.asked above, the frequency provided will not
be limited to 1 in greater than 7.2 billion:(which'is approximately the world
population), but instead will be reported-as the actual truncated probability that is
obtained using the formulas in Section 10, STATISTICAL CALCULATIONS. The
reported value for the random match probability will be truncated to 2 significant
figures.

6.7.2 Likelihood Ratio

The locirthat are-used for;calculating the-likelihood ratio-will be listed-in-thereport. This.can be done by
listing theloci individually, stating “the PowerPlex® 16 loci” or stating “the PowerPlex®16 loci with the
exception of LOCUS/LOCI”. A'likelihood ratio will be reported in the following manner:

“The DNA profile developed from the EVIDENCE, SPERM OR NON-SPERM FRACTION OF
EVIDENCE, ETC. at the LOCI USED FOR CALCULATION loci is:

times more likely to be observed if it originated from the SUSPECT and VICTIM than if it
originated from the VICTIM and an unknown individual in the Caucasian population.

times more likely to be observed if it originated from the SUSPECT and VICTIM than if it
originated from the VICTIM and an unknown individual in the Black population.

times more likely to be observed if it originated from the SUSPECT and VICTIM than if it
originated from the VICTIM and an unknown individual in the Hispanic population.”

NOTES: Depending on the assumptions made during the likelihood ratio calculation, there may be other
individuals (i.e., ELIMINATION SAMPLE, UNKNOWN INDIVIDUAL) that need to be
included in the likelihood ratio statement.

The reported value for the likelihood ratio probability will be truncated to 2 significant figures.
6.7.3 Combined Probability of Exclusion/Inclusion (CPE/CPI)

The loci that are used for calculating the CPE/CPI1 will be listed in the report. This can be done by listing

the loci individually, stating “the:PowerPlex® 16 loci” or stating “the PowerPlex® 16 loci with the

exception of LOCUS/LOCI”. The combined probability of exclusion/combined probability of inclusion
will be reported in the following manner:

6.7.3.1  The Methods statement will contain following statements when applicable.

STATISTICAL METHODS

“The DNA statistics calculated herein used the population allele frequencies generated by the
Virginia Department of Forensic Science.”
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“The [name] statistical method addressed below has been applied in accordance with the
Scientific Working Group on DNA Analysis Methods (SWGDAM) 2010 Interpretation
Guidelines and Departmental procedures.”

6.7.3.2  When all population groups exceed 7.2 billion (approximate world population):

“The probability of randomly selecting an unrelated individual who would be included as a
contributor to the DNA mixture profile developed from the EVIDENCE, SPERM OR NON-
SPERM FRACTION OF EVIDENCE, ETC. at the LOCI USED FOR CALCULATION loci
is 1 in greater than 7.2 billion (which is approximately the world population) in the Caucasian,
Black and Hispanic populations.”

6.7.3.3  When only one or two population groups exceed 7.2 billion (approximate world population):

“The probability of randomly selecting an unrelated individual who would be included as a
contributor.to.the DNA mixture profile.developed.from the EVIDENCE, SPERM OR NON-
SPERM:FRACTION OF EVIDENCE, ETC. at the:LOCI USED FOR CALCULATION loci
is approximately /1 in in the Black population, 1 in in the Hispanic population,
and 1 in greater than 7.2 billion (which is approximately the world population) in the
Caucasian population.”

6.7.3.4  When none of the population groups exceed 7.2 billion (approximate world population):

“The probability of randomly selecting an unrelated individual who would be included as a
contributor-tothe DNA mixture profile-developed fromthe EVIDENCE; SPERM OR NON-
SPERM FRACTION OF EVIDENCE, ETC. at the LOCIF'USED IN THE CALCULATION
loci'is approximately 1 in in the Caucasian population, 1 in in'the Black
population, and 1 in in the Hispanic population.

NOTE: The reported value for the combined probability of inclusion will be truncated to 2
significant figures.

6.7.3.5 In some instances a CPl, uRMP or major/minor statistic cannot be calculated. In current cases
involving non-person’s type crimes (stolen car, gun possession) the following wording will be
used.

“The significance of this DNA mixture profile cannot be determined using traditional
statistical methods. Accordingly, no comparisons were conducted and no conclusions are
being offered regarding possible contributors.”

Or

“The significance of this DNA mixture profile cannot be determined using traditional
statistical:methods. Accordingly, no conclusions are being offered regarding possible
contributors.”

6.7.4  Paternity Index and Probability of Paternity

The loci that are used for calculating the paternity index and probability of paternity need to be listed in
the report. This can be done by listing the loci individually, stating “the PowerPlex® 16 loci” or stating
“the PowerPlex® 16 loci with the exception of LOCUS/LOCI”. Paternity Index and Probability of
Paternity will be reported in the following manner:

“Based on a review of the typing results for the CHILD/EVIDENCE and the VICTIM and ALLEGED
FATHER previously analyzed at the PowerPlex® 16 loci and addressed in the Certificate of Analysis

dated , the following Combined Paternity Index (CPI) and Probability of Paternity, using a
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prior probability of 0.5, were calculated for the following populations at the LOCI USED IN THE
CALCULATION:

Caucasian CPI = Probability of Paternity = %
Black CPI = Probability of Paternity = %
Hispanic CPI = Probability of Paternity = %

The Combined Paternity Index is a likelihood ratio that expresses the odds that the ALLEGED FATHER
is the biological parent (father) of the CHILD/EVIDENCE SAMPLE (S) rather than another unrelated
random man. Therefore, the odds are ____ times more likely in the Caucasian population, times
more likely in the Black population, and times more likely in the Hispanic population that these
alleles would be observed if ALLEGED FATHER is/the biological parent (father) of the
CHILD/EVIDENCE SAMPLE (S) rather than another unrelated random man.”

NOTES: If one report is issued containing the PowerPlex® 16 typing results and the paternity index and
probability of paternity statistics; the first. sentence above will-be replaced with the following:
“The following Combined Paternity Index (CPI) and Probability of Paternity, using a prior
probability of 0.5, were calculated for the following'populations at the LOCI USED IN THE
CALCULATION:”

If a paternity calculation is‘being conducted in relation to a Body Identification case, the
following statement will be added to the Certificate of Analysis:

“Investigators are advised to evaluate all associated case information in addition to the
provided-genetic results before declaringthe identity of the remains.”

The 'reported value for the combined paternity index will be truncated to 2 significant figures.

Refer to Appendix L of the Commonwealth of Virginia Forensic Biology Section Procedure
Manual Section 11, Fluorescent Detection PCR-Based STR DNA Protocol: PowerPlex® 16
B10O System for acceptable values for the Probability of Paternity. The Probability of Paternity
percentage (%) will be carried out to 4 places after the decimal point.

“Based on a review of the typing results for the REFERENCE SAMPLE and for the SUSPECTED
SIBLING/HALF-SIBLING, previously analyzed at the PowerPlex® 16 loci and addressed in the
Certificate of Analysis dated , the following Combined Full Sibling (CSI) and Combined
Half-Sibling (CHSI) indices were calculated for the following populations at the PowerPlex® 16 loci:

Caucasian CSl = CHSI =
Black CSl = CHSI =
Hispanic CSl = CHSI =

The Combined Full Sibling Index.is a likelihood ratio that expresses the odds that the REFERENCE
SAMPLE and the SUSPECTED SIBLING share common biclogical parents, rather than unrelated.
Therefore, the odds are times more likely in the Caucasian population, times more
likely in the Black population and times more likely in the Hispanic population that these
alleles would be observed if theeREFERNCE - SAMPLE-and the SUSPECTED SIBLING share common
biological parents, rather than unrelated.

The Combined Half Sibling Index is a likelihood ratio that expresses the odds that the REFERENCE
SAMPLE and the SUSPECTED HALF-SIBLING share one common biological parent, rather than
unrelated. Therefore, the odds are times more likely in the Caucasian population,

times more likely in the Black population and times more likely in the Hispanic
population that these alleles would be observed if the REFERENCE SAMPLE and the SUSPECTED
HALF-SIBLING share a common biological parent, rather than unrelated.
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These findings support the conclusion that the REFERENCE SAMPLE and the SUSPECTED
SIBLING/HALF-SIBLING are full siblings.

[Or INC: The values reported do not meet the minimum value required in all population groups for an
inclusion as siblings. Therefore, these results support a finding of inconclusive regarding the question of
a sibling relationship between the donor of the EVIDENCE from the unidentified remains-and
REFERENCE KNOWN.]

Investigators are advised to evaluate all associated case information in addition to the provided genetic
results before declaring the identity of the remains.”

6.7.5  Missing Person

The loci that are used for calculating the missing person statistics need to be listed in the report. This can
be done by listing the loci individually, stating “the PowerPlex® 16 loci” or stating “the PowerPlex® 16
loci with-the exception-of LOCUS/LLOCI”:-Missing.person-statistics will-be-reported in the following
manner:

6.7.5.1  BOTH Parents Available for Testing

“Based on a review of the typing results for the EVIDENCE and MOTHER and FATHER
previously analyzed at the PowerPlex® 16 loci and addressed in the Certificate of Analysis
dated :

Itis times'more likely to observe the DNA profile developed from the EVIDENCE
at the LOCI USED IN THE CALCULATION.if it were from a biological child of
MOTHER and FATHER than if it were from a random couple of the Caucasian population.

Itis times more likely to observe the DNA profile developed from the EVIDENCE
at the LOCI USED IN THE CALCULATION if it were from a biological child of
MOTHER and FATHER than if it were from a random couple of the Black population.

Itis times more likely to observe the DNA profile developed from the EVIDENCE
at the LOCI USED IN THE CALCULATION if it were from a biological child of
MOTHER and FATHER than if it were from a random couple of the Hispanic population.”

“Investigators are advised to evaluate all associated case information in addition to the
provided genetic results before declaring the identity of the remains.”

NOTE: If one report is issued containing the PowerPlex® 16 typing results and the missing
person statistics, the first sentence above will be replaced with the following: “Given
the DNA typing results developed from the EVIDENCE and the reference samples
from the MOTHER and FATHER:”

The reported value for the likelihood ratio probability will be truncated to 2 significant
figures.

6.7.5.2  Only ONE Parent/ Grandparent Available for Testing

“Based on a review of the typing results for the EVIDENCE and the
PARENT/GRANDPARENT previously analyzed at the PowerPlex® 16 loci and addressed in
the Certificate of Analysis dated , the following Combined
Paternity/Maternity/Grandparent Index (CPI/CMI/CGI) and Probability of
Paternity/Maternity/Grandparentage, using a prior probability of 0.5, were calculated for the
following populations at the LOCI USED IN THE CALCULATION:

Caucasian CPI* = Probability of Paternity* = %
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Black CPI* = Probability of Paternity* = %

Hispanic CPI* = Probability of Paternity* = %”
*Replace with CMI or CGI as appropriate

“Investigators are advised to evaluate all associated:case information.in addition to the
provided genetic results before declaring the identity of the'remains.”

NOTE: The Probability of Paternity/Maternity/Grandparentage percentage (%) will be
carried out to 4 places after the decimal point.

“The Combined Paternity/Maternity/Grandparent Index is a likelihood ratio that expresses the
odds that the PARENT/GRANDPARENT is/the biological parent/grandparent
(mother/father/grandparent) of the person whose DNA was found on the EVIDENCE
SAMPLE(S) rather than another unrelated random man/woman. Therefore, the odds are __
times.more likely in.the Caucasian.population, ... times.more. likely in the Black
population, and /' times-more likely in the Hispanic population that these alleles would be
observedif PARENT/GRANDPARENT! is the biological parent/grandparent
(mother/father/grandparent) of the person whose DNA was found on the EVIDENCE than
another unrelated random man/woman.”

NOTE: If one report is issued containing the PowerPlex® 16 typing results and the missing
person statistics, the first sentence above will be replaced with the following:

“The following Combined Paternity/Maternity/Grandparent-Index; (CPI/CMI/CGI)
and Probability of Paternity/Maternity/Grandparentage, using a prior probability of
0.5, were calculated for the following populations:”

The reported value for the combined paternity/maternity/grandparent Index will be truncated
to 2 significant figures.
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APPENDIX A - Capillary Electrophoresis Reagents
Appendix A - Capillary Electrophoresis Reagents

1. This appendix describes the preparation of reagents necessary for the DNA analysis. For each reagent listed, the
company and catalog number is included. As a reagent is prepared, it will be labeled to include the following
information:

Identity
Concentration

Lot number

Date of preparation
Initials of preparer
Date of expiration

and if appropriate:

Date of autoclaving
Storage requirements

2. All reagents will be prepared with Type | water, unless otherwise stated.

3. All chemicals and reagents will be stored according to the manufacturers' specifications. All chemicals containing
biologicals will be disposed of in biohazard bags. Waste organic reagents and Ethidium Bromide will be placed in
designated waste containers in a hood and removed from the laboratory by an appropriate means of disposal. All
other reagents can be disposed of in the laboratory sink.

4. Any changes in chemical supply companies will be carefully checked by the Section Supervisor to ensure the
chemical being provided meets the specifications necessary for the reagent. Any changes in chemical supply
companies will be brought to the Forensic Biology Program Manager’s attention so the list can be updated as
necessary.

5. Concentrations preceding reagent components reflect the final concentrations of that specific component in the
resulting mixture.

6. When a reagent is diluted and used by a number of examiners and retained, a lot number must be created and the
reagent must be traceable to the reagent log. The container with the diluted reagent must contain the reagent stock
lot number, the date the dilution was prepared, and the initials of the individual preparing the dilution. If a stock
solution is diluted and used once and discarded or the dilution is used only by the examiner preparing the dilution, a
new lot number does not need to be assigned or recorded in the reagent log. The Gold ST*R 10X Buffer and the
Positive Control DNA are examples of such reagents where this applies. The original reagent stock lot number will
be used.

AMPLITAQ™ GOLD DNA POLYMERASE
Expiration date: Manufacturer's expiration date
Purchased from Applied BioSystems, Foster City, CA., Catalog number N808-0243 (6 pack) or N808-0244 (12
pack).

GENETIC ANALYZER BUFFER WITH EDTA (10x)
Expiration date: Manufacturer's expiration date
Purchased from Applied Biosystems, Foster City, CA. PN 402824, 25 mL each.

HI-DI™ FORMAMIDE
Expiration date: Manufacturer's expiration date
Purchased from Applied Biosystems, Inc., Foster City, CA, PN 4311230, 25 mL each.
Aliquot into 250 pL aliquots and store at -20°C.
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PERFORMANCE OPTIMIZED POLYMER - 4 (POP-4)
Expiration date: Manufacturer’s expiration date
Purchased from Applied Biosystems, Foster City, CA. PN 4363752 (3.5 mL) OR PN 4352755, (7 mL)

POWERPLEX® 16 SYSTEM KIT
Expiration date: Manufacturer’s expiration date
Purchased from Promega, Madison, WI., Catalog Number DC6531 for 100 reaction kit or DC6530 for 400 reaction
kit.
Kit components included (expiration date same as kit unless specified):
e POWERPLEX® 16 PRIMER PAIRS
POWERPLEX® 16 ALLELIC LADDER
GOLD ST*R 10X BUFFER - Purchased from Promega, Madison, WI. Catalog Number DM2411, 1.2 mL tube
FLUORESCENT INTERNAL LANE STANDARD 600
CONTROL DNA (2800M) - Purchased from Promega Corporation, Madison, WI., 250 ng tube, 10 ng/uL,
Catalog number DD1001.

POWERPLEX® MATRIX STANDARDS 3100/3130
Expiration date: Manufacturer’s expiration date
Purchase from Promega, Madison, WI. Catalog Number DG4650.
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Appendix B - Maintenance of the ABI 3130xI Genetic Analyzer

1. General Maintenance Schedule for the 3130xI

Table 1. Maintenance Tasks

Task

Freguency

Ensure adequate levels of buffer and water in reservoirs

Ensure the level of buffer in the buffer jar reaches the red
line. The overflow hole should not be occluded.

Replace the water and 1X running buffer in the reservoirs
and make sure the outside of the reservoirs are dry.

Check for bubbles in the pump block, lower polymer
block, interconnect tube, polymer supply tube, and
channels. Remove all bubbles with the Bubble Remove
wizard.

Check the loading-end header to ensure the capillary tips
are not crushed or damaged.

Ensure that sufficient volume of polymer!is present in the
bottle for run.

Ensure the pump block and lower polymer block are
securely fit on the instrument.

Clean the instrument surfaces.

Check for leaks around the array knob, interconnecting
tube nuts, and check valve.

Replace the polymer using the Replenish Polymer Wizard
Check the storage conditions of used arrays, if applicable.
Restart the computer and instrument
Run the Water wash wizard. Flush the array port during
this wizard, whether or not bubbles are present|in the array.
port.

Flush the water trap.

Defragment the PC’s hard drive (only C and E).
Clean the drip tray.

Change the array.

Remove any dried polymer from the capillary tips. Use a
lint-free wipe moistened with deionized water.

Before each run

Before each run

Every 48 hours or before each run,
whichever comes last

Before each run

Before each run

Before each run

Before each run or daily,
whichever comes last

As needed

Before each run or as needed

Every two weeks or as needed.
Weekly

Weekly

Monthly or as needed

Monthly or as needed
Monthly or as needed
As needed

As needed

As needed
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2. Wizards

APPENDIX B — Maintenance of the ABI 3130xI Genetic Analyzer

Wizards are automated instrument processes which allow the user to perform a variety of tasks. Each wizard has
been designed with specific instructions to achieve the purpose of the wizard. The wizards are accessed by selecting
the desired wizard from the “Wizards” menu and activated when the instrument name is selected in the tree pane.
The wizards include:

Install Array- used to install or replace capillary arrays

Change Polymer Type- change to a different polymer type (ex. POP-4 to POP-6)

Replenish Polymer — replace the polymer in the PDP with polymer with the same or different lot number.

Bubble Remove — remove bubbles (>0.2mm) in the PDP chamber, channels, tubing, as well as the array port

Water Wash — rinse the PDP chamber, lower polymer block, channels and tubing

Instrument Shutdown — prepares the instrument for long term storage and removes the capillary array

Autosampler Calibration — calibrates the positions on.the Autosampler

Update Cap Array Info — correct or update capillary array information

3 Replacing the Polymer using the Replenish Polymer Wizard

3.1

3.2

3.3

3.4

NOTE: Only use the replenish polymer wizard'if thetpolymer type is not changing. If a different polymer type
is desired, select the Change Polymer Type Wizard.

In the Data Collection Software 3.0, select Wizards> Replenish Polymer Wizard

Follow the directions given in the wizard to load fresh polymer on the instrument.

Record the date, lot number, expiration date, and polymer type in the 3130xI Instrument Log.

4 Flushing the Water Trap

4.1  The water trap in the polymer delivery pump creates a water barrier between the pump chamber seal and the
actual pump. The water trap should be flushed with Type | H,O on a monthly basis or as needed to wash out

any polymer and to clear bubbles. The trap should be left filled with type I H,O.

4.1.1  Fill a20 mL luer lock syringe with type 1 H,O. Remove any bubbles from the syringe.

4.1.2 = Attach the syringe to the forward facing luer fitting at the top of the pump block, as shown in Figure
1. Hold the fitting with one hand while threading the syringe onto the fitting'with the other hand.

4.1.3  Open the luer fitting by grasping the body of the fitting and turning it and the attached syringe
approx. one-half turn counterclockwise.

4.1.4  Open the exit fitting at the top left side of the pump block by turning it approximately one-half turn
counterclockwise.

4.1.5 Hold an empty beaker or tube under the exit fitting to catch approximately 5 mL of waste. Flush the
trap by pushing steadily on the syringe plunger. Take approximately 30 seconds to flush 5 mL of
type 1 H,O through the trap.
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4.1.6  Close the luer fitting then the exit fitting by turning each clockwise until the fittings seal against the
block. Do not over-tighten the fittings.

4.1.7  Remove the syringe from the luer fitting. Hold the fitting with one hand while turning the syringes
counterclockwise with the other hand.

Figure 1. Diagram of the pump block for flushing the water trap. The solid arrow points to
the luer fitting described in 4.1.2 above. The dashed arrow points to the exit fitting described

in 4.1.4. Figure reproduced from Applied Biosystems 3130/3130x| Genetic Analyzers (2004) Maintenance and
Troubleshooting Guide.

5 Rinsing and Filling Buffer and Water Reservoirs

5.1

5.2

5.3

5.4

5.5

5.6

5.7

5.8

5.9

Ensure the instrument.doors are closed.

Press the TRAY button'on the outside of the instrumentto bring the autosampler to the forwardposition.
Wait until the autosampler has stopped moving and then open the instrument doors.

Remove the anode buffer reservoir by gently pulling down and twisting slightly.

Remove the cathode buffer reservoir and H,O reservoirs.

Discard the solutions into the sink and rinse out the reservoirs with ddH,O or Type 1 H,0.

Dry with a lint-free wipe the cathode and anode reservoirs and then fill the reservoir to the fill line with 1X
Genetic Analyzer buffer.

Fill the water reservoirs to the fill line with ddH,O or Type 1 H,O(approximately 17 mL).
Place a clean septa strip on each reservoir and dry the outside of the reservoirs using a lint-free wipe. Be sure

that the septa are dry and fitted flush on the tops of the reservoirs in order to'prevent damaging the capillary
tips.

5.10 Place the reservoirs into position on the autosampler as shown in Figure 2.

 Water resemvoir -
fwaste)

Water reservair
{rinse)

" Water reservolr
(unused)

Cathode reservair
(1% running buffar)

_____ e 5

I— Home position

Figure 2. Position of water and buffer reservoirs on the 3130xI. Figure reproduced from Applied
Biosystems 3130/3130xI Genetic Analyzers (2004) Maintenance and Troubleshooting Guide.
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6 Changing the Capillary Array

6.1

6.2

6.3

6.4

6.5

6.6

6.7

6.8

6.9

6.10

6.11

The capillary array should last approximately 100 runs.

The capillary array may need to be replaced if poor sizing precision or allele calling results, or if poor
resolution and/or decreased signal intensityis demonstrated.

Close the oven and instrument doors, and then press the “Tray” button.

In the Data Collection 3.0 software, select Wizards>Install Array Wizard.
Open the instrument and oven doors

Follow the directions given in the wizard to install or replace an array.
Click Finish when done:

Close and lock the oven'door.

Note: if you have replaced the array with one of a different length, a new spectral calibration must be
completed for the dye set and array length combination.

Use the Update Capillary Array Info wizard (Wizard>Update Capillary Array Info) to identify the capillary
array length and serial number information. The capillary serial number and date must also be added to the
3130xI instrument log.

A new spatial calibration must be completed. See 7 below for directions.

7  Performing a Spatial Calibration

7.1  Aspatial calibration is used by the instrument to correlate the signal from each capillary with the signal
detected by the CCD camera.
7.2 Aspatial calibration must be performed when the capillary array is installed or replaced, any time the
capillary array is removed from the detection block, and when the instrument is moved.
7.3 Creation of the spatial calibration file
7.3.1  Onthe left side of the Data Collection Software, select GA Instruments>ga3130xI1>3130xI>Spatial
Run Scheduler, as shown in Figure 3.
Figure 3. Spatial Run Scheduler
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7.3.2  Inthe spatial protocols section on the right side of the screen, select either:
7.3.2.1  Protocol>3130 SpatialFill_1, if the capillaries do not contain fresh polymer, or
7.3.2.2  Protocol>3130 SpatialNoFill_1, if the capillaries do contain fresh polymer.

7.3:3 ' Click Start. The calibration run lasts approximately 2 min (6 min-when filling the capillaries as
well.)

7.4 Evaluation of the spatial calibration file
7.4.1  The spatial calibration profile should be evaluated according to:

Peak Height — Similar peak heights should be observed for all peaks.

Orange Crosses — One orange cross should mark the top of each peak.

Peak Shape —+Each peak should be'sharp: Small shoulders are acceptable.

Spacing — The difference between adjacent peaks should be approximately 15 pixels.

7.4.2  See Figure 4 for an example of an acceptable spatial calibration profile.

A Instruments = ga3130x] = 3130x1 = Spatial Calibration Viewer

12000

10000

an0n

BO00

4000

2000

120 140
Intensity vs Pixel Number

Figure 4. An example of an acceptable spatial calibration profile.

7.4.3 Inthe Capillary Positions table, ensure that the values in both the Left spacing and Right spacing
columns range between 13 and 16 pixels.

7.4.3.1  To move the cross, type in a new value in the Positions box for the capillary of interest
and press Enter.

7.4.4 _ If the calibration passed, click Accept to write the calibration data to.the database and the *.ini file.
If the calibration failed, click Reject and repeat the spatial calibration:

7.4.4.1  Poor spatial calibration is most often due to a dirty detection window or one or more
broken capillaries. The capillary array detection cell should be removed from the
instrument and the mirrored side cleaned with methanol (air dry) to clean the window.
While the detection cell is off the instrument, ensure that the capillaries are not broken
near the detection cell.

8 Performing a Spectral Calibration

8.1  The spectral calibration creates a matrix that is used during a run to reduce the raw (collected) data from the
instrument to the 4-dye or 5-dye data stored in the sample files.

8.2  The spectral calibration is specific to each dye set.
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8.3

8.4

8.5

8.6

8.7

8.8

APPENDIX B — Maintenance of the ABI 3130xI Genetic Analyzer
The spectral calibration needs to be performed when using a new dye set on the instrument, when the
capillary array length or polymer type is changed, after the laser or CCD camera have been serviced/replaced,
or if you see extensive pull-up or pull-down peaks in the data.

Note: For each dye set, a spectral calibration for each capillary array length and polymer type combination
must be created.

Note: A new spectral cannot be associated with previously-collected data. For example, if a new kit (with a
new dye set) is used on the instrument, it is necessary to perform a spectral calibration before running
the samples with that new Kkit.

For Fragment analysis, two common dye sets are:

e Dye Set F — used with PowerPlex® 16, AmpFISTR® COfiler® Kit, AmpFISTR® Profiler Plus® Kit, etc.

e Dye Set G5 — used with AmpFISTR® Yfiler™ Kit, AmpFISTR® Identifiler® Kit, AmpFISTR® Minifiler®

Kit, etc.

For Dye Set F in conjunction with the PowerPlex® 16 kit, the Promega PowerPlex® Matrix 3100/3130 should

be used. (For the AmpFISTR® COfiler® Kit or AmpFISTR® Profiler Plus® Kit, the DS-32 Matrix Standards

should be used.)

For Dye Set G5, the DS-33 Matrix Standards should be used.

Preparing the matrix standard for PowerPlex® 16

8.7.1  For PowerPlex® 16, remove the matrix standards (P/N .DG4650, Promega Corp.) from the
refrigerator, vortex to mix thoroughly, but do NOT centrifuge.

8.7.2  Dilute each of the concentrated dyes 1:10 with nuclease-free water (ex. 5 uL concentrated dye +
45 ul nuclease-free water). Vortex 5-10 seconds to mix. Using these dilutions, then mix 5 uL of
each diluted dye with 480 uL Hi-Di™ formamide for a total volume of 500 pL.

8.7.3  Vortex the formamide/matrix standard mixture thoroughly. Do not centrifuge the mixture.
Loading the samples

8.8.1  Add 25 pL of the formamide/dye mix to each well of two columns of a 96-well plate.
8.8.2  Seal the plate by laying the septum flat on the plate.

8.8.3  Inspect the plate and septum to ensure that the septum fits snugly and flush on the plate.

8.8.4 | Denature the samples at 95 °C for 3 minutes then immediately chill the-plate in a freezer block for 3
minutes.

8.8.5  Inspect the plate to ensure no bubbles are located at the bottom of a well. If so, either briefly
centrifuge the plate or use a pipet tip to remove the bubbles.

8.8.6  Leave the plate on ice until ready to prepare the plate assembly and place the assembly on the
autosampler.

8.8.7  Assemble the plate assembly by placing the sample plate into the black plate base. Snap the white
plate retainer onto the plate and plate base. Note: Verify that the holes of the plate retainer and the
septum are aligned. If not, reassemble the plate assembly.
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8.9  Creating a Spectral Instrument protocol
8.9.1  Before creating the protocol, go into the Module Manager and select “New”. Select “Spectral” in the

“Type” drop-down list and select “Spec36_POP4” in the “Template” drop-down list. Confirm or
change the following settings:

Inj. kV: 3

Inj. Secs: 5

Data Delay Time: 100

Run time: 800 seconds

8.9.2  On the left side of the Data Collection software window, choose GA
Instruments>ga3130xI>Protocol Manager to open the Protocol Manager, as shown in Figure 5.
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Figure 5. Creation of a protocol for a spectral calibration. The solid arrow points to the
appropriate selection on.the menu at the left side of the'screen. The dashed arrow (near bottom)
points to the “New” button for creating a new instrument protocol, as described in 8.9.2 below.

8.9.3  Inthe Instrument Protocols box, click “New...”, which opens the Protocol Editor dialog box.
8.9.4  Complete the Protocol editor dialog box:

Type a name for the protocol, typically including “Spectral” and the dye set utilized in the title.
Select Spectral in the Type drop-down list.

Select the correct dye set (F) for your run.

Select the polymer and array length from the drop-down lists

Select your chemistry file (Matrix Standard or Sequencing Standard) in the Chemistry drop-
down list.

e Inthe Run Module drop-down list, select the run module you created in step 8.9.1.
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e These modules are named with the array length and polymer type in the title. For example,
Spect36_POP4 is the name of the run module that should be used when the array length is 36
cm and the polymer type used is POP-4.

e  Select “Edit Parameters”. Change the lower condition bound to 4.0 and change the upper
condition bound to 12.0. Select “OK” in the “Edit Parameters” window and select “OK” in the

“Protocol/Manager”.

8.10

Performing the Spectral Calibration Plate Record

8.10.1 On the left side of the Data Collection software window, choose GA Instruments>ga3130xI>

3130xI>Plate Manager to open the Plate Manager, as shown in Figure 6.
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Figure 6. Plate Manager for creation of plate for spectral calibration. The solid arrow points
to the appropriate selection on the menu at the left side of the screen. The dashed arrow (near
bottom) points to the “New” button for creating a new plate record, as described in 8.10.2
below.

8.10.2 Click “New” to open the New Plate dialog box and fill out as indicated:
8.10.2.1
8.10.2.2 In the Application field, select “Spectral Calibration”

8.10.2.3 In the Plate Type field, select “96-well”

8.10.2.4  Enter “DFS” for the Owner Name field.
8.10.2.5 Enter your initials in the Operator Name field.

8.10.2.6  Click OK.

Type a name forthe plate — typically a.combination of the date, “Spectral”, and kit type.
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8.10.3 The Spectral Calibration Plate Editor dialog box will appear, as shown in Figure 7.

File Edit
Plate Mare: Operator:
Plate Sealing: [ ~rte Cwner: L=\ -
Well Sarple Narme | Commant Priority Instrumert Pratocol 1
A FP16 100 PowerPlex16 ~
B0 FP1E 100 PowerPlex!B
ol PP18 100 PoreverPlex1b
pol PP1E 100 ParwerPlex1B
=] PME 100 PowerPlexi B
Fo1 PP1E 100 PowerPlex16
G FP1E 100 PowerPlex1 6
Ho PP18 100 PoreeerPlexB
AD2 | PPIE 100 ParerPlex B
BO2 PP1E 100 PowerPlex16
co2 FP1E 100 PowerPlex1 B
ooz FP1E 100 PowerPlex!B
E02 PP18 100 PariverPlex1s
‘ Fo2 PP1E 100 PovverPlex] B
Go2 PP1E 100 PowerPlex1 g
Hiz | PP1B 100 FowerPlex1 B
[Cans LR Y A
-
cos ||
s | |
es || _’_ | ]
Fo3 | AR N
s | | \ B BB
Moz | - . v
Description

Figure 7..Spectral Calibration Plate Editor
8.10.4 In the row corresponding to the location of your first sample, select:

8.10.4.1 A sample name in the “Sample Name” column. The value “100” automatically appears in
the Priority column. There is no need to change this value.

8.10.4.2 Comments may be entered in the “Comment” column, but are not necessary.
8.10.4.3 In the “Instrument Protocol 1” select the protocol name created in 8.9, above.

8.10.5 Select the entire row by clicking on the sample well number, such as A0L. Select Edit>Fill Down
Special. This will populate the rows corresponding to your run.

8.10.6 Click “OK?”. The Plate record is now complete and the spectral calibration can be completed after
loading the plate onto the instrument and final preparation of the instrument.

8.11 Running the Spectral Calibration Plate

8.11.1 The plate assembly should be placed in the instrument.
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8.11.2 On the left side of the Data Collection software window, choose GA Instruments>ga3130xI>
3130xI>Run scheduler>Plate View to see the listing of prepared plates, as shown in Figure 8.

Eﬁ] Foundation Data Collection Version 3.0 -  No User is logged in

Fle View Service Tools Wizards Help

2N K™ —

= Aok stunerts : G, Instruments > ga3 30l = 3130 = Run Soheduier
[ Resutts Graup

=) Database Manager [-Find Pleties Metching These Criteria -+

2 Bgsatao

[EPiste Manager Type of Search

W@ Protocal Manager .
Sean or Type Plate ID

Jatacile Manager
= BERun History | ‘O
EEPT Viewer
Ever’vt Log N
Search Find All Append Results
B prfocs mp
Bl spatial Calibration i

B capilary Wiewer Link | Plate hame
BBl capiarray viewer cra
Bl spectral caliorstion A Y.031008.EB GeneMapper processed 96
mReextrammn
= EPaa0d
[Einstrument Status
[l spatisl Run Schedul
—
B Capilaries viewer
BBl capitrray Viewer
nSpectra\ Wiewwer
é"}‘Manual Contral
[ servics Lag

| el " | NS

| [N LY
[ [ V[
A (B[ ]

>

< | ¥
System Status P |Ruﬂ731 30| _2008-03-10_08-58_0003 status has changed to Completed ‘

Mo Current Run

Figure 8. Run scheduler for spectral calibration plate. The solid arrow points to the appropriate selection on the menu at
the left side of the screen. The dashed arrow points to the “Find All” button for finding the plate record created in 8.10.

8.11.3 Choose “Find All” to see a listing of all plate records. Alternatively, an advanced search can be
completed. The plate name from 8.10.2 can be used to find the spectral plate of interest. Select
“Search” and “‘Advanced” in the.‘:Type of Search” drop-down list.
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8.11.4 Once the plate of interest is found, select the plate record by clicking on the plate name. Click on the
plate position indicator (grid) which corresponds to the location in which the plate resides, as
completed in 8.11.1 above, shown in Figure 9. The plate map color will change from yellow to green
to indicate that the plate is successfully linked. In the toolbar or the Data Collection software, click
the green arrow near the top of the screen to begin the run. Click OK when the dialog box appears
(*“You are about to start processing plates...”).

.
Foundation Data Collection Yersion 3.0 - No User is logged in
Fle View ServiceTodls twizards Help
FEEBD £3
= AE‘;Z::;:{;‘:ZW : GA Instruments  ga 30x] = 3130 = Run Scheduler
i Database Manager (FindPlates Metching These Crierlar ——
= Eloa31300
[EPiste Manager Type of Search
@ Protacal Manager
Tl Mol erreger Sean of Type Plte D
= CERun Histary ‘
EPT Viewer
ElEwent Log
Search Find Al Append Resuits
s Don

BB patizl Caiibration i
B capillary Viewer
BB capiarray viewer
IR spectral Calibration

IReextraction
Els EE

[E=linstrument Status
B Spatial Run Schedul
B Capiilaries iewer
| capiarray Viewer
R spectral viewsr
$™anual Contral
B service Log

| amp o
| mp |
NE_|W
i
]
|
|
ISTREEE

< >

< >
System Status [ ‘Rul’\_31ﬁUxI_IUUBrUS—‘\U_UBVSB_UUU3 status has changed to Cotpleted

Mo Current Run

Figure 9. Plate Editor. The arrow points to the plate position indicator grid.
8.12 Evaluating the Spectral Calibration Data
8.12.1  Viewing the Pass/Fail Status after the run

8.12.1.1  On the left side of the Data Collection software window, choose GA
Instruments>ga3130xI>'3130xI>Instrument Status>Event Log to see the event messages.

8.12.1.2 In the “Event Messages” section of the window, view the pass/fail status of each
capillary. Each capillary (1-16, for the 3130xI) should have a Q-value (q) and a condition
number (c) in the range shown in Table 1.
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Table 1. Acceptable condition number range and Q-values for analysis of
spectral calibration data.

Dve Set Acceptable Condition Acceptable

Y Number Range (c) Q-value (q)
Fragment Analysis

D 4-85 above 0.95

F 6-12 above 0.95

E5 25-4 above 0.95

G5 8.5-145 above 0.95

Any other 1-20 above 0.80

4- or 5-dye set

8.12.2  Assessment of the Spectral Profiles and Raw Data

8.12.2.1 After assessing-the pass/fail status of the capillaries in 8.12.1, the spectral calibration
profile for each capillary must be assessed.

8.12.2.2  On the left side of the Data Collection software window, choose GA
Instruments>ga3130xI> 3130xI>Spectral Viewer to see the spectral data, as shown in
Figure 10.

& & efo)y alel A=

Capilary Datar Mon bl 07 11 57:2551;309‘
*

Figure 10. Spectral Viewer. The solid arrow points to the appropriate selection on the menu at the left side
of the screen. The dashed arrow (near bottom) points to passing wells (green) indicated on the plate

diagram.
8.12.2.3 Inthe “Dye Set” drop down list, choose the dye set utilized.
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8.12.2.4 Inthe “List of calibrations for Dye Set ", choose the spectral just created by ensuring
the date and time correspond to that run. Do not click “set” until the data has been
verified as acceptable.

8.12.2.5 Each well containing spectral sample of the 96-well plate is colored green (if passing) in
the plate diagram;as shown in Figure 10. Each'well can be clicked to verify the spectral
profile and raw data for each independently..A failing Capillary is colored tan (or yellow
when selected).

8.12.2.6  Verify that the spectral and raw data profiles for each well are acceptable by meeting the
following criteria:

8.12.2.6.1 ' [For 4-dye chemistry, the order/of peaks in the spectral (top) profile should
be: blue-green-yellow-red (left to right). For 5-dye chemistry, the order of
the peaks in the spectral (top) profile should be blue-green-yellow-red-
orange (left to-right). If the peaks.are not in-the correct order, the calibration
run has failed.

8.12.2.6.2  The order of peaks in the raw data (bottom) profile should be:
8.12.2.6.2.1 . ' Sequencing (4-dye): red-yellow-blue-green (left to right)

8.12.2.6.2.2  Fragment Analysis (e.g., STRs) — 4-dye: red-yellow-green-
blue and 5-dye: orange, red-yellow-green-blue.

8.12.2.6.2.3 . If the peaks are in the wrong order or extraneous peaks are
affecting the spectral profile, the calibration run has failed.

8.12.2.6.3  The peaks in the spectral profile should not contain “gross overlaps, dips or
other irregularities”. If so, the calibration has failed. A proper looking
spectral profile is shown in Figure 12.

10 G0 110 160 210 260 30
Intensity vs Pixel Mumber

Intensity vs Scan Number

Figure 12. An example of a proper spectral calibration profile for PowerPlex® 16.

8.12.2.7  If the spectral profile passes, the file name can be changed to reflect the date, dye set,
array length, and polymer type by clicking “Rename”.
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8.12.3 Activating a Spectral Calibration File

8.12.3.1 Note: every new spectral calibration is automatically the active one for that dye set,
unless manually changed. For example, if a spectral calibration were repeated but the first
spectral was optimal, one may wish to choose the first spectral as the active spectral.

8.12.3.2  On the left side of the Data Collection software window, choose GA
Instruments>ga3130xI> 3130-4DFS>Spectral Viewer to see the spectral data, as shown
in Figure 12.

8.12.3.3 Inthe “Dye Set” drop down list, select the dye set of interest.
8.12.3.4 Inthe “List of Calibrations for Dye Set: __ ”, select the spectral calibration you wish to
activate. The spectral profile and raw data are then displayed. If the spectral calibration is
acceptable as described in 8.12.2.6, click “Set”.
9 Long Periods of Inactivity
9.1 If the ABI 3130xI Genetic Analyzer remains unused for an extended period of time (approximately 2 weeks

or longer), it is recommended that either a blank run (consisting of only formamide and size standard) be
completed or the capillary array removed and the capillary ends stored in Type | H,O until further use.
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Appendix C — Storage of Electronic Data
Saving Digital Images

Sample files and project files generated using the Applied Biosystems, Inc. 3130xI Genetic Analyzer and analyzed
using the GeneMapper® 1D software will be saved onto a storage medium and stored according to the following
procedures:

After the data has been technically reviewed and found to be acceptable, the electronic sample files and project files
will be transferred (via flash drive or other electronic means) by the analyst to the supervisor. The supervisor will be
responsible for establishing a monthly deadline for the data to be transferred by the analyst. The collected data files
from all the databank analysts will be provided to'the CODIS Administrator, who will transfer the data onto a
medium for permanent storage. The storage medium will be labeled appropriately to indicate the data files are
PowerPlex® 16 samples and with the Month(s) and Year(s) which is included. After the data has been stored, the
folders may be deleted from the CODIS server

The storage medium will then:be stored securely in a specified location:within the laboratory for easy retrieval in
accordance with the laboratory’s Administrative Operation Procedures.

If a file(s) needs to be added to the storage medium for a given month, the analyst will make arrangements with
his/her supervisor to have the storage medium retrieved from storage and have the file(s) added to the appropriate
storage medium.

If electropherogram data must be retrieved and a copy made, the CODIS Administrator shall be notified to retrieve the
data from:the-appropriate-storage-medium:

Forensic Biology Section Procedures Manual, Section VIII DFS Document 210-D1100
Issued by Biology Program Manager Revision 4
Issue Date: 25-April-2016 Page 113 of 128



APPENDIX D - Initial Setup of GeneMapper® ID and Data Collection Software

Appendix D - Initial Setup of GeneMapper® ID and Data Collection Software

After installation of a new instrument and installation of the GeneMapper™ ID software on a new computer, a number
of customizations must be made. These include defining: panels and bin sets, the size standard, plot settings, and table
settings. If the new computer will also be used to control the instrument, appropriate protocols, modules, and results
groups must also be created. This appendix describes how to'make all of these settings modifications.

1 Creation of new run modules

1.1  Instrument procedures are controlled by the module manager. The control of operations such as injection
time, oven temperature, voltage during electrophoresis, data collection interval and z-axis (not adjustable by
user) can be modified. Modules must be created or modified from the templates provided.

1.2 While setting up a new instrument computer, it will be necessary to create a new module. For use with the
PowerPlex® 16 system, the module “PP16_5sec” will be used for a 5s injection. For a 2s injection,
“PP16_2sec” will be-used,jand-“PP16 10sec” will-be used-forithe:10s-injection:

1.3  To create a new module, navigate to Instruments>ga3130xI>Module'Manager in the tree pane view on the
left side of the screen (in the Data Collection software) to open the Module Manager window as shown in
Figure 1. Click on “New” and a Run Module Editor window appears.

1.3.1 A previously made module can be exported from another computer and imported into the Module
Manager rather than creating a new module, if desired. The import and export buttons are shown at
the bottom of Figure 1.

,L‘;'-] Foundation Data Collection Version 3.0. - Mo User is lopged in
Eile ‘iew Help
= Aﬁ:zﬁsﬁlp : GA Instruments = 93130 = Module Manager
_ E::TUT: Manager Find Module
[ElPiate Manager
&y Protoool hanager Rete
SUEHEE ~
® EERun History SPATIAL 31308patialNoFil yes
Els Bl FastSeq50_POP7_1 REGULAR FastSens0_POPT yes
FragmentAnalysis22_POP4_1 REGULAR FragmentAnalysis22_POP4 yes
FragmentAnalysis36_POP4_1 REGULAR FragmentAnalysis38_POP4 yes
FragmentAnalysis36_POP7_1 REGULAR Fragmenténalysis36_POP7 yes
FragmentAnalysis&0_POP4_1 REGULAR Fragmenténalysis&0_POP4 yes
FragmentAnalysis&0_POPE_1 REGULAR Fragmenténalysis&0_POPE yes
Fragmentanalysiss0_POP7_1 REGULAR Fragmentanalysiss0_POP7 yes
HIDFragmentanalysis 36_POP4_1 REGULAR HIDFragmentanalysis36_POP4 ¥es
HIDFragmentAnalysis38_POP4_12gec REGULAR HIDFragmentAnalysis36_POP4 no
HIDFragmentAnalysis 36_POP4_20sec REGULAR HIDFragmentAnalysis36_POP4 no
HIDFragmentAnalysis38_POP4_Gser REGULAR HIDFragmentAnalysis36_POP4 no
LongSeq80_POP4_1 REGULAR LongSeqa0_POP4 yes
LongSeqs0_POPT_1 REGULAR LongSeqa0_PoP? yes
FP16 REGULAR HIDFragmentanalysis36_POP4 no
PP16_10sec REGULAR HIDFragmentAnalysis36_POP4 no
FP16_2sec REGULAR HIDFragmentAnalysis36_POP4 no
FP16_3sec REGULAR HIDFragmentAnalysis36_POP4 no
RapidSeq36_POPE_1 REGULAR RapidSeq36_POPE yes
RapidSeq36_POP7_1 REGULAR RapiiiSeq36_POP7 yes
SNP22_POP4_1 REGULAR SNP22_POP4 yes
SNP36_POP4_1 REGULAR SHP3E_POP4 Yes
Spectd2_POP4_1 SPECTRAL Spect??_POP4 yes
Spect36_POP4_1 SPECTRAL Spect36_POP4 yes
Spect36_POPE_1 SPECTRAL Spect36_POPE yes 3
< —— - — >
New Edit Import Expert
Figure 1. Module Manager.
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1.4 Fill in the name and select the type of module (Regular) as well as a template
(HIDFragmentAnalysis36_POP4) from the drop-down list. Make modifications to the run conditions as
necessary to satisfy the run requirements. Figure 2 shows the conditions for the PP16_5sec run module.

Run Module Editor g|
[ Fun hModule Description —— ——

Marme: E‘I BTSSEC_

15.0 .| 0,15 kyalts

== Run_%“oltage

I

_ L
Type: REGULAR L
Template: HIDFragrmentAnalysis36_POP4 -
Description:
Run Module Settings R B mmE W OB N W |
’7 M atne J sl Range —‘
'_O\ten_Temperature - G0 L 18.B5Dey C -
FPoly_Fill_%ol | B500, 6500..38000 steps .
Current_Stability el 50 o 02000 uAmMps -
FreRun_“oltage »| 150 . 015 kKJolts -
Pre_Run_Time ~| 180 .| 1..1000 sec. o
Injection_“Yaltage o | 3.0 o 1..15 kvolts -
Injection_Tirme vl 0 » 1..600 sec. -
Voltage_Rlumber_Of _Steps | 40 y 1..100nk o
|_Woltage_Step_Interval vl 15 . 1.60sec -
1" Data_Delay_Time v 1 1N 10.3500 sec. J ‘
-

" a000 12000 sec.

B
a
=
E
gl
3
o
a4
5]
)
=]
=1

L

Figure 2. Run Module Editor.

1.4.1  After the settings have been verified, save the new module by clicking “OK”.

1.4.2  Similarly, a run module must be created for the 2 sec and 10 sec injections. To do so, click new at
the “Module Manager” and repeat the above steps to create the modules entitled “PP16_2sec” and
“PP16_10sec”. All settings should be as indicated in Figure y, except the injection time which
should be 2 and 10, respectively.

2  Creation of New Protocols

2.1  The instrument protocol is used to tell the instrument all of the necessary run conditions for the sample,
including the type of run, the run-module, and the/dye set: Typically, once aprotocol is defined for a
particular STR multiplex,.it will be used repeatedly and it will not be necessary to create a new one. If a new
protocol needs to be generated, proceed for directions.
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2.2 On the left side of the Data Collection Software, select GA Instruments>ga3130xI>Protocol Manager, as
shown in Figure 3.

B Foundation Data Collection Yarsion 3.0 Ho User is lopped In

e R Mo DyeSet  Descrption

n_G 8¢ @5 increased injection time
Craated wih populator
Croated with populator

A I0EpalAIMOFI_T 31 308pasamoFm_1

PPiGspecall 02907  Specld6_POP4_1
5 PORL_T

TEST Fragmentanatysis36_POPE_1

DE-32POPAF il SpectI8_POPY_) F
DS 1IPOPAGSdyesel  SpectdB_POP4_1 o5
F HIDFragmersinalysisis_POP4_1  F
a5 HIDFragmeranaysisdo_POFs 1 G5
Hifirstall HIDF ragmanshnalysln 5 _PORe_1 | G5
PPl PPl F
PowerPlex1 03107 PowerPlexl 02107 F
PRIBEY PoweP el B8y F
F
l
c

‘-‘-'[.""“ J [ ]

Figure 3. Protocol Manager. The solid arrow points to the appropriate selection on the menu
at the left side of the screen. The dashed arrow (near middle) points to the “New” button for

creating a new instrument protocol.

2.3 Inthe Instrument Protocols section, click “New” to open the Protocol Editor and create a new protocol.

2.3.1 A previously-made instrument protocol can be exported from another computer and imported into
the Protocol Manager rather than creating a new protocol, if desired. The import and export buttons

are shown at the bottom of Figure 3.

2.4  Complete the Protocol Editor, as shown in Figure 4.

Protacol Editor |X‘
Narme: || pP16_Sses |
Description
Tyde REGULAR ]
Run Module:[pp16_Ssec ]
orose 5

Figure 4. Protocol Editor.
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Type a name for the protocol. Typically, this names the amplification kit or dye set utilized for the
samples of interest.

Writing a description is optional.

Select “Regular” in the “Type” drop-down list.

Select the run module for your run. Typically, this will be: “PP16_5sec”, as this is the default run
module for PowerPlex® 16. A custom run module may be desired (e.g., varying injection time, run
time, etc.).

Select the Dye Set for your samples. Typically, thisiwill be “F”, which is the dye set for PowerPlex®
16, PowerPlex® Y, Profiler Plus®, and COfiler®. 5-dye chemistries such as Yfiler™, Identifiler™,
and MiniFiler™ typically utilize dye set G5.

Click OK.

Repeat the above steps to create an instrument protocolfor each injection time (ex. PP16_2sec and
PP16_10sec).

3 New Results Groups

3.1  The results group defines the file type, file name, analysis parameters, and file save location and run folder
name preferences for the samples separated on the instrument.

3.2 | Prior to utilizing the Results Group Editor, make a folder; with the examiners initials for whom'the Results
Group folder will-be created, in the'appropriate folder on the E drive (shown'in Figure 5).

Look i |l,i'| data b | ¥ |E| =
-1 |5 010406 _Ladder
bﬁ ) M
My Recent ) EB
Dacuments ) ga3130
7 ) ga31 301
LL% 2 bhH
Deszktop lii' MLE
S i B .Y
by Documents ||
My Computer
J‘ Fie name: | E:\&ppliedBiosystems\DCDataCallectionidata |
oy Metwark
Places Files of type: |AII Files ~ | Cancel

Figure 5. Making a folder for the Results Group.
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3.3 Create a results group by clicking on “Results Group” in the Tree Pane and click on the “New” button, as
shown in Figure 6. Alternatively, select a previously created results group to modify and click “Duplicate”
and rename the results group. The results group editor, as shown in Figure 7, opens.

menu at the Ieft side of the screen. The dashed arrow (near bottom) pomts to the “New”
button for creating a new results group, as described below.

I Results Group Editor

iz | Destination’ Naming | Automated Processing|

EbppliedBiosystemsi\UDC\DataCollectiondataikMH

[ oidwee..
[ Test |

—

. e’

Figure 7. Defining the destination for the Results Group folder.
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3.3.1  Apreviously made results group can be exported from another computer and imported rather than
creating a new results group, if desired. The import and export buttons are shown at the bottom of
Figure 6.

3.3.1.1  Complete the general tab by entering a name for the results group and owner; the
comment is not required

3.3.1.2 Select the Analysis tab, choose “GeneMapper-3130xI_1" (or the name the instrument was
assigned) as the analysis type, and ensure that Autoanalysis is not selected.

3.3.1.3 Select the Destination tab, and choose a destination folder for the results. The default
location is: E:\AppliedBiosystems\udc\datacollection\Data\Folder Name. Click “Use
Custom Location” and browse to a location by-clicking the “Browse” button (Figure 7).

3.3.1.4 Select the Naming tab to customize sample file and run folder names.
3.3.14.1 Sample file names shall be formatted as:
<WellPosition>_<SampleName>: <Plate Name>. Figure 8 shows how one

would select this option in the Results Group Editor. A potential filename
produced by the selection shown is: A01_AllelicLadder_2009-000.fsa

Results Group Editor, @

General | Analysis Destination| MNaming | Automated Processing
Sample File Mame Farmat
Bxa : I 1 lated )
. s greater than 1 i
| Pre
Marme Delimiter > File Name
Farmat H
= Formatting
|Samp|e Mame Vl |We|l Fositian A | |F'Iate Mame V| |<n0ne> V|
Suffi | |
File Extension 52 /
~Run Folder Mame Format
Example: EAppliedBiosystems\WDCDataCollectionmdatatkMHS egPlate 96 3
IRWALID MAME: Folder name does not have a unigue identifier in it.
Frefi | | Run Folder
Narne Delimiter > Name
IFELGRER | Formatting
|Plate Name + ||<none= v
/

Figure 8. Results Group Editor. An example of how run files and-folders might be named is
shown.

3.3.14.2 In a similar manner, the run folder name format shall be formatted as:
<Plate Name>.fsa. Figure 8 shows how one would select this option in the
Results Group Editor. An example of a run folder name is: 2009-000.fsa

3.3.1.5 Select the Automated Processing tab and confirm that “only when the results group is
complete” is selected.

3.3.1.6 Click on “OK” to save the Results Group. This results group will be used during the
sample data input in the Plate Manager.
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4.1  Inthe GeneMapper™ ID software, choose “GeneMapper Manager” in the “Tools” pull-down menu. The
GeneMapper Manager dialog box appears.

4.2 /Choose the “Size Standards” tab, as shown'in Figure 9.

(#] GeneMapper Manager

Projects | Analysis Methods || Takle Settings | Plot Settings | Matrices

Size Standards

Iame

Last Saved

Craener

Tvpe

Description

T_Go_HID_GE500

2005-03-07 11:43:0

grnicl

Basic/tdvanced

Factory Provided

377_F_HID_GSS00

2003-03-07 11:45:0

gtnic!

BaziciAdvanced

Factory Provided

CE_G5_HID_GE500

2005-03-07 11:45:_0]9mid

Basic/Advanced

Factory Provided

CE_F_HID_GS500

2008-03-07 11:45:D|gmid

BaziciAdvanced

Factory Provided

IL=600

2005-03-12 15:38:4|gmid

Baziciadvanced

for PPY and PP16

o e - SR 8

Figure 9. GeneMapper Manager. Size Standards tab for creating new or editing an already

existing size standard.

4.3  Choose “New...” (near bottom of dialog box) to create a new size standard.

4.3.1  Alternatively, a previously made size standard can be imported by choosing “Import...”

4.4 Inthe dialog box that opens, choose “Basic” or “Advanced” and click OK.
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4.5 Inthe Size Standard Editor dialog box that opens, name the new size standard “ILS600” and enter the size
standard dye (Red) and fragment sizes as shown in Figure 10.

Note: The 60 and 80 bp fragments may be included or excluded from the fragments listed.
Either choice will not affect the accurate sizing of the Amelogenin alleles since both the X and Y are
larger than the 100 bp fragment:

(7] Size Standard Editor

Edit
[ Size Standard Description
Mamne: ILSE00
for PPY and PPLE

Description:
Size Standard Dye: HE : —_ : __ __v
Size Standard Table

1 ooo

2 (1200

3 [1400

4 (1600

5 (1800

& (2000

7 |2250

5 (2500

a9 (2750

10 (300.0

11 3250

12 13500

1313750

14 (400.0

15 14250

16 |450.0

17 4750

16 (S00.0

19 |350.0

20 |600.0

Figure 10. Size Standard Editor. Settings shown are those utilized for the 1LS600.

5 Analysis Method Editor

5.1 Inthe GeneMapper Manager, select the “Analysis Methods” tab and click “New”. In the dialog box that
opens; choose “HD?" and-click OK. Give it the name, “PowerPlexl6advanced”. In the GeneMapper™ 1D
software, select Analysis>Analysis Method Editor.

5.2  Click on the “Peak Detector” tab.
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5.3  Ensure that all selections are properly designated, as indicated in Figure 11. The size calling method used for
the PowerPlex® 16 STR kit is the Local Southern method.

53.1

53.2

Analysis Method Editor - HID x
| General || 2llele| Peak Detector | Peak cluality || Guality Flags |
Peak Detection Algorithm: | Advanced _Iv
Ranges Peak Detection
Analysis Sizing Peak Amplitude Thresholds:
Pattial Range » FPartial Sizes w B |73 R |52
Start Pt: | 3000 Start Size:| 50
o - Gyo| 54 0: |50
Stop P | 11100 Stop Sized| 600 | r .
. = mm | o = | v |75
—Smocthing and Baselinibg
Min. Peak Half Width: 2 pts
Smoothing ) Mone ; 3
@ Light Palynomial Degree:
OyHesrey Peak Yinoow Size: |_15 pt=
Baseline Windaw: | 51 pts Aol
Peak Start: ERE
—Size Calling Method Paak End: oo
() 2nd Order Least Sguares
O Jrd Crder Least Sguares
() Cubic Spline Interpolstion
(%) Local Southern Method
() Global Southern Method

[ Factory Defaults l

i

Figure 11. Peak detector tab of the Analysis Method Editor. Only the analysis range and
threshold for the red channel may be altered during data analysis.

The analysis range starting and stopping points may be altered on a run-by-run basis to
accommodate migration times that may vary between injections. Typically, a starting point of 3000
and stopping point of 10,000 is appropriate.

The values for the peak amplitude thresholds are based upon empirical data derived from the limit of
detection analysis performed during the validation work and specific for each 3130xI instrument.
While the ILS 600 (which uses the red dye) will have its default peak amplitude threshold set based
on the LOD analysis, the threshold may be adusted upward, high enough to prevent detection of a
known artifact present in the Promega ILS 600 size standard (Figure 4), or reduced when the ILS
600 peaks may fall below the default threshold (this can occasionally occur with the 2 second
injection). Itis important to note that ONLY the'Red dye (ILS 600 size standard) may be adjusted if
such conditions are present.
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5.4

The settings under the “Allele” tab should remain as shown in Figure 12. The Bin Set is defined as

“Promega_Bins_ID3.2.0” and the marker specific stutter ratio is used.

Analysis Method Editor - HID:

Bin Set! \f‘mmega_ﬁlns_lDS 20

General AHE\EE Peak Detector || Peak Qualty | Quality Flags

&

v

Use tiiarker-specific stutter retia if availaile
Marker Repeat Type i Tetra Perta Hexa
Cut-off Walug 00 00 an 0o
MinusA Ratio 0o 0.0 oo 0o
Minus:4 Distance From | 0.0 0o oo 0o
To |00 00 oo a0
hlinus Stutter Ratio 0o 00 on 0o
Minus Stutter Distance Frarm iﬂ _325 | 4 25_ 5_25
To ’U_L 475 ] L5 7; IETS
Plus Stutter Ratis o oo | fan | oo
Aus Suterbictares. @Y, 08 || o0 || [0 | [e0 |
ot foo |“foo ©F [an | oo 7
.
Amelogenin Cutof! a0

Range Fiter

Factory Detauits

Figure 12. Analysis Method Editor — Allele Tab. The solid arrow points to where the bin set
is defined. The dashed arrow points to where the stutter distances are defined.

5.5

Analysis Method Editor - HID |

General AIIE?" Pealgeiedm :rQuaI'rly Flags |

Sigral level— R e e e e
Homozygous min peak height S0.0
Heterozygous min peak height S0.0
Heterozygote balance
hin peak height ratio ar
Peak morphology
Max peak width (basepairs) 1.5
Pull-up peak
’7 Pull-up ratio 0.0s ‘
Allele number
Max expected alleles 2

Factory Defaults

The default settings for the Peak Quality and Quality Flags tabs are used, as shown in Figures 13 and 14.

(x]

Analysis Method Editor - HID

Ciality weights are between 0 and 1.
rG@uality Flag Setting:

Spectral Pull-up 0s Contral Concatrdance 1.0
Broad Peak og Lowy Peak Height 0.3
Out of Bin Allele a8 Off-scale 0.8
Overlap s Peak Height Ratio 0.3

P& Threshold

Paszs Range: Lowy Guality Range:

Sizing Quality: From | 075 to 1.0 From00to | 0325

Genatype Quality: From | 075 to 1.0 From 0.0 to 0.25

Factory Defaults

Figure 13. Analysis Method Editor — Peak Quality
Tab

551

Figure 14. Analysis Method Editor —Quality Flags
Tab

Verify that the settings are the same as those shown in Figures 11 and 12, then click OK.
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Panels and Bins

6.1

[#]Panel Manager
File Edit Bins iew

APPENDIX D - Initial Setup of GeneMapper® ID and Data Collection Software

Panels and bins must be created for allele calling of PowerPlex 16 data. In the GeneMapper® 1D software,
navigate to “Tools” > “Panel Manager”. In the tree pane view on the left side of the dialog box (shown in

Figure 15), choose “Panel Manager”.

8 K| H N I Binset [smpFLSTR viier Binset vz | ||| B B B B { O { {0 |
Panel Harne Corrrrert
AmpFLSTR_iler_Panel Jf] |1’fi|er_v2 ||n0ne

T mpFLETR_Panels_v1

[rromega_Panels_ID3.2.0

[ ampFLSTR _MiniFiler_GS:
< >

[ OK H Cancel H Apply ]

Figure 15. Panel Manager.

6.2

6.3

Choose “File”>"Import Panels” and browse to the file on CD containing the panels for the PowerPlex 16 kit.
Note: the panels need to be obtained from Promega, as they are not installed on the computer by Applied

Biosystems.

Navigate to.“Promega._Panels1D3.2.0”,0f the treepane view.(at.the left side.of the screen), choose
“File”>"Import Bin Set” and browse to.the Promega-bins file, typically entitled-“Promega_Bins_I1D3.2.0".
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6.4  Navigate to “Promega_Panels_153.2.0”> “PowerPlex_16_1D3.2.0” of the treepane view (at the left side of the
screen). The resulting PowerPlex® 16 panel/bin set is shown in Figure 16. The marker specific stutter ratios
must be updated to reflect the validation data obtained at VDFS. The new stutter ratios should be edited to
reflect those shown in Figure 16. Click OK after completing.

(# ) Panel Manager

File Edit Bins View
e | mom om | ‘W e st fromecs pine pazo PO = O N | |
e ———— Wfrker Harme Dye Color | Min Sim | M Site | Corerol Alleles Wfaker | M:C;mn: = Tadd?mhhs
B 351355 B | [ Fasiase bue (940 [0 [1a1s 4 013 |none 12,13,14,15,16,17,18,19,20
THO1 2 |THOT bue  [1520 [1950 (893 4 005 none 4557899310,11133
D21511 EREEER bue  [1950  [z6z0 |30 4 014 none 24,24.2,25,25.2,26,27 28,26
D185t 4 |D1EssEt blue o740 |sB40 1518 4 014 |none 5910102,111213132,1¢
:Es';tg;g 5 |PentaE blue {3700 fs800.  [121% s 008 none 55,7 5,9,10,11,1213,14/15,
D135317 R areen |11z0 [1se0 |11 4 011 |none 78,8,10,11,12,13,14,1515
075820 7 |p13s37 oreen [1850  [2080 |11 4 011 |none 78810,1112,13,1415
D163533 5 |D7SE20 green  |2100 (2520 |10;11 4 01 |none £,7,5910,11,12,1314
EES::E 9 |D165538 greer  |2600 (300 (11,12 4 041 [none 58,3,10,11,12,13,14,15
AMEL 10 |CSFIPO oreen [3120  [3810 1012 4 011 |none 6,7,88,10,11,1213,14,15
[y 11 |Penta_D oreer  |3650  [4430 (12 B 004 none 22,32578310,11213,
D8S1179 | 12 TameC vellow [1020 [1H1zo |x a 00 |none Y
;PGZK il [13 [ in velow  [1200- |18a0 1718 4 018 |none 10,11,12,13,14,15,16,17 18,
< S S PP yellow  |2000  [2520 |13 4 041__Inone 73,9,10,1,12,13,14,1518,
 Sremmoe s |12 TPOX yellow (2550|3030 |6 4 005 none 6,7,89,10,11,12,13
16 [FGa velow [3050  [s6B0  [2324 4 013 |none 16,17,18,18.2,19,18.2,20,20
|

Figure 16. Panel/bin set for PowerPlex® 16. An arrow indicated the column of marker specific stutter ratios
that must be edited to reflect the validation data obtained at VDFS. The marker-specific stutter ratios shown
here are the values obtained at VDFS.

7  Plot Settings

7.1 In GeneMapper® ID, navigate to “Tools”>"GeneMapper Manager”. In the tabs near the top of the
GeneMapper Manager dialog box, choose “Plot Settings” to create custom plot settings. Two different
custom plot settings will be created: “Samples” and “Allelic Ladders”.

7.2 Create a new plot setting by clicking “New” and the “Plot Settings Editor” will appear. In the “General” tab,
type a name for the plot settings. In this instance, choose “Samples”.
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7.3 Figures 17 — 21 show the various tabs of the plot settings editor. Verify that the plot settings match those in
the Figures below.

Plot Settings Editor X

Genera\l Satnple Header | Genatype Header | Sizing Table || Labels | Display Seftings
~ZampleHeader Settings:

Show | Colurn
1 Sarnple File
2 Sample Name
3 Panel
4 Sizing Guality Overridden
5 Off-scale
B Sizing Quiality

Figure 17. Plot Settings Editor: Sample Header.

Plot Settings Editor

(X

A E—
General | Samplz Headerl Genotype Heacsr | Sizing Tahle | Labels || Display Settings
Genotype Header Settings:
Show | Column J
1 I Satrple File N
2 Sample Mame "
3 Panel
4 Marker
5 Off-scale
B Sharp Peak (M) B
T One Bazepair Allele (M)
& Single Peak Arifact (M)
3 Splt Peak (M)
Cut of Bin Allek
10 of Bin Allels 9|
Plot Settings Editor X
B —
General | Sample Haaderl Genotype Heacler | Sizing Table | Labels | Display Settings
~Genotype Header Settings:
show [eaumn
11 Peak Height Ratio a
12 Lowy Peak Helght
13 Spectral Pull-up
14 Allele Murmber
15 Eroacd Peak
16| []  |Double Peak (SNF) l]
17 |:| Marrowy Bin (SMP)
18 Cortrol Concordance
19 Cvetlap
20 Senatype Quslity ;
Figure 18. Plot Settings Editor: Genotype Header.
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Plot Settings Editor

General | Sample Header | Genotype Header| Sizing Takle | Lakels || Display Settings

~Sizing Table Setting

rColunh Seftings:

Show | Calumn

DiverSample Peak J

Satnple File Matme

tarker

Allele

Size

Height

Area J

Data Paint Y
| H A

[44]
HEEEEEEE

Fort Settings:

Fart: _Arial bl

X

Figure 19. Plot Settings Editor: Sizing Table.

Plot Settings Editor,

General | Sample Header | Genotype Header | Sizing Table| Lakels | Display Settings

Show Labels:

Label1:  |Allele Call v
Lakel 2:  [Height e
Label 3. |Size M

Label & |AF Comm... %

rWhen opening the Plot Window:

[ show data type prefixes
Show type of edit
D Invert mutant labels

Label Color: |Dye Calor-Barder

(X

Fort: Tahotna A
Size:

Figure 20. Plot Settings Editor: Labels. Note: these label settings are
specificito.the “Samples’plotsettings-Assecond plot-settings file:will be
created for allelic ladders in-which the allele labels are different.

NOTE: Labels may be adjusted by an examiner based on his or her

preferences.
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Plot Settings Editor 3

General | Sample Header | Genotype Header | Sizing Table || Labels | Display Settings
~When Opening The Plot Window
O Usze the display settings last used for this plot
@_Use these dizplay settings:

rFor both Satmple and Genotype plots:

Fanes: 4 \gI

FHEIEN
HoEis: Basepairs Y| s [Scale Weividually v
Toolkar D Showe Off-scale

rFaor Sample plot anly:

(E)EC_)()0 )
E eI
AN

rFor Genotype plat only: \
Marker Margirc| |5 bp

Figure 21. Plot Settings Editor: Display Settings. The arrows indicate the
icons that must be clicked.

7.3.1  Note that many of the settings in Figure 21 are difficult to discern from the figure because they are
toggle switches. The icons to which an‘arrow is pointing must be clicked (once) for the appropriate
settings. The number of panes may be'set at.the analyst’s discretion, but this is typically 2.

7.4  Click OK.
7.5 A second Plot Setting shall be created for ease of printing allelic ladders. Create a new plot setting by clicking

“New” and the “Plot Settings Editor” will appear. In the “General” tab, type a name for the plot settings. In
this instance, choose “Allelic Ladders”.

7.6 Figures 17 — 21 show the various tabs of the plot settings editor. Verify that the plot settings match those in
the Figures. The only difference between the allelic ladder and samples plot settings is the allele label. For
allelic ladders, only the allele call is used, as indicated in Figure 22.

7.7 Choose OK to close and save the plot settings and Done to close GeneMapper Manager.

Plot Settings Editar X
General | Sample Header | Genotype Header | Sizing Table | Lakels | Display Settings
Shomlabelss (tithen opening the Plot ifindow

Label e Alcle el v []'=hehw catatype prefixes

Label 2 Mone - Show type of edit

Lakel 3 |More v [ Invert mutsnt labets

Label 4 None v Label Color:  Dye Color-Borcer B
Font Tahoma |
Sizer EHl.

Figure 22. Plot Settings Editor: Labels. Note that these label settings are
specific to the “Allelic Ladders” plot settings.
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